








8 DECEMBER 2002

index ■
■ digit interactive

Jump start your way into the most
popular productivity suite with Fast

Forward, Working with Microsoft Office XP.
Find everything you need to know to

start using Word for creating documents
such as memos, letters, faxes, etc. Get a
primer on Excel, the powerful
spreadsheet software for all kinds of
calculations, from basic additions to
complex scientific formulas. Learn how
to create impressive presentations 
with PowerPoint, to get the right
communication across to your clients.
See how you can use Outlook to manage
not only your e-mail, but also your daily
activities, schedule, appointments,
meetings and much more.

Plus, look out for a bonus chapter on
using Mail Merge with Office XP to
quickly and easily create personalised
letters and e-mail for invitations,
announcements, product launches, etc.

Microsoft Office is a very powerful
suite and here’s an equally powerful
package to help you start working 
with it.

Your ‘slow’ computer is capable of
much more. Fast Forward, 100+ Tips

& Tricks brings you a cool package of
over a hundred reasons to not upgrade
your PC. See how you can use your PC
more efficiently and get it to work faster
with these tweaks and secrets.

Windows is the most common
operating system and is usually the first
culprit in slowing down your PC. Learn
how to tweak this OS to pull out all the
juice from your hardware and hog lesser
resources for better performance.

Check out cool tips for Microsoft
Office to get your work done in fewer
clicks. Be careful not to show that you
have a lot of free time though, or your
boss may just give you more to do. Gift
this Fast Forward to your boss instead!

Frustrated with your Net connection?
Tired of spam? Speed up your modem,
do more with Internet Explorer and
work smarter with Outlook and Outlook
Express with these great tips.

Go ahead, become a power user.

Unreal Tournament 2003
Size: 98 MB Section: Games

No One Lives Forever 2
Size: 158 MB Section: Games

Brixout XP
Size: 4.47 MB Section: FunZone

Quake III Arena Patch 1.32
Size: 28 MB Section: Extras

Epic Games Pinball
Size: 872 KB Section: FunZone

America’s Army: Operations
Patch 1.30
Size: 28 MB Section: Extras

WWF Raw
Size: 64.8 MB Section: Games

Gunocide 2
Size: 7.37 MB Section: FunZone

100+
TIPS & TRICKS

WORKING WITHWORKING WITH

MICROSOFT
OFFICE XP

WordPerfect Office 2002
Size: 170 MB Section: Office

Photoshop 7.0
Size: 163 MB Section: Multimedia

ICQ Lite
Size: 1.7 MB Section: Internet

Gmax
Size: 35.8 MB Section: Developer
Tools

Read Plus
Size: 7.47 MB Section: Home

PowerVCR II Pro 3.0
Size: 8.6 MB Section: Multimedia

FaxWizard 2000 7.2a
Size: 11.5 MB Section: Office

FreeRAM XP Pro 1.22
Size: 547 KB Section: System

ON THE CD
APP OF THE MONTH
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HIGHLIGHTS

GAME OF THE MONTH





index n
n colophon

16 DECEMBER 2002

Chairman Jasu Shah
Printer, Publisher and Editor 
Maulik Jasubhai
He a d - Publications & Web sites
Louis D’Mello 
A ssistant Editor Vinit Aggarwal

Editorial 
Head - Writer Marco D’Souza 
W riters Veer Kothari, Ahmed Shaikh,
Rachana Sanghani, Srinivasan
Ramakrishnan
F eatures E ditor Sveta Basraon 
C opy E ditor Mitali Parekh

D esign
A rt Director Marshall Mascarenhas
Manager -  Design Swaroop Biswas 
D esigners Shivasankaran C. Pillai,
Shyam Shirsekar, Jaya Shetty, 
Neeta Wadiker, Solomon Lewis, 
Ashwin Boricha, Mahesh Benkar, Atul
Deshmukh

Photographers Mexy Xavier, 
Jiten Gandhi

Test Centre
Head Hakimuddin K. Badshah
Reviewers Aliasgar Pardawala, 
Yatish Suvarna, Mitul Mehta, 
Ashu Mehrotra
Co-ordinator Gautami V. Chalke

M ultimedia
C o-ordinator V. Ravi Shankar 
Design Kabir Malkani, Jo-Ann Rodricks,
Hemant Charya, Priyamvada K.K., 
Liu Ai Chin

M edia Studio
Bimal Unnikrishnan, Priya Ramanathan,

Afzal Mazgaonkar, Prasanth Uyyul

Product ion
G M Shivshankar Hiremath 

C irculation & Logistics
Adarsh Kaul 

Customer Service
Namita Shetty 

M arketing & Sales
Deputy Head - Sales Vijay Adhikari
Marketing Manager Bhavesh Thakor
Manager -  Consumer Mktg
Nabjeet Ganguli

VOLUME 2, ISSUE 12

Head Office: Editorial, Marketing &
Customer Service
Plot No D-222/2, TTC Industrial Area,
MIDC, Shirvane, Nerul, 
Navi Mumbai 400 706 
Phone: +91 022-7629191/9200  
Fax: +91 022-7629164
Printed and published by Maulik
Jasubhai on behalf of Jasubhai Digital
Media Pvt Ltd, 26 Maker Chambers VI,
2nd Floor, Nariman Point, 
Mumbai 400 021, India.
Editor: Maulik Jasubhai
Printed at Tata Infomedia Limited, 
Prabhadevi, Mumbai 400 025

ADVERTISERS’ INDEX

CLIENT PAGE
3M  . . . . . . . . . . . . . . . . . .97
AMD  . . . . . . . . . . . . . . . . .13
ASUS  . . . . . . . . . .75,77,79,81
AT&T  . . . . . . . . . . . . . . . . .45
Canon  . . . . . . . . . . . . . . . .17
Dell  . . . . . . . . . . .10,11,14,15
Elnova  . . . . . . . . . . . . . . .110
Gigabyte  . . . . . . . . . . . . . .59
HP  . . . . . . . . . . . . . . . .18,19
IBM  . . . . . . . . . . . . . . . . . .23
Intel . . . . . . . . . . . . . . . . . . .7
Invensys . . . . . . . . . . . . . . .BC
Iomega  . . . . . . . . . . . . . .101
Kobian  . . . . . . . . . . . . .36,37
Lexmark . . . . . . . . . . . . . . .27
LG  . . . . . .111, 112, 113, 114, 

115, 116, 117, 118  
Logitech . . . . . . . . . . . . . . . .9
Maxtor . . . . . . . . . . . . . . . .25
Motorola  . . . . . . . . . . . . . . .5
MSI  . . . . . . . . . . . . . . . . . .53
National Panasonic  . . . . . . .41
Numeric  . . . . . . . . . . . . . .IBC
Onkyo  . . . . . . . . . . . . . . . .43
Penram  . . . . . . . . . . . . . . .87
Rooman  . . . . . . . . . . . . . . .83
Symantec  . . . . . . . . . . . . . .49
Triffin  . . . . . . . . . . . . . . . . .93
WEP  . . . . . . . . . . . . . . .55,57
Xserve  . . . . . . . . . . . . . . . .51

Write Back
Got feedback on Digit or
www.thinkdigit.com? Have something to say
about an article we published? 
We’d love to hear from you. Send us your
rants and raves at 
readersletters@jasubhai.com

Product Testing
Want your product reviewed by Digit? 
Contact our Test Centre at 
testcentre@jasubhai.com

Software on CD
To submit software for inclusion in the Digit
Interactive CDs, contact us at 
cdcontent@jasubhai.com

Help!
Complain about your missing copy?
Cover CD not working properly?
Renew your subscription
Report a change in mailing address
Order a back issue
Need assistance on any of these? 
Contact Customer Service at
022-27629200 Extn: 1013-1016
help@jasubhai.com

Endorsements/Reprints
The Best Performance and Best Value Awards
are the undisputed stamp of excellence for
technology products in India. If you are a

winner and are interested in ordering article reprints or using
our logos, contact 
vinith_shetty@jasubhai.com

While every effort is made to ensure
that the information and prices 
provided are correct, there may be
some variation due to differences in
local taxes across states. Please keep
this in mind before affecting any
product purchase.

Promise
to our readers

BANGALORE
S. Saikumar
Phone: 5325670/88, 2899287
E-mail: s_saikumar@jasubhai.com
CHENNAI
Jayesh George
Phone: 8235186-89 
E-mail: jayesh_george
@jasubhai.com
KOLKATA
Jayanta Bhattacharya

Phone: 2345100/5200
E-mail: jayanta_bhattacharya
@jasubhai.com
MUMBAI
Rupesh Sreedharan
Phone: 26591849-50, 26591651
E-mail: rupesh_sreedharan
@jasubhai.com
NEW DELHI
Rajesh Arora
Phone: 6483993-4

E-mail: rajesh_arora
@jasubhai.com
PUNE
Vinayak Inamdar
Phone: 4482059, 4494572
E-mail: vinayak_inamdar
@jasubhai.com
SECUNDERABAD
S. Venu
Phone: 6329190, 6329181 
E-mail: s_venu@jasubhai.com

CONTACT OUR BRANCH OFFICES
To Advertise



Playing a new tune

For all MUSICMATCH fans,
here is a reason to rejoice—

MUSICMATCH Jukebox 7.5
(www.musicmatch.com) has just
been released. The latest ver-
sion brings with it new online
jukebox technology that
allows for effortless transfer to
portable devices, lesser time to
create custom CDs and
advanced music tagging and
labelling that will help you
quickly and effortlessly add
track information for digital
audio files using the compa-
ny’s Radio MX subscription
service. It also comes with a
sleeker, easy-to-use interface. 

Though MUSICMATCH
decided to stop supporting the
Mac version late in October,
this one carries support for
quick-syncing the Apple iPod
for Windows operating sys -
tems. It still has syncing sup-
port for all the popular
portable MP3 players, includ-
ing the Nomad Jukebox. Ver-
sion 7.5 also lets you create
full-colour CD labels and
jewel case inserts for all of
your custom CDs.
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Pixie Dust
n What is it?
Pixie Dust is an indigenious
technology that IBM uses to
pack data on a portable
hard drive. IBM developed
this new technology a year
ago, and all IBM notebooks
integrate this technology
into their hard disks. 

n How does it work?
IBM uses a home grown data
storage technology called
the antiferromagnetically-
coupled (AFC) media. Pixie
Dust is a three-atom-thick
layer of the element Rutheni-
um. The Ruthenium element
forces adjacent layers to ori-
ent themselves in magneti-
cally opposite directions. This
makes the structure appear
much thinner than it actually
is—so small that high-density
bits can be written easily on
it, while retaining the mag-
netisation due to the media’s
overall thickness.

n What can it do?
IBM is now packing five lay-
ers of Pixie Dust, allowing 
up to 70 billion bits of data
to be written on each square
inch of disk space, up from
40 billion bits. IBM predicts
that it will achieve 100 billion
bits per square inch in 2003.
The Travelstar 80GN series of
mobile hard disks have
proven reliability with high
shock robustness and low
power consumption. 8 MB
cache makes it the world’s
highest performing 4200-
rpm mobile hard drive.

hypethesis

n New research proves computing causes strain and lethargy n Mitch Kapor, co-founder of Lotus Development, to build a free, open-source equivalent of MS Outlook

Internet on the roof

With the rapid accept-
ance of cell phones by

the Indian middle
class, the newest cause
for concern is marital
disharmony, claims the
National Human
Rights Council. The
group burned a cellu-
lar phone in
protest in a
demonstration in
New Delhi on
November 11,
2002. Subhash Gupta,
the group leader,
alleges that SMS is
against Indian
culture and has
resulted in a rather
large number of divorces.

With all the heat on the ill
effects of wireless telephony
being focussed on the radia-

tion emitted from mobile
devices, this is one of the

first protests of its
kind against the
spread of SMS. The

Council argues that
the brief, yet
effective language

used in SMS sparks
discord among
married couples.

Perhaps cause for
concern rises from the
nature of SMS, where
one can chat with just

about anybody
using a mobile
phone.

SMS causes divorce

Soon, a hundred lucky
households in Cardiff,

Wales, will live the broadband
dream and, perhaps, a glimpse
into the broadband future—
movies on demand,
broadcast quality
video chats and
d o w n l o a d
speeds at 4
Mbps. This
new service is
based on
Mesh radio, a
high capacity wire-
less network. Unlike
conventional wire -
less networking services,
this one turns every end user’s
house into a mini base sta -
tion. With four directional

antennas that lock onto other
antennas, each mini base sta-
tion achieves nearly a 100 per
cent cover. If a station goes
down, recovery is easy—

come back on and
lock into the

n e i g h b o u r ’ s
antenna. 

M o s t
b r o a d b a n d
users in India

suffer because
there are too
many sub-

scribers and too little
bandwidth. In this

radical new system, Mesh
radio will not slow down
when a lot of people access it
at the same time.

89% of internation-

al e-commerce users

base their buying

decisions on transac-

tion security, while

59% base theirs on

price

Source: WorldPay eCommerce Survey

snapshot
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Roron
A new worm called Roron or
Oror.B could help hackers
control home computers. It
can spread through e-mail,
shared drives and the KaZaA
network. Each copy of the
virus contains several hacker
tools that let an infected
computer be controlled by
messages from Internet Relay
Chat (IRC). Once Roron
infects a system, it spreads by
creating e-mail messages
with different subject lines
and names for the attached
file. Once opened, Roron
copies itself to several folders,
including those used to share
files on the KaZaA network,
as well as to any shared hard
drives on a network. Finally,
Roron installs a backdoor into
the PC that lets remote
attackers run attack tools.
Though Kapersky Labs
attaches high risk to the
virus, Symantec rates Roron
as only two on its threat scale
of five. Updating your anti-
virus software should take
care of the virus.

Fishy on Linux
Backdoor.Bofishy.C is a Trojan
that affects the libpcap packet
capture library and the tcp-
dump sniffer on Unix and
Linux systems. It comes as
modified source packages
that create a backdoor during
their installation that gives the
attacker access to a shell on
the local computer. Users and
administrators are advised to
turn off unnecessary services,
patch all running software
with the latest updates, espe-
cially Internet services and
configure e-mail servers to
block or remove e-mail that
contains file attachments that
are commonly used to spread
viruses, such as vbs, bat, exe,
pif and scr files. 

redalert

n AOL offers instant messaging servers and clients to businesses n Japanese firm develops technology to transfer data via handsets at 10 Mbps 

Word on the street is that
there are 101 things

that Mozilla can do
that Internet
Explorer 6 can-
not. The list
that has been
filtering through
programmer news-
groups and discussion
forums was created by
Neal Deakin, a 28-
year-old resident
of Toronto,
Canada. Popu-
lar with the
open source

community, Mozilla is a
standalone open source

browser created by
Mozilla.org. Deakin
though cautions

against reading too
much into his list—
quite a few of the

items on the
list are long
time grouses

against Inter-
net Explorer, such as

the lack of
being able to
n a v i g a t e
t h r o u g h

multiple windows through
tabs and the inability to block
popup ads. Other grievences
include the lack of people-
friendly tools such as the abil-
ity to zoom text, save plugins
while saving a Web page,
adding detailed information
about bookmarks and the abil-
ity to block images from third-
party sites. There is also addi-
tional mention of user-friend-
ly cookie management, easy
password management, form
filling, better security and the
claim of being able to run
straight off a CD or a network.

Early in November 2002,
Philips Electronics annou-

nced that it has developed a
new DVD Writer in an
effort to promote the
DVD+RW format.
Philips debuted the
main meat of a pro -
posed DVD+RW drive
that has an integrated
chipset, optical pickup unit
and a reference design. The
drive claims to record at

speeds of up to 8x. Philips
holds the key patents and
stands to obtain significant

revenues from licens -
ing, should DVD+RW
become a dominant for-
mat in the near future.
The company will
license and sell compo-
nents for the drives and

hopes to see manufacturers
making them available in the
first half of 2003.

101 reasons to switch to Mozilla

statattack

Philips joins the DVD format war Mac-ing it easy

If you are a PC user moving
towards a Mac, this is just

the software
and hardware
combinat ion
that could ease
the transition.
M o v e 2 M a c
comes with a

lot of software and a cus-
tomised USB cable that lets
PC users move many of their
files and settings into a Mac-
intosh running the new OS
X. The software will also let
you keep your background
pictures, by transferring them
onto the Mac.

Detto Technologies, the
developers of this software,
reportedly received no fund-
ing from Apple, though
Apple intends to carry it into
their retail store. Apart from
Internet settings, files and
contacts, the other things
such as pictures and music
are automatically moved into
the right location on the new
Mac, without much tinker-
ing. With Apple’s new cam-
paign focussing on luring PC
users to the Mac platform, it
appears that the scales may
just have been tilted!

INFOGRAPHICS: Jaya Shetty

/
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Supercomputing
On November 4, more than
1,000 computers across
Canada were wired up to
create a huge networked
supercomputer, used to
model the interaction of two
molecules in 20,000 different
positions and measure the
energy bonds which this cre-
ates—a single desktop would
take over six years for this.

Tablet PC
Microsoft has signed deals
with top publishers Forbes,
Financial Times , New Yorker,
Slate, France’s Les Echoes and
Germany’s Wirtschafts Woche
to help make the Tablet PC
more popular. A trial set of
the magazines should be
available for download in
2003.

Digital voting

America is pioneering digi-
tal voting, but security chal-
lenges seem far too many.
Large-scale fraud, like vote-
buying and selling, are sim-
pler on a computer that is
vulnerable to hackers and
viruses. Moreover, the soft-
ware used for voting pur-
poses is proprietary and the
vendors control it, leaving
its accuracy to question. 

Philanthropy
PowerUp, a three-year-old
project that gave away
computer equipment to
schools and community
centres across the United
States has been shut down.
The weakening economy
has forced its founders to
close down the program
aimed at bridging the great
digital divide..

zeroes

Source: Gartner Dataquest

$4 billion worth
of Linux servers
expected to sell in
2003, shipping about

8 lakh units

snapshot

Users of Symantec’s Norton
Internet Security 2003 have
discovered that the software
causes e-mail to be deleted
before it reaches the
user’s inbox.
Symantec says
that the flaw
comes from the
anti-spam fea-
ture in the
software that
tags suspect-
ed spam, and
has fixed the problem with
a patch. If the user had a large
volume of mail arriving or if
the client was frequently
checking e-mail, then Norton
Spam Alert would cause mem-

ory allocation errors that lead
to e-mail deletions. For such 
e-mail, all that appeared in

the inbox was a cryptic
message with
‘Symantec E-mail
Proxy Deleted

Message’ in
the subject
line. 

The prob-
lem faced by
Norton’s cus-
tomers is simi-

lar to what many Hot-
mail account users face, with
strict spam filters in place.
Hotmail follows a very strict
policy of blocking all the mail
from offending ISPs.

Symantec deletes more than spam
followup

You could soon be buying
and legally downloading

movies from the Internet, or
so hope five of the major stu-
dios in Hollywood. Sony Pic-

tures, MGM, Paramount Pic -
tures, Warner Brothers and
Universal Pictures have joined
together and announced tech-
nology partnerships with
Microsoft and RealNetworks to
jumpstart movie-rental servic-
es on the Net. Industry execu-
tives are ecstatic at what they
call the bounty of video-on-
demand. Moreover, distribu-
tion is planned to be secure
and unbreachable. You can
now download over 175 new
and old movies from
movielink.com . The movies, of
course, don’t come for free—
you are required to pay any-
where between $1.99 (approx
Rs 100) and $4.99 (approx Rs
250), depending on how new

the movie is. Once down -
loaded, it will remain for 30
days on the hard drive, though
once you have started to play
the movie it will remain only
for 24 hours. Moreover, it can-
not be transferred to any other
device, and this they hope will
curb trading of movies over
the Internet via P2P networks
such as KaZaA and Morpheus.
This service is operational only
in the US right now and dial-
up users are strongly discour-
aged. While it is an interesting
concept, it does have its prob-
lems. Firstly, you could rent
DVDs and keep them for at
least two nights for the same
price. Moreover, even with
broadband connections, it
could take up to 4 hours for a
single download. On the other
hand, code hackers aren’t
keeping quiet—pirates are
already talking about circum-
venting these measures. They
claim that unless the movie
‘self destructs’, there is every
possibility that a solution
could be found!

Blockbusters on the Net

n Nokia to launch N-Gage, a-game-console-and-cell-phone-in-one, by February 2003 n Shockwave.com launches GameBlast, a new subscription game service 

A leaking keyboard

In what looks like an amaz-
ing security goof up, an HP

wireless keyboard user in Nor-
way discovered that what he
typed into his screen appeared
on a friend’s monitor, some
150 metres away—supposedly
far out of range and blocked
by at least two solid walls.
With HP and the user initially

assuming that this was a one-
off fault with that particular
keyboard, they settled on a
replacement. Even after
replacement, the keyboard
signals still reach across 150
metres! HP is now considering
doing field tests to ascertain
the reasons behind it. 

HP has sold some 65,000
wireless keyboards in Europe
and a smaller number in
North America. What is wor-
rying is the fact that such a
strong signal gives the users
no control over who receives
it, compromising on their
security. Already, it is possible
to illegally intercept signals
emitted from them, but in
this case, the device is literal-
ly beaming the signals far
and wide, singing away to all
and sundry!

Illustrations: Farzana Cooper
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Released last month, Hit-
man 2: Silent Assassin ,

from the UK-based publisher
Eidos, had come under fire
from members of the Sikh
community for having depict-
ed the religions’ adherents as
members of an evil cult.

In the final mission, Hit-
man 2 features a violent show-
down in a gurudwara and the
player is encouraged to enter
and kill a group of fanatical
believers. In a statement

released by the company,
Eidos and IO Interactive, the

developers, have stressed that
no offence was intended and

has apologised to the Sikh
community for the depiction.
Eidos claims to have reached
an amicable position with the
Sikh Coalition and will now
edit all offending content.

All the relevant content
from the Hitman 2 official
Web site will also be removed
and changes will be made to
the forthcoming GameCube
version of the title, which was
scheduled for release early
next year.  

Hitman 2 publishers apologise

Intel has just released the
fastest ever Pentium 4

processor, that clocks a cool
3.06 GHz and is the first to
feature Hyper-Thread-
ing. However,
W i n d o w s
XP is the
only Windows
OS that can take
advantage of this.
Hyper-Threading technology
should yield between 14 to
26 per cent improvement in
performance, claims Intel.
The technology ‘tricks’ the

underlying software into
believing that there are in
fact two CPUs. The software
can’t make out the differ-
ence, so it works as though

there were two
a c t u a l
CPUs. It

w o u l d
mean, for

e x a m p l e ,
that while

playing a game, frame rates
are slightly lower because of
the processing done by the
CPU for the soundcard, the

OS and so on. With Hyper-
Threading, this overhead will
be negligible. Tests by several
enthusiast sites on the Inter -
net have revealed that this
chip does score very well—in
fact, it is not incorrect to call
this mock-SMP (Symmetric
Multi Processing), a setup
where more than one CPU is
used. All this is expected to
come at an expectedly heafty
price and the CPU has
already caused an immediate
price war with AMD halving
prices of its older CPUs. 

Buy 1, get 1 virtually free

Iridigm, a San Francisco
based company has devel-

oped a new reflective screen
technology using a micro -
electromechanical system
(MEMS) called an Interfero -
metric Modulator, or iMoD.
This device can yield screen
brightness as much as three
times that of other liquid crys-

tal displays, while consuming
less power. The display is
made of two conductive
plates—one is a thin film stack
on a glass substrate, and the
other is a metallic membrane
suspended over it. The gap
between the two is filled with
air. The basic principle is the
idea of light interference—the

same principle
found within
shimmering but-
terfly wings that
give it the irides-
cent colours!

Looking better
Philips may soon help you

place a song you can’t
remember. All you will have to
do is dial a number
and place your  cell
phone near
the speaker
when the
track is
played. A com-
puter tallies it
against a database
and sends you a text message
with the relevant information.
Hashing, the technology used
here, breaks the tune into 33

narrow frequency bands and
the energy of each band is

measured. When
a tune is
played, the

c o m p u t e r
cross checks

it with the
existing database.

Philips hopes to
have a database
of over a

1,00,000 songs
and estimates that just three
seconds of playtime should
give you an accurate match.

Musical directory

The last bastion of P2P is
under threat—realising that

university networks offer stu-
dents high bandwidth and the
opportunity to swap music and
movies, the Recording Industry
Association of America and the
Motion Picture Association of
America sent letters to more
than 2,000 colleges, warning
them that their networks were
used to trade illegal file copies.
The Electronic Privacy Infor-
mation Centre (EPIC) sent let-
ters to universities asking them
to consider before installing
tools to monitor the file swap-
ping networks, as increased
network surveillance could
dilute the already scarce uni-
versity resources.

Don’t fight P2P

n MS memo claims its efforts to disparage open-source software may be backfiring n Apple to add DVD writer to PowerBook n IBM to push mobile HDDs to 80 GB

Source: ComScore Networks

Online music sales
drop to $545
million in the
first three quarters
of 2002, from
$730 million
in the first three
quarters of 2001

snapshot
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Atechnology using devices
called Organic LEDs

(OLEDs) might just end the
quest for a more cost-effective
alternative to TFT displays.
While this new technology
initially used an expensive fab-
rication process where multi-
ple layers of light-emitting
materials had to be deposited
sequentially in the devices,
recent breakthroughs have
allowed them to be fabricated
using a single layer. This allows

OLEDs to be fabricated at sig-
nificantly lower costs, giving
them higher brightness, con-
trast levels and resolutions. It
will also eliminate the need for
a backlight, thus greatly saving
power requirements—ideal for
mobile display applications. 

Also, while OLEDs were
originally capable of emitting
only a single colour, a newer
process called down-conver-
sion created by Anil Duggal, a
researcher at the General Elec-

tric Global Research Center in
New York, will allow multiple
colours. Through this process,
an OLED is placed face down
on a glass substrate and the
opposite side of this substrate
is deposited with particles of
dyed polymers. When light
from the OLED enters the
polymer layers, some of the
photons are split or down con-
verted by the phosphor parti-
cles into two longer wave-
length photons. 

“Breaking into Mac
isn’t something that
gets a hacker kudos
in his or her com-
munity. Breaking
Microsoft gives that
person the ego 
dollars that they
depend upon”

Dan Kusnetzky, Vice
President of systems soft-
ware research at IDC,
explaining why Microsoft
systems are more often
hacked than other OSes

“All legitimate busi-
nesses online have
an incentive to fight
piracy, obviously as
this study shows. It
affects everyone”
A representative for the
Recording Industry Asso-
ciation of America, on the
need for anti-piracy meas-
ures, in view of a study by
ComScore Networks that
showed a drastic slump in
online music sales this year

Acclaim Entertainment’s
BMX XXX will not contain

topless nudity in
its PlayStation2
version. The
game’s trailers
featured strip -
pers, coarse lan-
guage and the tag
line ‘Keep It
Dirty’. However, protests from
various parents groups as well

as the refusal by big retailers to
stock the controversial game

have finally led
to an edited ver-
sion for the
PlayStation 2
release. The
XBox and Game-
Cube versions,
however, will

not be ‘sanitised’, said the
company. 

If it wasn’t enough that com-
puters are being used to cre-

ate special effects in movies,
Broadway has now embraced
the PC passion-
ately. 

In a new
m u s i c a l ,
Dance of the
Vampires, the
entire set
made up of a
six-ton ceme-
tery, changes in
under a minute. The
entire arrangement, from the
lighting effects right down to
shifting the six-ton graveyard,
is governed by a computer
needing a supervisor to just

flip a switch. Intelligent lights
change colour, focus and fade
right on cue with smoke pour-
ing through ports on the floor

and music
p u m p s
t h r o u g h
s p e a k e r s
monitored
by a com-
puter-assist-
ed keyboard,
g i v i n g
enthusiasts
the perform-

ance of a life-
time. One does won-

der though, if the show
would go on, should the com-
puter crash!

Acting digital

Organic Light Emitting Diode
tomorrow’stechnology

No XXX in BMX XXX

quoteworthy

Reliance is targeting

40-50 lakh 
customers, and

expects to make 

Rs 4,000 crore
in the first year of its

WLL service

snapshot

Source: Economic Times

In a hard blow to the fight for
right to privacy on the Net,

the Virginia Supreme Court
ruled against America Online’s
plea that a subpoena calling
for revealing a subscriber’s
identity be quashed. Califor -
nia-based Nam Tai Electronics
filed a complaint in January
2001 alleging that 51
unknown individuals, includ-
ing an AOL subscriber, had
posted false and unlawful mes-
sages on a discussion board.

C l a i m i n g
trade libel and
violations of
Cal i fornia ’ s
unfair busi-
ness practice

statutes, Nam Tai requested
the California Supreme Court
to subpoena the AOL user. Pri-
vacy and democratic rights
groups are appalled at the rul-
ing, as courts all over the US
protect the individual’s privacy
and anonymity rights. 

AOL filed a motion argu-
ing that it cannot reveal sub-
scriber information as it
would infringe on the First
Amendment rights that guar-
antees an individual the free-
dom of speech and the right
to anonymity. AOL now has
10 days to appeal to the Vir -
ginia Supreme Court or turn
over the name. If the Virginia
court rules against AOL, then
AOL can appeal to the US
Supreme Court.

Privacy at stake

n BMG to manufacture only copy-protected CDs henceforth n Tablet PCs from Acer, Toshiba and ViewSonic range from $2,000 to $2,500 
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Dear Venkatesh,
Your belief that 40 GB hard disk drives have a greater tendency
to develop bad sectors is a fallacy. A simple case of bad luck might
have more to do with your friend’s drive crashing, than its 40 GB
capacity (we’ve got a substantial number of similar capacity
drives that are running completely trouble-free in our offices). The
best way to avoid bad sectors is by taking necessary precautions
such as refraining from moving the drive while it’s in operation
and providing clean, uninterrupted power to your computer.

DECEMBER 2002

Q. What do you think about Digit’s unique 
half-flap covers?

Your vote counts

Since you are this undecided, we’ll stick with the tried and 
tested for now.

34%
For

33%
Against

33%
Gimme Models

This month’s question:

“Would you replace Backbyte with a
monthly technology quiz?”

Log on to www.thinkdigit.com and vote on it
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Hi Srinivasa,
You are absolutely right. Falling speeds as
a result of an increase in the subscriber
base is a primary problem affecting
broadband services in India. Service
providers need to strictly enforce Quality
of Service and ensure that their bandwidth
increases in proportion to the number of
subscribers. 

n The Walking Gigabytes story
on Page 74, Digit November
2002, incorrectly mentions that
the Zip 250 and 750 do not fea-
ture a manual eject button.
Both the Zip drives have the
said button.

n In November issue’s Bazaar
section, the contact informa-
tion provided for Busy Lite 3.0
on Page 89 is incorrect. The
correct contact is Busy
Infotech Pvt Ltd, Phone: 011-
7375062, Price: Rs 1,500.

n The Drive-in Bytes story on
Page 56 in the same issue
mentions that the LG 8320B
contains 8 MB of buffer. It in
fact only has a 2 MB buffer.
Thanks for pointing this one
out, Vishwanath.

Notice any goof-ups? Write to
goof@jasubhai.com

Goof Ups

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes
Miss October
Hi Vinit, 
Your October edition was a
real treat; the centre-
spread workshop on
‘Reviving your Dead PC’
was especially outstanding.
I am a hardware student
and I found that piece to
be of great help.
Shiva Kumar
Via e-mail

Spread the good
word
Dear Vinit, 
I have been reading your
magazine since its incep-
tion and I love the articles
and reviews. Lately I’ve
run out of storage space,
but I simply cannot get
myself to give away Digit
to the raddiwalla. Can you
please suggest an alterna-
tive means to give the old
issues away?
Chirag
Via e-mail

Since knowledge and wisdom are
best shared, you could donate the
old issues to your local library
and give countless others an
opportunity to learn about the
wonderful world of technology.

DECEMBER 2002
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Popular culture has always been bombarded
with the thoughts of science fiction writers and
pop directors. Whether it is mass-hysteria cre-
ated by the radio transmission of H.G. Wells'
War of the Worlds, or the drones of fans that
religiously subscribe to the worlds of Star Trek
and Star Wars, fiction has always teased and
appeased the human mind. Cars that can talk
and drive themselves, buildings that fly, robots
that help around the house, androids that are
almost human, universal translators, aircraft
that do all the flying for us…joining all these
seemingly disparate dots is the common thread
of Artificial Intelligence. The concept that we,
as humans, will one day create entities that will
be non-differentiable from us in thought and in
action. Will the line between fact and fiction be
always a thick bold one? Are we doomed to
conjure up things larger than life whilst we
struggle to cure the common cold? Let us see
whether science today has succeeded in ren-
dering some of our fondest dreams into reality,
even as we look further, into the brave new
world of the future.

AHMED S H A I K H

features n
n technology next

The bad news is that KITT is still
years away—as of now, you cannot

hope to control your car with a cell
phone. The good news is that there are
autonomous systems that allow some
amount of back seat driving. Typically
such systems, such as the Distronic
found in the Mercedes S Class of cars,
do little but regulate the distance
between vehicles, speeding and slow-
ing as and when required. The better
news is that something a little more
evolutionary, that can cope with the
urban traffic, where lane rules and road
regulations are easily forgotten, is in
the making. This new car contains two
microprocessors that figure out where
the car is in relation to others and to
the boundaries of the road. The vehicle
is driven by software AI techniques of
shape recognition and comparison. It’s
based on a database consisting of three-
dimensional models of roads and road
elements. Thus, facets of road intersec-
tions, types, typical road-widths, cars,

trucks and pedestrians are all accumu
lated within the database. Mounted in
front of the car are cameras that take
snapshots of the surrounding environ
ment and send them to the processors
nestling within. The processors then
use the AI routines to compare the pic
tures to the ones within the database.
The car will thus ascertain its position
and speed with respect to the other
vehicles, the road and pedestrians. The
processor then steers, accelerates and
decelerates as needed. The system is
not perfect since the decisions are
based on ideal road widths and it per
forms best on slow speeds.

Future cars could share a collective
consciousness of sorts; a distributed
software environment reminiscent of
the Borg collective. Akin to the swarm
ing behaviour of birds, AI routines will
render this collective to act in unison,
keeping distance, maintaining speed
.and ensuring that you reach your des
tination safely and effectively. 

Sleek, black, fast and talkative. Riding
autonomously on all fours with an indestructible
body to boot. This was KITT, a Pontiac Trans-Am
and the star of the 1982 television series Knight
Rider. Can we ever hope to own a car that drives
itself? 

? 
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Using a combination of data collected from radars, satel -
lites and wireless networks, an airplane is more aware of

itself and its airspace than it has ever been. These systems act
as early-warning alarms, automated co-pilots, navigational aids
and even landing assists. For instance, when a rudder or the
wing flaps of an airplane malfunction, there is precious little
that a pilot can do to avert disaster, since these systems do not
have fallbacks. AI routines developed by NASA have been used
to keep a plane flying even when it otherwise wouldn’t. The
software is based on a neural network—an AI routine that
enables a program to perform a series of tasks by learning
through trial and error. A flight control system keeps an eye on
data such as the plane’s airspeed, heading and the forces expe-
rienced by its elements such as the wings and the tail. This
data is then compared to a safe set of numbers, which would
be encountered when things are working optimally. When

something awry is detected by the control system, the
neural net kicks in and takes control. The network sifts
through the alarming data six times a second to work out the
best means of using the operational systems of the plane to
maintain normal flight. For example, if it detects a useless
wing-flap, the net would guide the airplane into a pre-deter
mined manoeuvre, maybe banking the entire structure to com
pensate for the flaps. The neural net was able to keep a test
plane in control even at a supersonic speed.

A neural net, along with surface recognition algorithms and
data gathered from satellites can theoretically, fly and land an
aeroplane. Although such a system might never find everyday
use, scenarios wherein the pilots are not available would not end
in disasters, like they currently do. Hostage situations, in partic
ular, could be foiled, as a neural net would guide and land the
plane in a safe territory without needing human input.

Making up for the lack of a brain
in Dr Frankenstein’s monster,

scientists are busy tinkering with cre-
ations that can think. A computer
program that closely mirrors the
manner in which humans learn in
the social menagerie of life. These
new portents of intelligence use a
technique called inductive logic pro-
gramming—knowledge supplied by
the scientists in the form of rules and
rule-execution criteria. The programs
use this information to learn from
their system in what can be termed
as ‘experience’; and for their own
benefit, tweak and change the base
rules. It is an evolutionary process
that relies on feedback from the envi-
ronment. 

So what are the benefits of such
programs? Researchers have already
assigned them the role of molecular

biologists: the analysis of protein
structure. In one such scenario, the
programs successfully ‘self-discov-
ered’ a previously unknown carcino-
gen. They were also able to extrapo-
late and extract new rules that gov-
ern the manner in which a three-
dimensional protein structure is
formed. Success has not been restrict-
ed to the field of biology—mathe -
matics was gifted a new sequence of
integers called refractorables, by a
similarly thinking software routine.

A thinking piece of software is
well in demand in various fields, rang-
ing from military—a smart bomb that
designates and destroys enemy targets;
to medicine—a smart pill that finds
home in your body and delivers drugs
based upon the feedback it receives
from your immune and circulatory
system.

The 1986 Disney film, Flight of the Navigator, showcased the story of a young boy
taken on an interstellar ride by a sleek silver spacecraft that called itself MAX.
When can we expect our current modes of flight to go sentient and fly us around
the universe? 

"Dave, this conversation can serve no purpose any
more. Goodbye." Thus ran the chilling conversa-
tion between the AI program HAL 9000 and the
space explorer Dave, moments before Dave
breathes his last. Are software programs smart
enough to be compared with HAL from Stanley
Kubrick’s Space Odyssey 2001?

? 

? 

Mechanised wheelchairs
that help the disabled are
already a market reality.
These futuristic wheel-
chairs can take
the form of
motorised,
gyro-controlled
vehicles that offer
stability and an abil -
ity to climb stairs.
They also sport pres-
sure-sensitive manoeu-
vring systems that can be
used to steer the machines
with the faintest of blows
from the mouth. Experts at the
Osaka University in Japan have
used AI techniques to take the
current-generation of wheel
chairs onto a higher level of
automation. You can call the
chair towards you, for example,
by simply gesturing with your
hands. Video cameras mounted
on the machine along with facial
recognition and motion detection
software allow just such behav
iour. The chair can be steered
with sideway head motions—

Automated Help
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edsters

Probotics, a small company, has
developed Cye—an answer to

domestic woes that took 10 years in
the making. Cye resembles a dustpan
on wheels and is designed to serve you
dinner and clean the carpet. It uses a
personal computer as the hub of its
tasks. The user defines the chores that
need to be performed, by dragging and
dropping icons within a computer
program and Cye takes over from
there. Before bending its back though,
the robot needs to know the lay of the
land. This task requires the owner’s
input, so that the robot is guided from
one extreme of a room to another
using a mouse. It then explores
between boundaries thus defined,

interpolates the data from its treks and
conjures up a map of the space in
question. Once mapped, the machine
navigates using a pair of wheels that
double up as rudimentary sense
organs. Whenever the wheels
encounter resistance to their motion,
the force is translated into electronic
signals that the machine can under-
stand. Cye can therefore detect obsta-
cles in its path using these wheels.
Thus aided, the robot will arm itself
with a vacuum cleaner and attack the
carpet with the vigour reserved for
mechanical nuts and bearings. When
it runs low on power, it stops what it
is doing and heads to the nearest
recharging pod for a breather.

Kismet is a robot, complete with
eyes, eyebrows, ears and lips—

an experiment that is destined for
adorable, if not great things. Creat
ed by a Massachusetts Institute of
Technology (MIT) team headed by
Rodney Brooks, the robot is meant
to self-learn just like a two-year-old
human toddler. Traditionally, AI has
been about implementing software
algorithms that define a set of rules
to replicate the world and another
set to define the robot’s behaviour
within the simulated world. Brooks
thinks differently. Rules are never
defined, but are emergent. Kismet is
built on a tree-structure of simple
components; the complexity of
behaviour is only visible on an over
all scale—the robot can communi
cate its desires using a range of
expressions that cover interest, sad
ness, surprise and anxiety. Similar
techniques can equip us with the
tools to implement complex emo
tion and feedback systems into the
robots of tomorrow. 

The German Research Center for
Artificial Intelligence (DFKI) along

with IBM and Siemens has jointly
developed an AI system that aims to
bridge the language gap. Language
resources such as lexicons, grammar,
and test suite form the foundation of
the technology. Built upon this are
components for the design and imple-
mentation of a language such as word
‘taggers’, sentence parsers and sentence
generators, along with tools for the
maintenance of terminologies and dic-
tionaries. Finally, AI routines that help
in speech analysis and synthesis are
brought to task. The entire system 
performs a bevy of tasks including
information extraction from spoken

sentences, cross-lingual information
access, linguistic analysis and grammar
checking. The system has been com-
mercially implemented in the form of
Verbmobil, a cellular phone service
that can translate spoken English, Ger-
man, Japanese and Chinese in a few
milliseconds at an accuracy rate of
close to 90 per cent. 

Better AI routines are all that stop
speech synthesizers from becoming uni-
versal translators. Spoken words are a
part of the communication process,
which includes gestures and body lan-
guage. The ultimate translator would
thus be one that analyses not only words
but also the slight tilt of the head that
separates a comment from a conde-

We grew up with the Jetsons family and half
expected the wonderful world of flying cars, auto-
mated sidewalks and the floating buildings to
come alive. Will robotics bring Rosie the robot
maid out of the television screen and into our
homes?

? 

The inimitable series by Douglas Adams, The
Hitchiker’s Guide to the Galaxy, had a peculiar ele-
ment to it—an alien fish, which when appropriately
inserted could instantaneously translate between
any and every language. Termed Babelfish, will the
real world ever hold it with its ear?

? 

Go back to the
1986 hit movie,
Short Circuit, star-
ring an emotionally
wrought, self-
aware, existential
robot, Number 5.
Can AIBO, Sony's replace
ment dog, ever hope to be
as emotive and expressive
as that movie’s star?

? 

scending remark.
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Humans bring with them cognitive
biases: they rely too much on one

set of information without looking at
the entire picture formed, often with
disastrous results. To minimise errors
and to eventually produce a silicon
stock market capable of simulating the
lows and ups of the real thing, AI tech-
niques are pitched together. Rule sets
are created with data extracted from
market snapshots of the past. Software
agents are then hired to simulate buy-
ing and selling decisions based on
these rules. These decisions are then
passed on to a human who does the
actual transactions. Each decision
made by such an agent is accorded a
weightage based on the degree of suc-
cess of the choice. Successful agents are
then ‘bred’ together—a snippet of code
from here, a snip from there and you
have birthed something new. Muta-

tions can also be introduced in the
progeny by toggling the 1s and the 0s
involved. The resultant offspring are
similarly evaluated on their successes
and the process is repeated till a
healthy ecology emerges wherein soft-
ware agents of repute move up the lad-
der while the faulty ones fade into
extinction, taking the associative rule
sets with them. To add to the heady
mix are fuzzy logic elements that can
base decisions on a range of data,
rather than discrete values of the same.
Such cocktails have been used to con-
struct expert systems—software pow-
erhouses designed to replace a human
professional such as a market analyst.

Built upon the power of supercom-
puters, an expert system can perhaps one
day answer the age-old questions about
‘Life’. Nirvana, via your friendly neigh-
bourhood computer!

Move over AIBO, enter
Robokoneko. Proving compre-

hensively that cats are indeed smarter
than dogs, the robot kitten is all set to
take centre stage with a brain powered
by the electrical firings between some
40 million artificial neurons. The
brain will consist of 72 programmable
silicon chips whose connections
between constituent transistors can be
electronically rewired. To maximise
their potential, connections will
repeatedly be reconfigured to repre -
sent 32,768 different modules. As the
brain cycles through these modules at
a rate of 300 times per second, the
effect will be akin to a singular entity
with a virtual bank of 37.7 million

neurons. Since the task of program-
ming a bank as complex as the kitty’s
brain seems illogical, the scientists
turn to genetic algorithms for respite.
Codes of software will be let to brew,
intermingle and share snippets
amongst each other, eventually lead-
ing to the creation of a neural network
based on the best-of-breed software
snippets.

Take a brain as complex as
Robokoneko’s, add in the expressions
and the emotional ability of a Kismet and
stir vigorously. Blend in face recognition
software, speech analyzers, speech syn-
thesizers, a healthy dollop of automated
limbs and voila, a fully functional
android is at your service. Happy living.

How are viruses, bacteria and the
Internet inter-related? Sex. The

Net is a mass of connections, strung
together at nodes that physically
manifest as routers. These routers
have a fixed buffer capacity that
determines their ability to accept,
store and re-route data. Sometimes
the data arriving at these nodes are
lost by the router. What is needed
then, is a mechanism by which the
buffers monitor themselves, analyse
the incoming packets and adjust
their lengths accordingly. So where
does sex come in? Bacteria repro
duce in a very efficient, albeit non-
exciting manner: when two such
cells come in contact with each
other, genes snippets are exchanged.
Successful genes are propagated,
while ineffective ones fade away.
Software codes behave similarly—
strings of data imitate the gene snip
pets that are then collated and inter
spersed between the software. These
code snips let the buffer adapt and
evolve as per the needs of the data. 

This could be put to use across
phone lines, making dropped calls
and busy lines a thing of the past.

Precogs: Humans with the ability to predict a
crime even before it is committed. Thus went the
premise of the 2002 hit movie, Minority Report.
Can science ever develop a piece of software or
hardware to predict the future? ? 

Bicentennial Man, the 1999 film starring Robin
Williams told of Andrew Martin, a household
android who begins to feel genuine human emo-
tions. Will a robot ever reach a level of intelligence
to be considered sentient and maybe, even human?? 

“Agent Smith”, say
it in the soporific
drone of the vil-
lain that plagued
Neo and the crew
in The Matrix.
Smith was created
as a figure to police and
maintain hegemony over
the humans in the virtual
network that enmeshed
the fictional world. Can
scientists come up with
software codes that will
serve the Internet in a
similar fashion?

? 
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Panasonic DVD-LV65
For your viewing pleasure
This portable DVD player offers 2.5 hours of
viewing time. Its 5-inch widescreen LCD
monitor can be adjusted for a wide range of
viewing positions and allows you to view
DVD movies in the 16:9 widescreen format
or conventional 4:3 format. The DVD-LV65
can play a variety of audio and video disc
formats such as DVD-Video, DVD-RAM,
DVD-R, Video CD, Audio CD and CD-R/R.
You can also view JPEG images and MPEG4
video, and listen to MP3 files. There are out-
puts for optional DTS and Dolby Digital sur-
round sound decoders, providing six dis-
crete audio channels. So switch on the DVD
player, bring out the popcorn and enjoy!
Web site: www.panasonic.com

Digital accessories to match your attitude

HP Jornada 928 WDA Pocket PC
Two-in-one wonder
Voice, data and personal information management integrat -
ed in one device? That’s what the 928 WDA offers you. It is
based on Microsoft’s Pocket PC 2002 Phone Edition software
and combines a PDA with a GSM/GPRS-enabled phone.
Thanks to its dual screen design, you can access the phone
and Pocket PC functions independently of one another—the
PDA applications on a 16-bit colour reflective TFT screen,
and the phone functions on a blue-backlit phone display.
The 928 WDA features voice-activated dialling and a dual-
battery system that includes a rechargeable lithium-polymer
battery which gives you an estimated 3 hours talk time or 12
hours PDA usage and 120 hours standby time. 
Web site: www.hp-expo.com
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Casio Exilim Wearable Card
Camera EX-M2
Slim is in!
This little device has a 2.0 megapixel CCD, 4x
digital zoom, and the ability to record up to 30
seconds of video. For memory, it has an SD
Memory Card, a MultiMedia Card and 12 MB of
Flash memory. The camera supports Print Image
Matching II and comes with a USB cable and
software that simplifies image management—all
in a package that is 11.3 mm thin and weighs
just 88 grams. Oh and did we mention that it
acts as an MP3 player also? You can get nearly
five-and-a-half hours of playback on a full charge.
What more could you want in a camera?
Web site:
http://world.casio.com/exilim/en/ex_s2/style
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MadPlayer
Tunes for you 
An MP3 player is an MP3 player, is an MP3 player.
Right? Take a look at MadPlayer and you just might
change your ideas. This MP3 player can store music in
all the popular file formats, including MP3, WMA and
MIDI. It has a karaoke functionality, an FM radio and
uses a soundbank of over 550 instruments and sounds so
you can create tunes in a huge range of styles and gen-
res. Besides, it lets you be your own DJ—you can choose
the music style, add samples and effects and even share
your creations. There’s a standard 32 MB Smart Media
card, upgradable to 128 MB. A built-in audio output jack
lets you connect it to practically anything—your home
stereo or any other device that can record MP3s or burn
them on CDs. So if you’ve got a tune, just play it!
Web site: www.madplayer.com

Archos Jukebox FM Recorder 20 GB  
Your entertainment centre
A 20 GB hard drive, USB 2.0 compatibility, data transfer rate
of up to 480 Mbps, 300 hours of CD quality MP3 music at
128 kbps, 450 hours of radio recording at 96 kbps, 700 hours
of voice recording at 64 kbps, continuous playback time of
up to 12 hours or 20 GB of data. No, we are not listing out
the specifications of a PC. This tiny little pocket-sized MP3-
player-cum-recorder-cum-FM-radio allows you to record from
any analog or digital source and to port your recordings back
to the PC without any specialised software—just drag and
drop MP3 files from Windows Explorer. This versatile device
can also be used as a voice recorder.  
Web site: www.archos.com
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Hari Raghavan, aged 24,
comes across as your reg-
ular MBA yuppie, sport-
ing a clean shave and an

endearing twang. What makes his
colleagues take a double take as he
marches into his office is the red
and white stick he uses. ‘Chal-
lenged’ by retinal degeneration
since the age of 17, Raghavan is a
marketing executive with one of
India’s leading publishing houses.
His job profile involves two
extremely sight-centred activities—
computing and travelling. Thanks
to special tools built into common
applications and some add ons, he
is able to do his work remarkably
well within the same setup that is
used by the rest of the office. 

In the overall employment and
market scenario, where every half a
degree separates the employed from
the unemployed, physical impair-
ment can be a big drawback—espe-
cially so if it is of the visual nature.
In a workplace, the employment of
any differently abled individual
means extra investment in terms of
infrastructure and hence, the choice

between hiring an able-bodied per-
son and a blind one is already made.
In this kind of economy, especially
in a developing country, it is quite a
struggle for the disabled to acquire
jobs. In order to amend this, it is
essential that they are educated by
the same standard and have similar
skill sets as others so that they can
easily fit into existing work envi -
ronments. 

The need then is for chameleon
like devices and applications that
blend in with the already existing
environment. Fortunately, there
are plenty of tools available that
allow this.

Inherent support
The source of input and feedback is
the most crucial part of an applica-
tion for those who are incapable of
receiving conventional feedback.
This naturally points to Braille, the
tried and tested medium of com-
munication. However, a basic
drawback with Braille is the learn-
ing curve involved, not to mention
the ‘unlearning’ one has to do of
conventional reading and writing

methods. This is especially difficult
for those who have lost their sight
gradually or by an accident. 

K. Ramakrishna, a general man-
ager at IDBI bank, found that
Braille was inadequate for his
mathematical and statistical
requirements. “Not that the teach-
ers at the National Association for
the Blind didn’t try their very best
to teach me Braille,” says he with a
snigger, ‘I think I was just too lazy
to learn.”

Also, the introduction of, say a
Braille printer or keyboard in a
functional workplace spells addi-
tional effort, which few are ready
to undertake. However, this same
crack lets in the light for comput-
ing—since Braille has such limita-
tions, we have to fall back upon
regular alphabet reading. For those
who already have the concept of a
PC and its navigation, OCR and
screen reading software are ideal. 

Visual disability can be classi
fied as either partial or complete
blindness. The former obviously
lends a certain degree of independ-
ence compared to the latter. A

ILLUSTRATION: Atu l
Deshmukh
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features n
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Our vision when we started the company was a computer on every desk and in every
home. 
In this setting, I think the word to emphasise is ‘Every’. The PC can be a tool for everyone

“

COMPUTING FOR

Absolutely Everybody
COMPUTING FOR

Absolutely Everybody
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features n
n firsthand

transparent architecture to support either
of the disabilities is inherently present in
most technologies. Simple magnification
methods present in Windows such as
increasing the font sizes and using spe-
cial, high-contrast colour schemes help
the partially blind. 

Among the enhanced accessibility
features in Microsoft’s Windows 2000 and
XP are two utilities called Narrator and
On-Screen Keyboard, which along with
the previously introduced Magnifier, are
installed by default with the operating
systems. They appear along with the
Accessibility Wizard and the new Utility
Manager in the expanded Accessibility

menu, found under the Start button. Such
utilities provide a minimum level of func-
tionality for many people with disabili-
ties, without requiring additional soft-
ware and hardware.

While Magnifier, Narrator and On-
Screen Keyboard do not replace full-fea-
tured accessibility aids, they allow users
with disabilities to effectively use a com-
puter running Windows. Narrator is par-
ticularly useful to the visually impaired as
it is a text-to-speech program that can
narrate as a user types. The On-Screen
Keyboard displays a virtual keyboard on
the screen, enabling users with limited
mobility to input text using a pointing
device like the mouse. The Magnifier, as
suggested by the name, enlarges sections
of the computer screen for increased read-

ability, a boon for users with weak or fail-
ing eyesight. 

However, both the Magnifier and
the Narrator are but assisting tools that
can not offer the user complete inde-
pendence. The Magnifier helps only
those with failing vision, while the Nar-
rator, by its maker’s own confession,
“allows only a minimal level of func -
tionality for users with special needs”.
The situation demands utility programs
with advanced features that let users
perform day to day tasks with complete
independence.

A glimmer of light
Many a surprised colleague has
stopped by Raghavan’s desk, kindly
letting him know that his monitor is
switched off as he types furiously away
at his keyboard. Raghavan explains
patiently that he doesn’t need the
monitor to be switched on since he
uses a software called Window-Eyes.
Developed by GW Micro, this is a
screen navigating software that reads
out explicitly what is presented on
your monitor display—default but-
tons, spaces, line breaks and punctua-

tion included. A series of configured keys
let you choose a particular line to be read
out slower or even spelt out. The rest of the
functions, such as file saving, changing its
location, and maximising and minimising
a window can also be configured as per the
user’s convenience and preference. The
pace of reading can be set to a speed com-
fortable to the user.

Raghavan got through his BCom years
with the help of traditional human readers
and writers during examination and by
studying with the aid of audiotapes record-
ed by his mother. The vacations preceding
his final year took him to the US where he
was introduced to various OCR software
and to Window-Eyes. By the time Ragha-
van returned, he was happily rattling away
at his keyboard while the speakers prattled

out the words. Since Raghavan was already
accustomed to using the PC before he lost
his sight, the screen narration emanating
in an American drawl from his speak
ers/headphones as he used Window-Eyes
was easy to decipher.

While the thought of travelling across
two continents to learn computing may
seem impractical to most visually
impaired people, help is available closer
to home. Karishma Enterprises in Mum
bai is the master distributor in India
JAWS for Windows (www.freedomscientif
ic. com), a popular and user-friendly screen
reading software. It enables the visually
impaired to learn and operate computers,
independently.

JAWS for Windows, developed by
Freedom Scientific USA, has the credit of
being a pioneer in its field. Ramakrishna,
one of the early users of JAWS for Win
dows, used a DOS-based version as early as
1986. The software reads information
from the computer screen and speaks it
back via a speech synthesiser. The USP of
the software is its intuitiveness and ease
of use. This is further enhanced by the fact
that most of the people working on this
project are visually impaired. The speech

Braille was
inadequate 
for my 
mathematical
and statistical 
needsK. Ramakrishna

GENERAL MANAGER, IDBI

“
”

Karishma Enterprises, run by Ram
Agarwal, who is also visually
impaired, specialises in importing
assistive devices. The company’s
Web site, www.brailleworldindia.com
lists the different devices that can
be ordered, and also has a job
directory and a space for those

interested in setting up computer
and electronic training institutes
and projects. Karishma Enterprises
undertakes the setting up and
installation of these centres as well
as the training and orientation of
the staff. It also provides consultan

Assistive Devices

Apart from software enablers, there
are hardware devices that let a visually
impaired person use the computer in
as natural and effortless a way as pos -
sible. Devices that give the users the
‘feel’ of the screen through various
products such as refreshable Braille
displays, touchpads, screen reading
software or speech synthesisers, are all

aimed to provide such an experience.
But such devices are not easily avail -
able and may not match the budget
and preference of the user. Adapting
them to an already set infrastructure
like say, a work place where the basic
work devices such as the printers and
PCs are connected to each other,
becomes quite a task—to install a

Hardware Solutions

Brailleworldin-
dia.com has
an exhaustive
directory of
assistive
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synthesiser offers support for seven lan-
guages—US English, British English, Ger-
man, Italian, French and Latin Spanish.

The latest version incorporates fea -
tures such as Smart Screen Technology to
provide flexibility with menus and dialog

boxes. A speech pad enables single-hand-
ed operation and voice configurations. It
possesses enough intelligence to analyse
the screen content and then speak, mak-
ing it easier for the user to work unfamil-
iar applications. It also works in tandem

with Windows, which means that any
enhancement in the OS, such as XP will
be adapted to JAWS for Windows. 

Filling the void
So are these tools restricted to a privileged

few? Not at all. The makers of
the technologies themselves are
instrumental in spreading it to
the intended audience. Most
NGOs that set up computer
training centres for the visually
impaired consider only the costs
of their sighted teachers—the
equipment is sponsored by evan-
gelist NGOs and developers of
the technology. The Indian
Association of the Visually
Handicapped (IAVH), an associ-

ation dedicated to informing, counselling
and aiding the visually impaired, was
built on grants from IDBI Bank, Microsoft
and the HDFC bank. It has training cen-
tres in Mumbai, Pune, Nagpur, Hyderabad
and Thiruvananthapuram. The Victoria

Bobby: A Web accessibility software
that is compliant with existing acces-

sibility guidelines. It
enables visually impaired

people to access and enjoy the same
information available on the Internet
that is available to the rest of the
world.
Web site: http://bobby.watchfire.com/
bobby/html/en/index.jsp

Focus: The Focus series of Braille dis-
plays come with keys
that allow the user
to navigate any soft-
ware without reach-

ing for the computer keyboard. They
also have two audio inputs and one
output for maximum usability. Two
USB ports and programmable but-
tons further enhance its usefulness. 
Web site:
http://www.freedomscientif ic.com
/fs_products/displays_focusinfo.asp

IBM Home Page Reader 3.0: This soft-
ware utilises IBM’s ViaVoice text-to-
speech synthesizer for reading out
text, frames, images, text links, data
input fields and other details on the
Web. It is available in Brazilian Por-

tuguese, French, German, Italian, and
Spanish.
Web site: http://www-
3.ibm.com/able
/hpr .h tml

JAWS 4.5: Job Access With Speech is
designed to add speech output to
applications. It uses configuration
files to record speech parameters
such as volume, rate, pitch and frame
and macro definitions. The latest ver -
sion supports Windows XP and Inter -
net Explorer 6. 

Web site: http://www.free-
domscientific.com

/fs_products/software_jaws.asp

PAC Mate BNS: A handheld designed
exclusively for the visually impaired.
Running JAWS for Windows, it pro-
vides the same applications that have
been built for devices such as the
Compaq iPaq. The PAC Mate BNS has
Braille in and speech out capabilities
and the PAC Mate BNS has a QWERTY-
style keyboard with speech output.
Web site:
http://www.freedomscientif ic.com

Tool Shop

Technology is
what technolo-
gy does, and it
has made it
possible for me
to have a main-
stream careerHari Raghavan

CONSUMER MARKETING ,

“
”
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
After having tested and
reviewed 588 hardware and
software products during
the course of this year in
Digit, we bring to you the
Zero1 Awards, the defini-
tive award for excellence in
performance. If you want
to find out who’s the best-
of-class in the various 
product categories, turn to
the Zero1 Awards feature
this month. From 3D
graphics cards to games,
laser printers and scanners,
we bring you the products
that have excelled in tech-
nology, innovation and 
performance.

We also bring you a crop
of some of the most bleed-
ing-edge products in our
Bazaar section. Reviewed
here is the formidable Her-
cules 3D Prophet 9700 Pro
graphics accelerator—to
date, the fastest graphics
card in the world for gam-
ing. The product that could
just make the sub-Rs 20,000
PC become a reality. Find
out also how the new Mini-
ITX form factor mother-
board from VIA stacks up in
our tests. 

There are also a host of
droolable peripherals such
as the Logitech Cordless
Freedom Optical keyboard
and Microsoft’s new wireless
Intellimouse Explorer optical
mouse. 

On the software front,
we review the newest itera-
tion of Red Hat, version
8.0, and also a couple of
great tools such as Norton
AntiVirus 2003 for combat-
ing the threats posed by
the increasing army of
viruses, and Adobe LiveMo-
tion 2.0, which will help
you add pizzazz to your
Web sites.

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features—far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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Like with passengers on a speeding train, our perception of
technology is but a fleeting blur—technology is constantly
changing, sometimes faster than you can grasp! And this year
has seen some of the most influential arrivals in the field. With
advancements in processor fabrication processes, quantum
leaps in 3D graphics hardware design, and smoother and more
efficient application software, our experience of technology has
evolved from working with toolbars to getting the maximum out
of our beige box. 

Be it games, communication or office tasks, the combination of
today’s bleeding-edge hardware and feature-rich software has
raised our levels of interaction, efficiency and experience to
higher peaks. We have been witnessing these changes
throughout the year in our labs, so we think it only fitting to
bring you the best on a platter at the end of the year. 

In the never-ending quest for the faster, higher and stronger,
we bring you the Zero1 Awards 2002.

IMAGING: Swaroop Biswas

DECEMBER 2002
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Unreal Tournament 2003

Smoke streaming through floor gratings, a flickering blue
light reflecting off a steel door, rusted girders looming
through a murky corridor—Unreal Tournament 2003 is the

path-breaking game that set new standards for realism in 3D
gaming. It sports a radically new game engine that allows for an
intensive level of detail and environmental splendour, which
can be enjoyed even on a mid-range machine without slowing
down to a slideshow. Retaining all the classic elements of a
winning First Person Shooter, the game has vast and playable
levels, radical weaponry and modes of gameplay to keep an
enthusiast riveted for hours. It also features one of the most
realistic physics engines where bodies and elements move and
react to external stimulus more realistically.

Incorporat-
ing a very
powerful set
of level edit-
ing and cre-
ation tools, the
playability and
the level of varia-
tion in this game
can be supple-
mented with
user-created add-ons and enhancements, ensuring that 
Tournament 2003 , like its predecessor, will continue to enjoy a
long life.

Ardent gamers are not used to settling for anything lower
than the best when it comes to their favourite games,
be it a first person shooter or a racing simulation. But

at the rate that graphics technology advances, what’s hot
today is stone cold a few months down the line. This year has
seen some of the most formidable technologies, where more
pipelines, and faster core and memory speeds have allowed
cards such as nVidia’s GeForce4 and ATi’s Radeon 9700 to blur
the line between high performance gaming and cinema-like
graphics.

Behind the polygons
Forthcoming games will use larger, more detailed textures.
Game developers are already going all-out in creating high-
polygon count models and game characters. These games will
demand Programmable Pixels, at least 64 MB of DDR video
memory and of course, faster core and memory
speeds. Programmable GPUs allow game
developers to create custom effects in
models and environ-
ments—all this spells
the need for the fastest
video memory you can
afford on your graphics
card and faster AGP
interfaces such as AGP
8x. Also remember that you
will need a powerful system
processor to run these
graphics powerhouses.

These factors will ensure that you won’t have to live through
your first DOOM 3 experience like it was a slideshow! 

And the award goes to…
The graphics card that impressed us this year with its best-of-class
processing power and stunning frame rates in games was the
Gainward GeForce4. Sporting a 300 MHz core speed and 128 MB

of DDR memory (effectively running at 640 MHz), the card
delivered the highest frame rates we have ever seen in

gaming: in Quake III Arena, even with the reso
lution cranked up to 1024x768, with 4x anti-

aliasing, 32-bit texture depth and with all other
quality settings kept at their maximum values, this
card pushed out over 100 fps on a test system com
prising of a 2.8 GHz Pentium 4 processor! With
this card, you will be able to enjoy the latest games
at butter-smooth frame rates without sacri
on graphics quality.

3D GRAPHICS

GAMES

Name

GeForce4
Ti 4600

GeForce4
Ti 4200

Comments

This GeForce4-based card has 64 MB
of DDR memory. It logged a com
mendable score in our gaming bech
marks, making it an idea complement
to a fast gaming system

With a 250 MHz core and a 444 MHz
memory speed, this 64 MB DDR
memory-based card packs the horse
power to get you through your gam
ing escapades comfortably

Gainward
GeForce4
Gainward Co Ltd, 
Ph: 886-2-26966777

The verdict: This card has a massive 300 MHz core
and 640 MHz of DDR memory. It shattered all record
on our gaming benchmarks, proving to be the fastest
vehicle for a killer gaming experince!

Unreal
Tournament
2003 
Milestone

Interactive Software, 
Ph: 022-28381614
The verdict: With a new game
engine that allows greater detail, Unreal
Tournament 2003 sets new standards for
realism

Nominees
Contacts

Xserve India Pvt
Ltd,
Ph: 080-5202915

Xserve India Pvt
Ltd,
Ph: 080-5202915
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Once upon a time, CD-Writer drives were so expensive
that they didn’t feature on most people’s upgrade list.
But the technology behind these drives has developed

rapidly and simultaneously, the cost of manufacture has
dropped, resulting in a range of very affordable drives. 

Today, prices of CD-Writer drives equal those of DVD-ROM
drives and most budget processors. Most CD-Writers (in similar
speed ranges) are priced in the same range, making it difficult to
choose one. However, keeping in mind the parameters that do
affect the performance and reliability of these drives, one can
decide which is best suited to a particular task. While different
CD-Writers support varying speeds for write and re-write tasks,
there is a point beyond which the effective speed of CD-Writers
does not make any real difference. 

The burning decision
A year ago, CD-Writers supported speeds such as 12x write, 4x
re-write and 32x read. Then a 650 MB CD-R written at an 8x
speed, for example, would take about 15 minutes. In compari-
son, today’s fast 48x20x48x drives can write a 700 MB CD in
under 4 minutes at the fastest setting. However, every disk has
a lead in and lead out which takes about a minute to
complete. Therefore, even with faster CD-Writer
drives, you would not be
able to tell the difference
in speeds as you would
between, say, a 12x and a
24x drive. Also, you need
to have media that is
compliant with such high
write and re-write speeds. 

Hence, your choice of CD-
Writer should not be dictated
by speed alone, but in con-
junction with other parameters such as the buffer size and the
buffer underrun technology. The larger the buffer on your drive,
the lower are the chances of facing buffer underrun errors while
writing a CD even if you are performing other tasks on your
computer. This becomes very crucial, as most of us tend to 
multitask. 

Along with faster write speeds, today’s CD-Writers also try
to write more reliably even with other applications running in
the background. In order to take full advantage of these tech-
nologies, you need to look for similar support in your drive’s
software for creating various types of CDs such as Video CDs
and for creating Audio CDs directly from the MP3s on your
hard disk. With most internal drives pushing the 48x write
speed mark and the lowest drive beginning at 32x, the limits
of speed have been redefined. Also, prices for most internal CD-

RW drives are such that the variance is not more than a thou
sand rupees between the slowest and the fastest drives out
there. If your work involves occasional CD-writing where you
would not need to burn many CDs on an ongoing basis, then
an entry-level 40x drive would be a good choice. However, if
speed is critical, especially in professional applications where
quality is also paramount, then it would make sense to invest
in a 42x drive that features at least an 8 MB buffer with some

form of buffer underrun protection so as to prevent any lost
CDs while other applications are also running during

the burn process. 
In the case of external CD-Writers, the

most important parameter is the inter
face. While external CD-Writers are
functionally similar to internal CD-Writ

ers, their performance is maximised only
if your computer sports an interface similar
to that of the external drive. Therefore, if
you plan to buy an external drive based on
the new USB 2.0 standard, it exploits its
fullest potential only if your computer also
has a USB 2.0 port. Otherwise, it would be

limited to the significantly lower 12 Mbps bandwidth of USB
1.1 and you won’t be able to write CDs at more than 4x. If you
are going to be taking the drive with you between computers,
it would also be advisable to invest in one that is light, 
yet built sturdy so that it can withstand a rigourous life on 
the road.

And the award goes to…
The Writer that came out a winner this year was the Iomega
CDRW55296INT-B 48x24x48x drive. It boasted of high write
speeds and very good data transfer performance, even as a 
CD drive. Despite the fact that it featured just 2 MB of 
buffer memory, its SMARTBURN technology ensures that it
reliably writes CD-Rs and CD-RWs even at the highest speed
setting.

CD-WRITERS

Name

ASUS
CRW-
4816A

LITEON
48x12x48
CD-
Writer

Comments

This 48x CD-Writer boasts of very
good write speeds and features tech
nologies that let it write disks even if
data is temporarily suspended, allow
ing it to take off from where it
stopped

This CD-Writer drive did well in the 
write and re-write tests and given 
its performance, it is also very 
affordable

Nominees
Contacts

Neoteric
Infomatique, 
Ph: 022-
24172600

Mediatech India, 
Ph: 022-
56396696

Iomega
CDRW55296INT-B
Neoteric Infomatique, 
Ph: 022-24172600

The verdict: This 48x write, 24x rewrite drive boasts of
best-of- class speeds and also performs very well while
reading CDs
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This year has witnessed a host of new technologies in the
cellular cosmos. While the beginning of the year saw a
lot of improvement in the basic GSM cellular services,

towards the latter half of the year, many of the big service
providers introduced new, more advanced functionality in
cellular services such as always-on Internet connectivity and
new standards such as CDMA and MMS. While we are
gripped at the cusp of this explosive growth, it is only testa -
ment to the fact that the forthcoming year will put the world
in your palm, via your cell phone. With service providers
ramping up their technology, it follows naturally that 
the Indian market will be flooded with new cellular devices
that support these technologies and services—we are already 
seeing the first trickle with GPRS and MMS-capable 
cellular phones.

Make the right call
Various factors are instrumental when you go out to buy a cel-
lular phone. At its very basic level, every cellular device in the
market lets you make and receive calls, work with SMS and pro-
vides basic scheduling and contact management functionality.
Depending on personal preferences, one would either need as
many functions and features the phone has to offer with the
price being no bar, or one would require basic functionality, with
the price being a crucial aspect. 

If you intend buying a new cell phone in the new year,
look for a combination of basic functionality and support for
future standards and services. Along with considering the tra-
ditional factors such as memory for contacts and messages,
long battery life, scheduling, calendar and PIM functionali-
ty, you should also demand
higher specifications in
each of these. Set your
sights on a phone that
offers storage for at least
250 phone numbers,
greater memory for storing
SMS, and standby and talk
time in excess of 15 days and
5 hours, respectively. Even in
the lower end phones, you
should ensure that there is
some form of basic PIM functionality such as scheduling and
remider capabilities. Also, it is a wise choice to go in for a  phone
based on Lithium Ion batteries as they feaure long talktimes and
useable life.

On a higher plane, you should also look at more advanced
features that will let the phone adapt to newer technologies.
Bluetooth compliance is one such feature to look for. This 
wireless standard promises to deliver a transparent wire-free

experience when used with other Bluetooth-capable devices.
GPRS compliance and MMS functionality should also be kept
in mind for a better multimedia experience and for enabling
access to information on the Web. To facilitate all this, your
phone will need a good screen with a relatively high resolution
and preferably with colour support. Last but not the least, 
consider parameters such as weight, size and looks—these
would, of course, depend upon your individual preferences 
and personality!

If you want exclusive boasting rights, search for funky 
features such as backlit displays with many colours, poly
phonic ring tones and full-colour screens. Finally, always see

the phone and ask the vendor to demonstrate a few
of the features of the phone to you. Use it for a

while and see if it is comfortable to hold and
operate, especially if you have large or small
hands. Make and receive calls and see that the
volume of the speaker is loud enough for you
to hear clearly without having to strain 
yourself.

And the award goes to…
The cell phone that stood out head and
shoulders above this year’s crowd in terms
of functionality, features and performance
was the Sony Ericsson T68i. Fusing tech
nology with great looks, this phone 

supports various standards such as GPRS,
MMS and Bluetooth, and is a true pioneer
of cellular phones to come. It keeps you
busy on long trips with eight games and

can hold 510 contacts, 150 messages and 30 calls. With its
advanced Lithium Ion battery, it delivers a standby time of up
to 15 days and a talk time of over 6 hours on a single charge
session.

With its 256-colour screen, joystick menu navigation 
system and lightweight form factor, this phone gives you 
a surprisingly wide array of technology in a very small 
package.

Name

Nokia
5510

Nokia
8310

Comments

Boasting of a keyboard for easier
SMS entry and an in-built MP3 
player, this cellphone integrates a lot
of functionality

With trendy looks, a large contact
memory and an integrated FM radio,
this phone delivered very good 
performance and functionality

Nominees
Contacts

Nokia, 
Ph: 011-6779000 

Nokia, 
Ph: 011-6779000 

CELL PHONES

Sony Ericsson T68i
Ericsson 
Ph: 022-24962142
The verdict: With features

like MMS and GPRS capability, a
large phone and message memory
and a full colour screen, this tiny
cellphone packs a lot of technol-
ogy into a small size
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Ontrack SystemSuite 4.0

The system suite most worthy of the Zero1 Award this year
was Ontrack SystemSuite 4.0. This software comprises a
wide array of tools and functionality to keep your system

operating at its peak levels. Its good performance can also be
attributed to its effective firewall and registry cleaner. This reg-
istry cleaner provides a power interface that lists duplicate and
null entries from where you can delete specific entries. The fire-
wall not only protects your computer by blocking ports but also
includes functionality that makes it suited to home users. 

This software presents a unique tool called EasyRecovery, which
recovers permanently erased data as well as files from formatted

partitions! Anoth-
er tool backs up
critical system
files—an invalu-
able feature for
users who install
numerous applica -
tions and expose their
critical files to rogue
programs. All these
protective and innovative measures are available at a very afford
able price tag, spiralling Ontarck to the top pedestal.

The type of computer you buy is largely decided by the
choice of its components and your budget. At the outset,
there is an array of system components and even platforms

to choose from. The best way to approach this decision is from
the point of view of the applications you have in mind for your
machine—are you going to use it for gaming or to surf the Net?

Name your brand
A Pc for gaming and entertainment would need a robust multi-
media subsystem. For gaming, buy the fastest processor, the most
RAM and the best graphics card your wallet permits. Also invest
in a 17-inch monitor at the very least and a good sound system.
The latest motherboards integrate full 5.1-channel sound and
Dolby Digital soundcards are also pretty affordable now. Team up
one of these sound systems with a good speaker system—go for
at least a four-channel speaker system. A good system for enter-
tainment would be one based around a 1.5 GHz processor or
higher, 256 MB to 512 MB of RAM, at least a 40 GB 7,200-rpm
hard disk and the best 3D accelerator card you can afford. 

For Web and multimedia authoring, or system-intensive soft-
ware such as page layout and image editing applications, your sys-
tem should allow you to
multitask effectively, with
ample room for running
and storing your applica -
tions and data. Go for a sys-
tem with a 1.3 to 1.5 GHz
processor, 256 MB RAM, at least
a 40 GB hard disk and a 17-inch
monitor to give you enough
real estate to work the applica-
tions at higher resolutions. 

For simply surfing the Net

and using e-mail, word processing and spreadsheets, a satisfac
tory choice would be built around an 800 MHz to 1.2 GHz-class
processor, 256 MB RAM, a 40 GB 5,400-rpm drive and a 15-inch
monitor. A motherboard with integrated sound, video and net
working subsystems would be quite economical here. 

And the award goes to…
The computer that delivered the best

performance during 2002 was the Visu
alan Lavish. With its best-of-class sub
systems, it showed excellent

performance in all our tests. Run
ning on a 2.53 GHz Pentium 4
processor, 256 MB of DDR RAM and

a 40 GB 7,200-rpm Seagate Barracuda
hard disk, this PC did very well in the office
productivity tests. When coupled with the
ATi Radeon 7500 and a 17-inch LG E700S Fla
tron monitor, its gaming performance was
also quite commendable. This system impart
ed additional functionality with its wireless
mouse and its 32x CD-Writer drive.

Name

HCL
Beanstalk
4455

HCL
Beanstalk
4458

Comments

With a 2.4 GHz Pentium 4 CPU and 
DDR RAM, this computer delivered very
good performance and also came with a
good set of connectivity options and
peripherals

Running on a 2 GHz Pentium 4 CPU and
DDR RAM, this computer fared com
mendably in the tests

Nominees
Contacts

HCL Infosystems
Ltd, 
Ph: 0120-4555219

HCL Infosystems
Ltd, 
Ph: 0120-4555219

Visualan
Lavish
Visualan

Technologies, 
Ph: 022-27686817
The verdict: Powered by a formidable 2.53 GHz
Pentium 4 CPU, DDR RAM and an ATi Radeon 7500
graphics card, this computer performed brilliantly—
ideal for processor and graphics-intensive applications

DESKTOP PCS

Ontrack SystemSuite 4.0
Ontrack, 
E-mail: sales@ontrack.com

The verdict: With plenty of functionality
such as an integrated firewall and the
ability to recover files from even format
ted partitions, this suite is a must-have

SYSTEM SUITES
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Adobe Photoshop 7

The most-loved image editing software has just become bet-
ter. Adobe Photoshop 7 has enriched the user interface with
smoother buttons and inherent cosmetic enhancements.

Your workspace and the arrangement of palettes and toolbars can
now be saved and used later by different users. Underneath this
new interface is a range of new tools such as the intuitive visual
image management system. You can browse through your image
files here in a thumbnail view with an intuitive Explorer-like nav-
igation interface, which also displays a preview and information
about the image. Another enhancement is the bloated number of
over 50 brush presets. The newly incorporated AutoColor com-

mand is  an effective
one-click colour
correction tool.
With numerous
additional func-
tionalities such as the
improved Liquefy tool
and the Pattern Maker,
the creative possibili-
ties are widespread,
making Photoshop 7 a
clear winner.

Once things get into the digital realm, it naturally gains
advantages such as portability, ease of archiving and
most importantly, no loss of quality even after duplica-

tion. Though digital cameras have been around for some time
now, their technology and functionality has come to the fore
only in the recent past. With denser CCDs, smaller form factors,
more features, exhaustive options, longer battery life and, most
importantly, a fall in prices, digital cameras are slowly but sure-
ly creeping into the price bracket of the amateur shutter-bug.

Getting in focus
The optical parameters of a digital camera are identical to those
of conventional cameras. This includes the focal length of the
camera, the optical zoom, the exposure modes, the manual and
auto focussing methods and metering modes. However, more
important than these are parameters such as the CCD sensor,
the amount of memory for storage, the LCD viewfinder, battery
type and menu navigation system. 

A camera with a 1.3 megapixel CCD sensor is a good place to
start for beginners—their resolutions go up to 1280x1024 at 72-
dpi. Though not suited for printing, it is adequate for viewing
and sharing them
online. For basic print
photo needs, you need
at least a 2.1 megapix-
el CCD—this allows a
resolution up to
1600x1200, which is  ade-
quate for postcard-sized
prints. 

All digital cameras
use some form of Flash

storage. Opt for at least 8 MB of Flash memory or higher—the
more you can afford, the better. Optical zoom gives clearer close-
up shots compared to digital zoom. Digital cameras are also noto
rious for chewing up batteries. Opt for Lithium Ion batteries as
they are lighter and offer greater capacities; the next best are
NiMH batteries. 

And the award goes to…
The camera that shone bright in our tests this
year was the formidable Olympus Camedia C-
2100 Ultra Zoom. With its 2.11 megapixel sen
sor and various modes for metering, flash and
white balance, the camera captured stunning
images. The icing on the cake was the 10x opti
cal zoom and class-leading 27x digital zoom that
allowed you to get really close and personal with
your subject. With a wide array of features, excel
lent build quality and brilliant imaging per
formance, this camera turned out to be the
undisputed winner.

DIGITAL CAMERAS

IMAGE EDITING

Name

Fuji
FinePix
2800
Zoom

Nikon
CoolPix
800

Comments

Boasting of a 6x optical zoom, this
2.1 megapixel camera sported many
controls for great photography even
for amateurs

Sporting a 2x optical and 2.5x digital
zoom, this 2.11 megapixel camera
boasted of a large number of control
options for creative photography with
many controls over manual settings

Nominees
Contacts

Jindal Photo films
Ltd,
Ph: 022-
28514441

Aver Software
Technologies,
Ph: 022-
26320472

Olympus Camedia 
C-2100 Ultra Zoom
Komal International, 
Ph: 022-22614015

The verdict: This 2.11
megapixel camera, with its outstanding 10x optical
zoom and 27x digital zoom, delivered unbeatable pic-
ture quality with plenty of features for creative digital
photography

Adobe
Photoshop 7

Adobe Systems India Pvt Ltd, 
Ph: 914532026
The verdict: With plenty of enhance
ments such as the visual image man
agement interface, many new custom
brush settings and tools that simplify
commonly used tasks, Photoshop 7
still remains the best in image editing
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DVD-ROM drives are here to stay. Armed with complete
backward compatibility for CD-ROM drives, enhanced
functionality in terms of larger data storage and the fact

that you can watch Dolby Digital movies on them, these enter-
tainers are on everyone’s wish list! A lot has changed over the
past year with DVD-ROM drives—most importantly, the speeds
and the price. Till recently, users dismissed DVD-ROM drives as
an unnecessary expense. But due to the spread of DVD movies
and the fact that their price has been plummeting for the past
one year, DVD-ROM drives are now considered an essential
upgrade from the CD-ROM drive. Even though there aren’t too
many applications made for the DVD, it still makes sense to
invest in this drive as it warrants higher speeds and total 
compatibility with CD-ROM drives, especially if you are a
movie buff.

Under the lens
When considering a DVD-ROM drive, there are a few parame-
ters that you should consider. These are not very different from
the things that you would examine when buying CD-ROM
drives—the read data transfer speeds, access time and interface
still need to be considered. Most 16x DVD-ROM drives available
today boast of sequential read speeds in the range of 6 MBps to
8 MBps. The access times of these drives range from 70 ms to
150 ms—the lower, the better. Don’t buy a drive that is rated
to run lower than this speed and stay far away from sub-
16x DVD-ROM drives. Drives with access times lower
than 70 ms will be
slow when you work
with CD and DVD-
based applications,
especially if those
applications cause the
drive to read in a random
fashion.

As with any optical
drive, make use of its DMA
(Direct Memory Access) support by enabling the DMA mode
from your operating system and from the BIOS. Your machine
may show symptoms of degraded performance during DVD 
playback if you run the drive in PIO (Programmed Input/
Output) mode. 

Most drives are based on the ATA/33 standard though there
are a few that support ATA/66. However, this standard isn’t
very crucial, as optical drives never reach even half the band-
width offered by this interface. Finally, look for a drive that has
a large buffer—512 KB is standard but some drives are built
around 256 KB buffers—stay away from these. Apart from per-
formance, also consider support for as many standards as pos -
sible to ensure that it can be used with a vast spread of media.

Also, it is always adviseable to go for a DVD drive that also
packages a good bundle of software which can be used on the
drive such as DVD playback applications. Since the primary
use of DVD-ROM drives is for DVD movie playback, go for one
that bundles an application such as PowerDVD or WinDVD.
Some of the less popular drives do have an advantage of 
being better-priced, but they might not have a corporate Web
site that feautres things like regular updates to the drive’s 
BIOS to take care of possible bugs or adding functionaly and
performance. 

Finally, if you create a lot of MP3 files, you should check to
see if the drive supports Digital Audio Extraction (DAE) and if it
does, see that it is able to do so at speeds of at least 12x if you are

looking for performance.
There are standards like DVD-RAM, DVD-

RW, DVD-R, DVD+R and all of these are
not necessarily supported by all
drives—if a drive does not support a
particular standard, you will not be

able to read from that media. Even
though most users stick to DVD disks, there will
come a time when other DVD media formats will
be available. Therefore, it makes sense to invest
in a drive that supports as many standards 
as possible. 

Finally, make sure that the drive is able to
play all the DVDs available in your region. Most DVD drives are
region locked, that is, they can only play DVD movies from
regions that match their own. You can change the region codes
a maximum of five times, after which it stays locked at the 
last setting.

And the award goes to…
The drive that really shone in performance this year was the
Benq DVP-1648A 16x DVD drive. With blistering performance
in the read tests and an excellent access time, the drive
crunched through all the applications it was subjected to. The
icing on the cake is that it is also one of the most affordable
drives in the market.

DVD-ROM DRIVES

Name

Liteon
LTD-165H

Pioneer
DVD-
106S/2

Comments

A very commendable performer,
this 16x DVD-ROM drive deliv
ered very good performance and
is also very competitively priced

With its slot-in interface, this
DVD-ROM drive boastd very
good performance with excellent
build quality.

Nominees
Contacts

Mediatech India,
Ph: 022-56396696

Mnemonic
Systems,
Ph: 022-28010871

BenQ DVP-1648A
BenQ India Pvt Ltd, 
Ph: 022-25705230
The verdict: This 16x DVD drive

performed brilliantly in the read tests over various
types of data, making it the best suited to applications
needing frequent CD and DVD access
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Adobe Premiere 6.0

Adobe Premiere brings with it a host of added function-
ality and a very powerful set of features for working
with digital video. It includes FireWire support

through which you can hook up a DV cam to your computer
and transfer high-quality video for processing in NTSC or PAL
format. Many parameters such as the frame size and rate,
compression ratio, colour depth, audio, etc can be config-
ured. 

There is also support for the widescreen (16:9) format. A DV
editing mode enables the program to send captured and rendered
digital video through the FireWire port to an external device direct-

ly for full-quality
previewing. You
can create video
for the Internet in
a variety of opti -
mised formats
such as QuickTime and
RealMedia. Premiere 6.0
also contains a complete
99-track Audio Mixer
for professional-level
audio mixing.  

With the barriers between our professional and per -
sonal lives blurring, the need of the day is some -
thing that will let you transport your data efficient-

ly and reliably between computers. At one time, all we had
were the trusty CD-R and Zip drives. But today, there is a vast
variety of external storage devices tailor-made for our many
requirements such as the storage capacity, speed and most
importantly, adaptability with the wallet. As a result, we have
portable CD-Writers based on the USB 2.0 standard for fast
write speeds and even portable hard disk drives that can with-
stand physical shock and rough treatment. 

Choosing your backpack
The ideal external storage device for you is largely dependent on
your applications. There are three basic kinds of portable storage
solutions available today—portable CD-RW drives, portable hard
disks and Zip drives. Each of these are characterised by different
performance levels, capacity, compatibility and cost. 

The performance characteristics you need to consider are the
read and write data transfer speeds between the drive and your
host computer for different file types. Also consider the latency
and the access time when transferring and reading data. Exter-
nal CD-RW drives are known for the low cost and univer-
sal compatibility of their media and are therefore most
suited to home users and
applications that involve file
sizes under 700 MB. Zip drives
are suited only to applications
where the installed base of the
drives among users is large
enough to warrant you to buy
one. Since they are not known
for their speed and have storage

capacities comparable to CD-RW drives, they are not suited to
situations that require transfer of large volumes of data, quickly.

The most suitable performance devices for external data stor
age are the external hard disk drives. They offer high-speed data
transfer and plenty of storage capacity. Also, since they are built
around high-speed interfaces such as USB 2.0, data transfer to
and from these devices is faster than any other external storage
device. The USB 2.0 standard connects them to any computer
that has a USB port, though you would see the maximum trans
fer rates only when used on USB 2.0 compliant computers. The
only downside is that they are expensive.

And the award goes to…
The external storage device that gets kudos for sheer

performance this year is the Freecom FHD-1 20
GB external hard disk drive. It is based on the
USB 2.0 standard and delivered sustained
data transfer rates of 17 MBps when reading
data sequentially. With blistering perform
ances in both read and write tests for a vari
ety of file types, this drive is ideally suited to
applications that required gigabytes of data
to be transferred between locations.

EXTERNAL STORAGE
Name

Iomega 
HDD 20
GB

Freecom
FHD-1 60
GB HDD

Comments

This sleek 20 GB portable hard disk
provided quick access times and data
transfers, making it highly suited to
transporting large multimeida files

Boasting of a 60 GB size, this hard
disk sports a USB 2.0 interface and is
suited to transferring large amounts
of data between computers

Nominees
Contacts

JIngram Micro
India Pvt Ltd, 
Ph: 022-
25202901

J.S Equipments,
Ph: 022-
23810713

Freecom FHD-1 20 GB
J.S. Equipments, 
Ph: 022-23810713

The verdict: With USB 2.0 functionality, this drive pro-
vides the fastest method to get large amounts of data
ported from computer to computer

Adobe Premiere 6.0
Adobe Systems India
Pvt Ltd, 

Ph: 914532026
The verdict: With a host of features
like FireWire support for DV cameras,
export to web-based video fomats,
added effects and robust audio sup
port,  this a brilliant digital video edit
ing tool for professionals

VIDEO EDITING
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Windows XP Professional

Aproven operating system in a swanky new dressing,
Windows XP Professional still rules with its powerful fea-
tures, security and added functionality in a good-looking

and intuitive interface. It incorporates features such as ClearText
and the integration of hardware-accelerated graphics for the GUI.
The re-worked Start menu gives access to often used applications
and can be customised to individual preferences. On the security
front, it incorporates the robustness and stability of Windows
2000 and has a firewall for added security. With a redefined layout
for applications and system settings, controlling and accessing the
settings and components of the OS is easy. The process of config-

uring new peripher-
als and technologies
is intuitive with
most of the manage-
ment tasks being
wizard driven. This
OS even works well
with older programs as
they can be defined to
run in an environment
that mimics older
Windows OSes. 

Over the past year, hard disk drives have evolved from the
entry-level standard of 5,400-rpm to 7,200-rpm and
capacities now dictate that hard disks of 40 GB are the

bare minimum for any application. With further enhancements
in fabrication processes, manufacturing costs have been low-
ered and this has resulted in a drop in prices. This is the primary
reason why some 7,200-rpm drives today are only marginally
more expensive than their 5,400-rpm counterparts.

On the right track
When looking for a hard disk drive, the best way to decide
which one is ideal for you is to evaluate the technology used,
along with the capacity it offers. The parameters that influence
the performance are the data transfer rate while reading and
writing different types of data, access time, amount of buffer
memory and finally the interface. 

The 5,400-rpm drives naturally deliver lower data transfer rates
compared to the 7,200-rpm drives. For example, 5,400-rpm drives
generally offer sequential read data transfer rates in the region of
32 to 42 MBps, while 7,200-rpm drives offer 48 to 54 MBps. The
access times specified for 5,400-rpm drives should not be more
than 12 ms, while for 7,200-rpm drives it should not exceed 9 ms.
Faster access times will result in
speedier access to distributed sets
of data across your hard disk. 

Today’s hard disks sport
ATA/100 interface and the
newer ones are just beginning
to feature ATA/133 interfaces. Both
these interface feature maximum
data transfer rates of 100 MBps and
133 MBps, respectively. However,
in order to utilise them to their

maximum potential, they have to be supported by your moth
erboard and the resultant speed gains are only noticed when
the rotations speed of the hard disks are higher. Therefore,
7,200-rpm drives use these interfaces more efficiently than
5,400-rpm drives. Finally, the buffer on the hard disk plays an
important role in holding information temporarily when data
is being written to or read from the hard disk—the larger the
buffer, the faster is the response of the hard disk. Nearly all IDE
hard disks available today have a 2 MB data buffer. 

And the award goes to…
The drive that has the honour of being the

fastest drive of the year is the Western Dig
ital WD1000. This 100 GB monster is

based on a 7,200-rpm spindle
speed. It blazed through our tests
and clocked some of the fastest
data transfer rates we’ve seen in an

IDE hard disk drive. With excellent
data transfer rates in both sequential
and random reads and writes, this drive
is ideally suited to applications that
demand the best in storage bandwidth.

Name

IBM
IC35l080A
V VA07-0

Western
Digital
WD2000

Comments

This hard disk has a 2 MB buffer and a
7,200-rpm spindle speed. It is ideally
suited to applications that require quick
response from the storage subsystem

Sporting a whopping 200 GB capacity,
this hard disk delivered astonishing
speed in various types of data transfer
applications

Nominees
Contacts

Wales
Technologies,
Ph: 022-
23828100

ACI Infocom,
Ph: 022-
28266031

Western Digital
WD1000
ACI Infocom,
Ph: 022-28266031

The verdict: Boasting of a 7,200-rpm
spindle speed and a 100 GB storage capacity, this hard
disk drive shattered all records for data transfer speed
over various applications

Windows XP
Professional
Microsoft Corporation

India Pvt Ltd, 
Ph: 011-26292640
The verdict: With a host of functional
ity, great looks and a robust architec
ture, this operating system still shines
for even the most demanding office
applications

HARD DISK DRIVES

OPERATING SYSTEMS
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Adobe InDesign 2.0

In the battle for the perfect page layout software, Adobe
InDesign 2.0 proved its mettle. With its extensive support for
text and image handling, it makes working with complex

files such as brochures and magazines a snap. InDesign has spe-
cial support for working with image files from within the pro-
gram itself, therefore, you don’t need to resort to a separate
image editing software. Its ability to handle text effects and
tables is far superior compared to other page layout software and

tables can be
imported directly
from Word and
Excel files. The magic
of layers has been
exploited well. It can
also open files from
other applications such
as Quark Express. 

Inkjet printers bring all those visualisations, documents,
presentations and pictures to vivid life on paper. While
most high-quality printers in the beginning of the year

touched resolutions of 1440-dpi, towards the end of the year
we saw the best of the pack boasting print resolutions of up to
2400-dpi—and there seems to be no signs of this rise in 
resolutions stopping. 

Read the fine print
When talking about the performance of a printer, there are two
parameters that should be kept in mind—print quality and
printing speed. In print quality, the primary factor that deter -
mines the clarity is the resolution of the printer—the greater
the resolution, the greater is the number of dots it can pack into
a unit of area on a page. The latest printers support print reso-
lutions of up to 2400 dpi, which results in photo-quality prints
when using the correct paper. Before buying a printer, always
analyse a sample print under best quality mode and make sure
it meets your quality needs. 

If you are looking for quality, the type of paper supported and
the setting of the driver are two very important factors. For the
best possible prints, make sure that your printer
prints on special kinds of paper such as coated,
glossy or inkjet paper, as this results in superior
quality printouts. Also see that the printer has spe-
cial modes of printing images and photographs.

Secondly, analyse the print speed—this is
largely depen-
dant on the
type of docu -
ment being
printed. In the
case of graph-
i c s - i n t e n s i v e
documents, the
speeds would

understandably be lower than while printing plain text. A good
inkjet printer should have a text printout rate of about 9 pages
per minutes (ppm). In the case of colour photo printouts, the
time taken will vastly vary according to the type of print and
the quality chosen. 

While looking for speed, print using draft or economy
mode as this uses less ink and subsequently takes less time to
print. Finally, the interface plays an important role, especial
ly if you print in large quantities or if you print graphic-inten
sive files. A faster interface such as USB allows the computer
to spool print information much faster than an older interface

such as a parallel port. Finally, choose a printer
with a print buffer of at least 64 KB. The greater
the amount of buffer memory, the smoother
the printing of larger files such 
as photographs.

And the award goes to…
The best inkjet printer this year was the HP Deskjet

970CXi. With its formidable 2400-dpi print resolution
capability and support for a variety of papers, this print
er produced truly stunning prints and delivered good
performance when it came to print speeds over text and
graphics. It even managed to impress us in the profes
sional print domain.

Name

HP
Deskjet
920C

Canon
S4500

Comments

This printer sports a print resolution
of 2400-dpi and features a 2 MB print
buffer. It delivered excellent results for
photo printing

Based on a 1440-dpi print engine,
this bubble jet printer delivered good
results when printing graphically
detailed images

Nominees
Contacts

Hewlett-Packard
India Ltd,
Ph: 011-6826000

Canon India Ltd,
Ph: 011-6806572

PAGE LAYOUT SOFTWARE

INKJET PRINTERS

HP Deskjet 970CXi
Hewlett Packard India Ltd,
Ph: 011-6826000
The verdict: With an astounding 2400-dpi

print capability and 4 MB of buffer memory, this print-
er delivered stunning results in photo printing and
graphically demanding applications

Adobe
InDesign 2.0
Adobe systems India Pvt Ltd,
Ph: 914532026

The verdict: Adobe InDesign 2.0 has
very powerful text and picture han
dling capabilities, and gets top hon
ours in the page layout software cate
gory. For users of Adobe products, this
application sports a similar interface
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CorelDRAW 11

One of the best illustration software has just got better—
CorelDRAW 11 has some amazing new features and
functionality, making it one of the most powerful vec-

tor drawing applications. Its numerous drawing tools let you
create a variety of elements, and the customisable toolbars
and menus with individual macros can be saved to specific
workspaces. The cross-platform functionality lets you work
with files from different sources and the import/export filters
make this task simple. The three-point drawing tools let you
create a variety of curves and shapes with a minimum num-
ber of clicks. Tools such as Weld, Trim and Intersect allow speed
and efficiency when working with a variety of objects in a sin-
gle drawing. You can also save shapes and drawings that you’ve

created as ‘symbols’, which can then be saved in a library and
recalled on later projects. A bundled application called RAVE
lets you create cool rollovers and 3D vector extrusions to add
pizzazz to your vector-based animations. With
numerous new intelligent tools, CorelDRAW 11
is the best illustration application you can work

with for fast and professional results.

The ubiquitous mouse and the keyboard are our real inter-
faces into the digital world. Though there have been
numerous suggestions for more advanced forms of get-

ting information into the computer all through the years, there
is no device that has quite matched the convenience that the
keyboard and mouse offers—even after the arrival of such tools
as speech recognition.

Pushing the right buttons
Input devices are broadly characterised by their interface, func-
tionality, ergonomics and the technology used. In the case of
keyboards, the best kinds are those that offer good features and
are comfortable to type on. If you use many multimedia appli-
cations such as audio and video players, look for a keyboard
that offers many function keys with programmable buttons for
specialised tasks. Go for one with a USB interface. 

Wireless radio-frequency (RF) or infrared keyboards elimi-
nate the tangle of wires on your desktop. Opt for
the RF kind since they offer the freedom of
being anywhere in the room, and not nec-
essarily in the line of sight of the computer
to be able to
use them.

The most
i m p o r t a n t
performance
characteristic
of a mouse is the
resolution (in
dpi) and the
sampling rate—

this decides the smoothness of the response. Choose one with a
rating of at least 1000 dpi and a sampling rate of at least 80 Hz.
Avoid mice based on a serial interface as these support very low
sampling rates. Look for additional buttons 
for added func-
tionality in
working with
applications. For
pe r fo rmance ,
choose an opti-
cal mouse over 
a roller mouse as 
the former is far
smoother and
requires less  main-
tenance. Finally, try it out for feel and make sure that it is com
fortable in your hands and offers enough tactile response. 

And the award goes to…
Sporting a great looking design and colour combination, the
Logitech Cordless Freedom Keyboard is easily the keyboard of
the year. It has an array of buttons to control your multimedia
applications and has shortcut keys and application keys for
accessing specific features of your programs. The keys are
ergonomically placed and are tactile and responsive.

The mouse voted to be the best in its category is the Microsoft
Wireless Intellimouse Explorer. Using optical sensor technology,
this mouse features programmable buttons that can be used to
navigate through applications and control various features in
games. It gives you accurate control without the hassle of wires
on your desktop.

Logitech Cordless 
Freedom Optical Keyboard
Logitech, Ph: 022-26427501
The verdict: Using a wireless RF
technology, this keyboard offers a

hassle free interface to your computer. It
sports a good design, with responsive keys
and plenty of shortcuts for accessing often-
used applications

CorelDRAW 11
Triffin Technologies, Ph: 011-6486447
The verdict: Integrating powerful new vec-

tor image manipulation capabilities, support for user-created symbols
and macros for accessing often-used commands, this is the most
comprehensive and powerful software for vector illustrations

INPUT DEVICES

VECTOR GRAPHICS/ILLUS-

Microsoft Wireless
IntelliMouse Explorer
Microsoft Corporation
India Pvt Ltd, 
Ph: 011-26292640

The verdict: Using the tried and proven
optical sensor, this mouse takes on the
wireless advantage with a very contoured
and comfortable styling
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Norton AntiVirus 2003

One of the most trusted names in the industry, Norton’s
newest version strives to give you higher security.
Norton AntiVirus 2003 incorporates a new scanning

engine; it even scans your instant messenger for any harmful
programs that might sneak in through file transfers during chat
conversations. Norton AntiVirus 2003’s new, smoother engine
is both light on the system and fast at scanning, making it less
tedious to scan large volumes or entire hard disks. 

The software protects your computer against SMTP-based
worms, Trojans, etc. It is extremely user-friendly, with numerous
wizards for configuring and setting the various parameters essen-

tial for safety. It packs
the trademark compul-
sory scheduling agent
and auto-update feature. 

With a wide array of
features, easy interface
and the ability to track
even your instant mes -
senger, Norton AntiVirus
2003 wins top honours
for protecting your 
systems.

Laptops let you take your work home, your home to work
and your play to the road—and today’s laptops do this
better than ever. Now the name of the game is immense

functionality in terms of integrated peripherals and connectiv-
ity, with no compromise on processing power.

One for the road
The most important question to ask when buying a laptop is
what application is it going to be used for? This will help give
you the parameters to judge it by. For example, a laptop replete
with features and processing power but slightly heavy and on
the larger side, would suit users who plan to carry it between
places but the bulk of the usage would be at a desktop and in
transit. On the other hand, those who want portability over all
else, should look for the smallest, thinnest and lightest device
they can find, even at the cost of a slight loss on the processing
power and perhaps on the functionality front too.

This gives us a few characteristics that need to be evaluated
before buying a laptop. Firstly, the processor is very important
since it gives you the power to run all your applications. Go for
one that complements your applications and needs. The same
applies for the amount of RAM and the hard disk capacity.
Next, evaluate the number of connectivity options you
need. If you make
many presentations,
you need video out -
puts for displaying on
a projector, integrated
Ethernet and modem
for connectivity. In newer
laptops, you can even get
features such as 802.11b
WiFi compliance or Blue-

tooth connectivity. Also keep an eye out for integrated peripher
als such as a CD-RW drive or a DVD-ROM drive. 

If portability is your main requirement, go for the smallest and
lightest laptop you can find, though you might have to trade off
on processing power and integrated functionality. Finally, consid
er the battery life—since the device is primarily meant for the road,
search for a laptop that specifies a standby time of at least 4 hours—

anything less would require you to carry around your
charger and stay on a constant lookout for power sources
you can charge it from.

And the award goes to…
The laptop that screeched with sheer performance was

the ACi Emerald. Boasting a 2 GHz Pentium 4
processor, 128 MB DDR RAM and a 20 GB hard

disk, this laptop has the power to keep you work
ing smoothly while on the road. In terms of con
nectivity, it featured four USB ports, a FireWire
port and integrated Ethernet and modem. With
adequate power and plenty of connectivity
options, this device blurs the difference between
a desktop and a laptop.

Name

ACi
Impression

Zenith
Portable
Desktop

Comments

This laptop features a 1.5 GHz Pentium
4 Mobile processor,  256 MB of DDR
memory and even a DVD-ROM drive—
ideal for the power-hungry professional

Sporting a 1.6 GHz Pentium 4 Moble
processor and 128 MB of DDR memo
ry, this laptop is a suitable desktop
replacement and offers many routes for
configurability and peripheral support

Nominees
Contacts

Allied Computer
International (Asia)
Pvt Ltd,
Ph: 022-26366800

Zenith Computers
Ltd,
Ph: 022-28377300

LAPTOPS

ANTI-VIRUS

ACi Emerald
Allied Computer 
International (Asia) Pvt Ltd,
Ph: 022-26366800

The verdict: Built around a 2 GHz Pentium 4 mobile
processor with DDR memory, this computer is a very
viable desktop replacement, even for the most graphi-
cally intensive tasks

Norton
AntiVirus
2003

Symantec, Ph: 022-26570658
The verdict: Norton AntiVirus 2003
boasts of a new scanning engine
that is significantly lighter on the
system, newer and up-to-date virus
definitions and the ability to even
restore files damaged due to viruses 
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Microsoft Office XP

The arrival of Microsoft Office heralded a new age of sim-
plicity for tasks such as word processing and working
with spreadsheets. Even though Microsoft Office XP has

been around for a year, it is still the best office suite in terms
of functionality and features. With a range of intuitive and
task-simplifying tools, getting work done in Office XP is 
easier than ever. 

New features such as the task pane give you a dashboard view
of everything from wizards to settings and options for the vari-
ous tools. This arranges all your tools in front of you so that you
don’t have to dig deep into the menus to look for a particular
formatting setting. Small enhancements such as the Smart Paste
function let you choose whether you want to copy text along
with formatting options or if you want to discard them and use
new formatting options. Along with this, it also has multiple

paste options that
let you choose from
a variety of copied
objects, from differ-
ent formats. You can also
perform multiple selec-
tions from documents,
which helps you manage
formatting options and
editing tasks with much
greater ease. Incorporat-
ing a greater number of
features such as formatting, fonts, etc has also enhanced the
right-click menu. With excellent functionality and intuitive new
methods of accessing configuration menus, this application
incorporates features that let you get more done, faster.

Laser printers have always been the machines of choice for
applications that require large volumes of printouts with-
out sacrificing on print clarity. As a technology, it is more

expensive than any other print technology, but when it comes
to dealing with text, no other comes close to delivering the
speed and quality of a laser printer. This is why they are the de
facto standard for mass printing in the corporate environment,
where the workflow is heavy.

Look sharp
When evaluating the performance of a laser printer, two param-
eters need to be considered—the print quality and the print
speed. The resolution of the laser printer defines the clarity of the
printouts and is usually in the range of 300 to 600 dpi for most
laser printers. High-end printers boast up to 1200 dpi resolution.
While this is significantly lower than inkjet printers, it is ade -
quate for printing text and graphics with reasonable clarity.

Most laser printers have speeds ranging from 15 to 25 pages
per minute (ppm) and some others built for enterprise appli-
cations go all the way up to 40
ppm. This is the primary spec-
ification that defines the cost
of the printer. Another very
important component is the
buffer, which is the memory
that holds the print jobs before
they get printed—since laser print-
ers are meant to handle large print
volumes, they must have a signif-

icantly higher amount of buffer memory compared to inkjet and
dot matrix printers. Entry-level laser printers should feature at least
2 MB of buffer memory. Depending on specific needs, this specifi
cation can go all the way up to 64 MB. Some enterprise-class print

ers even have dedicated hard disk drives for storing
print jobs while they are being processed.

And the award goes to…
The laser printer of choice for the year
2002 is the Canon LBP1210. This desk
top printer sports a 600-dpi print engine

and has a USB as well as parallel interface.
With a 250-sheet paper tray, it packs the capaci

ty to handle most medium load print jobs. It also
has a 2 MB print buffer and delivers swift printing
speeds while printing both text as well as mono
chrome graphics.

Microsoft
Office XP
Microsoft

Corporation India Pvt Ltd, 
Ph: 011-6292640
The verdict: Still the reigning best,
Office XP integrates wizards, the
task pane and extensive tools,
offering you the greatest function
ality and features for working with
Office tasks

Name

Samsung
ML-1450

Hewlett-
Packard
Laserjet
1200se

Comments

This printer returned very good print
quality in text and graphics. It has
some interesting features such as the
ability to print documents on 6 by 6
sheet sizes for posters

This printer offers very good print
quality for monochrome documents
and fared very well even in speed tests
when printing large documents,
thanks to its 8 MB print buffer memory

Nominees
Contacts

Samsung Electronics
India Information &
Telecommunication
Ltd, 
Ph: 011-6322517

Hewlett-Packard
India Ltd,
Ph: 011- 6826000

LASER PRINTERS

OFFICE SUITES

Canon LBP1210
Canon India Ltd,
Ph: 011-680 6572
The verdict: Based upon a

600-dpi print engine and sporting both a
USB and a parallel interface, this laser print-
er boasts of commendably high print
speeds in the text as well as graphics modes
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While the basic functioning of a CRT monitor has not
changed much over the years, there have been
tremendous advancements in the way CRTs are

manufactured. Resolutions have increased, and technolo-
gies used to fabricate the picture tubes have been improved,
resulting in image quality far greater than what we were
used to even as recently as a year ago.

The big picture
CRT monitors range from the lowly 14-inch screens to the 22-
inch big screens. If most of your work is centred on word pro-
cessing, spreadsheets, the Internet and e-mail, a 15-inch monitor
will serve you adequately. However, with the fall in prices of 17-
inch monitors, it would be a wise decision to invest in a 17-inch-
er in view of the higher resolution and refresh rate it supports. This
greatly enhances the experience in the gaming and entertainment
areas. Also consider the resolution. With a 17-inch monitor, you
should be able to run your display at a resolution of 1280x1024
and a refresh rate of at least 75 Hz to reduce eyestrain.

Finally, look for a monitor that lets you adjust the colour and
resolution settings for finer picture and image quality. This would
include support for modification and tweaking of parameters
such as focus, colour correction, along with screen geometry
control such as raster size
and shape—all this will let
you tailor your monitor’s
display to suit your applica-
tions and needs.

And the award goes to…
The Sony Multiscan G520
impressed us with its top-of-

the-line specifications and features. With support for a stunning
2048x1536 resolution, this 21-inch monitor is a designer’s dream
toy. It performed brilliantly in our tests and delivered outstand
ing image quality in the colour and screen geometry tests.

In the 14- and 15-inch category, the
Viewsonic E53 performed brilliantly in
terms of colour reproduction and especial
ly in resolution support—this was the only
15-inch monitor that supported a
1280x1024 resolution.

In the 17-inch monitor category, the
Viewsonic G73f delivered brilliant per
formance. It was one of the few 17-inch
montiors to support a resolution of
1600x1200. This flat monitor delivered
good colour and geometry reproduction,
making it an ideal choice for demanding
professional applications.

66 DECEMBER 2002

Dreamweaver MX

Dreamweaver offers WYSIWYG functionality to Web site
creation. In its new MX incarnation, the familiar multi-
window, floating-palette interface is replaced by the new

MX look and feel. It takes some getting used to, but the dockable
panel groups and tabbed document windows prove far more effi-
cient. Other welcome changes include the new tabbed Insert
toolbar, integrated file browsing and the revamped context-sen-
sitive Properties panel. HTML coding has also been brought to
the fore with enhanced functionality while working directly with
code—Code Hinting suggests appropriate alternatives to your
code as you type it. Greater stress is laid on the tag-based nature
of Web authoring with the new Tag Inspector showing an

editable list of all tags
and their attributes in
the current document.

U l t r a D e v — a n
invaluable tool for
high-end Web developers
working with ASP and JSP 
to produce data-driven
Web sites. Overall,
Dreamweaver MX shines
with its ability to author
hard-hitting Web sites
with the greatest of ease. 

Name

Viewsonic
E53

Viewsonic
G73f

Comments

This high-performance 1280x1024-
capable 15-inch monitor features a
0.28 mm dot pitch and even inte
grates a USB hub in the base—excel
lent for office and home applications
where quality it a must

Sporting a 0.25 mm dot pitch, this is
one of the few 17-inch monitors that
delivered a screen resolution of
1600x1200. This was accompanied 
with brilliant imaging and geometry 
performance

Contacts

Priya Ltd,
Ph: 022-22663611

Priya Ltd,
Ph: 022-22663611

CRT MONITORS

WEB AUTHORING SOFT-

Sony Multiscan G520
(19- and 21-inch category)
Rashi Peripherals, 
Ph: 022-28260258

The verdict: This 21-inch true flat CRT monitor sports a
resolution of an astounding 2048x1536 with a stripe
pitch of 0.24 mm, resulting in truly brilliant image quality

Macromedia
Dreamweaver
MX
Wipro Infotech
Enterprise Software Group,

Ph: 080-8440011
The verdict: With a brilliant combi
nation of WYSIWYG functionality
coupled with powerful HTML edit
ing capabilities, this application is
ideally suited to authoring basic as
well as advanced database-driven
Web sites

Other Winners

14- AND 15-INCH MONITORS

17-INCH MONITORS
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Adobe LiveMotion 2.0

Adobe LiveMotion 2.0 matches and even exceeds the
capabilities of Flash. Users already familiar with the
Adobe suite of products will find the interface of

LiveMotion very comfortable to work with. It provides a com-
prehensive set of tools for editing bitmaps and ties seamlessly
with Photoshop for more advanced pixel editing. 

LiveMotion packs some very effective vector-handling tools,
by allowing basic vector shapes to be effortlessly converted into
buttons. Like Photoshop, it also allows you to place special
editable effects to your elements such as drop shadows, bevels
and embosses. A unique feature built into this application is the
ability to plot changes to object attributes over time, instead of

doing so by frames.
This makes it a snap
to change element
properties without
editing its attributes
in each frame.

Armed with a power-
ful set of tools, LiveMo-
tion provides a lucid
and effective platform
to accomplish Web
graphics and animation
with the greatest of ease.

There is something inherently futuristic about LCD dis -
plays—their sleek form factor makes them every PC own-
ers dream peripheral. While LCD-based displays boast of

lower space requirements, higher contrast and brightness levels
compared to their CRT counterparts, they still lag behind CRT
monitors when it comes to performance. The best LCD moni -
tors offer resolutions of up to 1600x1024, but this is still lower
than that of a CRT’s 2048x1536 resolution on a similar screen
size. This is attributed to the fact that the pixel size of LCD
monitors is lower than that of CRT technology. 

The flat truth
At this point in time, however, the main reasons why one would
choose an LCD monitor is not for its performance but for conven-
ience and for staying ahead of the technology curve. When look-
ing for an LCD monitor, besides the specifications of resolution
and pixel size, note its response time—this specification decides
the speed with which a pixel can be switched on and off. The lower
the response time, smoother will be the display and this will be
apparent while viewing fast-moving content on your screen such
as games and video. The area
where LCD monitors score
over CRT is the inherently
higher contrast and bright-
ness levels—these specifica-
tions should be at least 300:1
and 150 cd/m2 to ensure sharp
images even with bright ambi-
ent light. This characteristic
makes LCD monitors ideally
suited to a public display system

where their higher brightness and contrast levels allow them to be
viewed from a distance. Many LCD monitors support special fea
tures such as integrated USB ports. Finally, since LCD monitors are

inherently digital, some of them offer sup
port for special kinds of input such as a DVI
connector—this allows the monitor to be
driven by a pure digital signal, resulting in
significantly greater image clarity.

And the award goes to…
The LCD monitor that excelled in per
formance proved to be the Samsung Sync
Master 171MP. With stunning image qual
ity and a resolution support of up to
1280x1024, this TFT monitor delivered
very good results when evaluated for
colour reproduction and response time in
real world applications. 

Name

LG Flatron
295LM

Sharp 
LL-T15V1

Comments

This whopping 22-inch LCD moni
tor features a widescreen aspect,
supports a resolution of up to
1600x1024 and is ideal for view
ing DVD movies and demanding
page layout and graphics applica
tions

This 15-inch TFT monitor supports
a resolution of up to 1024x768
and delivered sharp and stable
images

Nominees
Contacts

LG Electronics,
Ph: 0120-
4560900

Sharp Business
Systems India
Ltd, Ph: 022-
2884452

Samsung SyncMaster 171MP
Samsung Electronics India
Information &
Telecommunication Ltd,

Ph: 011-6322517
The verdict: Supporting a maximum resolution of
1280x1024, this TFT monitor features an integrated TV
Tuner and at 250 cd/sq.m, it is one of the brightest
LCD monitors around

LCD MONITORS

WEB GRAPHICS

Adobe
LiveMotion 2.0
Adobe systems India Pvt Ltd, 
Ph: 914532026

The verdict: This software packs in
numerous capabilities for handling
virtually every aspect of Web anima
tion. All in all, LiveMotion provides
a lucid and effective platform for
creating dynamic content for your
Web site. 
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Mandrake Linux 8.2

An immensly easy installation and an attractive  interface
makes Mandrake Linux 8.2 an excellent Linux distribu-
tion. Its ability to install to different profiles of applica-

tion areas makes it ideal for users who don’t want to install
components of the OS they don’t really need. This means that
you can tailor your installation to a specific need such as gam-
ing, Web server, e-mail server, multimedia authoring, office
applications, etc. There are numerous wizards to help you with
everything, from installation to loading and configuring hard-

ware and installing
drivers. If you want
to switch to Linux,
Mandrake Linux 8.2 is a
brilliant place to start for
professionals who need
an OS that offers tweak-
ability, as well as for first-
time adventures into the
world of Linux.

There have been continuous advancements in desktop tech-
nologies ranging from display to storage, to processors,
stretching even to the RAM. All of these advancements are

reflections of the new, futuristic motherboards.

Across the board
For Intel processors, check if your motherboard supports either
RDRAM or DDR memory. RDRAM offers greater bandwidth,
while DDR is a good cost-effective solution and with the advent
of DDR II memory, its performance is close to that of RDRAM.
However, availability of this new memory is scarce and the full
potential of these motherboards will not be realised until they are
used with the compliant memory. The second most important
factor is the type of processor supported. While the Pentium 4
Northwood is still Intel’s most popular processor, there are oth-
ers on the anvil that will support even greater clock speeds such
as the new Pentium 4s with HyperThreading technology. Check
if the motherboard supports these new processors, especially if
you want to upgrade later. Even with AMD processors, evaluate
whether the motherboard reflects the technology sup-
ported by the new processors, especially the
Opteron. 

And the award goes to…
The AMD mother-
board that shat-
tered our records in
performance and
utility was the MSI
KT4 Ultra. With a
host of features such as
the new VIA KT400
chipset, support for
DDR/333 memory, 8x
AGP, a 200/266 MHz

bus speed support and the inclusion of Bluetooth compliance,
this motherboard provides the fastest platform for your
AMD processors and has a host of connectivity and

peripheral options.
The Intel motherboard that shone this

year was the Gigabyte GA-8ITXE, based on
the Intel D850GB
chipset. With sup-
port for PC800
RDRAM, this imple-
mentation of the
i850 family of
chipset lets the North-
wood P4 processors see
their maximum per -
formance levels.

Name

DFI AD70-
SC/SR

DFI AD73
PRO

Intel
D850MD

MSI 845E
Max2-BLR

Comments

Built around the KT266 chipset, this
motherboard features a bus speed sup
port of up to 266 MHz and support for
DDR memory

Sporting the KT266A chipset, this
motherboard also supports PC2100
DDR memory along with ATA/133 for
IDE drives

This motherboard is based on the i850
chipset and supports PC800 RDRAM
along with integrated Ethernet and
audio functionality

Built around the i845E chipset, this
motherbaord supports a bus speed of
up to 533 MHz, supports DDR memory
and also integrates Bluetooth support

Nominees
Contacts

Zeta Technologies,
Ph: 022-24102288

Zeta Technologies,
Ph: 022-24102288

Nebula Technologies
Pvt Ltd, Ph: 022-
2673 0567

Priya Ltd,
Ph: 022-22663611

MOTHERBOARDS

LINUX DISTRIBUTIONS

MSI KT4
Ultra
Priya Ltd, 
Ph: 022-22663611
The verdict: Based upon the for-

midable KT400 chipset, this motherboard
features support for DDR memory, has
six USB ports, six-channel onboard audio
and serial ATA, making it the highest per-
formance platform for AMD processors

Gigabyte
GA-8ITXE
Nebula Technologies Pvt Ltd, 
Ph: 022-2673 0567
The verdict: Built around the

i850 chipset that supports a bus speed
of 400 MHz and RDRAM support, this
motherboard proved to the be the
fastest platform for Pentium 4 processors

Mandrake
Linux 8.2
G.T. Enterprise, 
Ph: 080-6606093

The verdict: With very
comprehsive support for vir-
tually every type of application
and usage area, this Linux distribu
tion is highly configurable and is
suited well to amateurs and sea
soned users alike

For AMD CPUs

For Intel CPUs
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When MP3 players first came out, the very thought of
carrying along a part of your 500-track MP3 collec-
tion sent a surge of excitement through every audio-

phile’s spine. The primary components that these devices are
built around a signal processor to decode the MP3 tracks and
Flash memory to store the tracks. Since these ingredients
accounted for a major portion of the cost of the player, accept-
ance was not very high initially. However, with the drop in
Flash memory prices over the latter half of this year, MP3 play-
ers are coming closer to every music lover. 

Hear the right notes
MP3 players are characterised by the features they support in a
given form factor and by their price tags. Also, since they are
meant to be used while on the move—while exercising, com-
muting or walking—the effective audio quality of most MP3
players hardly differs. It is only when the audio signal is closely
scrutinised that differences begin to emerge. However, these dif-
ferences are too minute to be noticed when these devices are
used in everyday situations. Therefore, one of the most impor-
tant considerations in buying an MP3 player is the number of fea-
tures they offer in a given size. Also, look for an intuitive navi-
gation system that lets you locate and play your tracks quick-
ly and easily. The controls of the player should also be eas-
ily accessible and the
bundled software
must be easy to under-
stand and work with. 

Enhancements to
digital audio codecs
and standards keep
emerging and it is there-
fore important that your
player has robust driver
support on the company
Web site for newer digital audio formats. 

Arguably, the most important component of an MP3 player
is its storage system and capacity. Since the MP3 player is meant
for being used while on the move, it is important that you have
enough room for your songs. Most entry-level MP3 players come
with 32 MB of memory and this can store about 30 minutes of
near-CD quality audio. Therefore, it is recommended that you
choose one with at least 64 MB of memory—the more the mer-
rier. Also, if you happen to have another device with Flash mem-
ory, such as a digital camera, go for an MP3 player that supports
a similar format of memory so that you can exchange memory
between the two devices. If price is not a bar, then the best you
can opt for when it comes to storing all your songs would be an
MP3 player that features a hard disk drive in it—these are avail-
able in capacities ranging from 8 GB all the way up to 40 GB and

at their highest capacity, can store audio equivalent to about
2,000 CDs worth of music! 

If you want reasonable storage capacity but are on a budget,
CD-MP3 players are your best bet. With the ability to play back
about 120 songs on a single CD, they are a good solution when
compared to solid state and hard disk based MP3 players. Best of
all, this genre of MP3 players are the most inexpensive.

When on the road, another very important factor with a
portable device is power—you have to have enough of

it to run through your journey. Look out 
for an MP3 player that has a longer play
time and one that uses an easily available
battery format such as the AA or AAA 

batteries. 
There should also be an adequate number of

modes for your tracks such as looping, shuffling
and programmed play. Look out for players that
offer special support for digital audio processing
on the player itself—an MP3 player that supports
a graphic equaliser or specialised bass and treble
controls with preset audio profiles is always 
preferred. 

Finally, since you might have to carry the MP3
player around with you, make sure that it is com

fortable to hold and navigate through. CD and hard disk based
MP3 players are larger in size and also involve moveable parts
that could be prone to damage due to rough treatment or phys
ical shock. Therefore, if you are going to tag your MP3 player
along for your workout or morning jog, it would be adviseable
to opt for a solid state MP3 player as it will be significantly more
robust compared to other kinds.

And the award goes to…
The MP3 player that wins this year is the Creative PA-20, on
account of its great audio performance, a small size and features.
Built around a very small form factor, this MP3 player boasts of
superior audio quality and the ability to support MP3 and SMA
formats, in addition to the range of audio control capabilities
such as shuffle and programmed playback. 

Name

Creative
DAP-
CD0001

Napa
DAV316

Comments

Capable of reading CDs, CD-Rs and
CD-RWs, this MP3 Audio CD player
supports ID3 tags and boasts of plen
ty of song control features

Capable of reading CDs, CD-Rs and
CD-RWs, this MP3 Audio CD player
features NiMH batteries and also has
ID3 tag support

Nominees
Contacts

Compuage
Infocom Ltd
Ph: 022-
23842200

Moon Computers
Ph: 022-
22653390

MP3 PLAYERS

Creative PA-20
Compuage Infocom Ltd,
Ph: 022-23842200
The verdict: This little player

packs plenty of performance into a very small package.
With 32 MB of memory and support for formats such
as MP3 and WMA, this MP3 player is the ideal com-
panion during those morning jogs
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3ds max 5

The 3D rendering application that scaled new levels of utili-
ty and enhancement, 3ds max 5 is a bubbling cauldron of
functionalities, ranging from the interface, modelling, ren-

dering, animation and special effects features. In the interface, the
menus have been re-ordered such that similar tasks are grouped in
more logical and intuitive task groups for easier access. Tools such
as the Dope Sheet make it easier to change animation characteris-
tics, without worrying about the animation curve, while the
Bones tool greatly simplifies skeletal animation. When used in
conjunction with the IK Spline solver, the connected elements in
complex models move much more realistically and far greater
control has been affected over them. In tasks such as realistic lip-
synching, the Progressive Modifier gives animators control over
the morphing stages in steps, providing a much smoother and

realistic effect. Once
a separate package,
Reactor is now bun-
dled with 3ds max 5
and allows you to add
dynamic properties to
objects such as water
droplets, explosions,
smoke, etc. The Toon
Shader function provides
far smoother control
over the colours and textures in cartoon animation.

With a plethora of added functionality and a far greater con
trol over complex tasks, 3ds max 5 provides an unbeatable pack
age for 3D animators and modellers.

The processor landscape changes more frequently than the
seasons. Every few months, the megahertz war reaches a
culmination and begets a new breed of processors to be

born of AMD and Intel. With each family of processors, these
chips feature lower power consumption and heat dissipation for
greater reliability and lower operating costs. Also, as processors
advance at a frantic pace, other system components sprint to
keep up with them, resulting in a healthy situation where you
have faster overall systems. 

The power trip
When choosing a processor, the most important factor is its appli-
cation. Once you’ve defined your application area, look at suit-
able specifications such as the processor speed, the brand and
other  factors such as the L1 and L2 cache, fabrication process, etc. 

If your needs centre on non-intensive tasks such as word pro-
cessing, surfing and e-mail, then your processing requirements
will be satisfied by a 1 GHz-class processor. However, if you like
to live on the cutting-edge with 3D games and 3D rendering and
multimedia authoring software, then you will need a proocessor
with enough horse power to efficiently run these applications. 

The cache on the processor is crucial in applications such as
image-editing and gaming,
where there are repetitive
routines and frequent access
of data sets. 

Newer processors have
moved to the 0.13 micron
fabrication process. When con-
sidering such a processor,

ensure it is supported by the motherboard as well. Also, in an
Intel Pentium 4 or an Athlon XP, it is important to choose other
supporting components such that they complement the proces
sor and do not slow it down. Therefore, if you are looking for
pure performance in, say, a 2.8 GHz Pentium 4 processor, cou
ple it with an RDRAM-based system and a fast hard disk drive.
Similarly, pair up an Athlon XP processor with the fastest DDR

RAM you can afford, along with a complementing moth
erboard.

And the award goes to…
The processor that wins kudos for being
the fastest one as per our lab tests this
year turned is the AMD Athlon 2600+.
With the 0.13 micron technology, six

integer and floating point units, this proces
sor is ideally suited to applications that
involve streaming data such as audio and
video encoding. 

AMD Athlon 2600+
AMD Far East Ltd,
Ph: 011-6238620
The verdict: Armed with six processing

units and a high clock speed, this processor turned out
to be the best overall performer across applications

Name

Intel
Pentium 4
2.8 GHz

Intel
Pentium
2.53 GHz

Comments

Reaching still higher with faster clock
speeds and with support for a 533
MHz bus, this processor is highly suit
ed to processor-intensive applications

Based on a 0.13 micron core, this
processor delivers brilliant performance
without drawing on too much of
power

Nominees
Contacts

Nebula
Technologies Pvt
Ltd, 
Ph: 022-2673 0567

Nebula
Technologies Pvt
Ltd,
Ph: 022-2673 0567

PROCESSORS

3D AUTHORING TOOLS

3ds max 5
Discreet,
Ph: 022-
26952000

The verdict: With an array of new
features such as advanced animation
controls, environment effects and an
improved menu layout, 3ds max 5
bags top honours for 3D animation
applications
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ABBY FineReader 6.0 CE

In the OCR software segment, ABBY FineReader 6.0 CE
logged 96 per cent accuracy in identifying words. This
application is a brilliant solution for getting all those hard-

copies and newspaper clippings into editable document for -
mat. The factor that set it apart from others was that it man-
aged to retain even the formatting in the document—even
newspaper and magazine pages were correctly reproduced. The

application created
an editable docu -
ment that retained the
columns, images, for-
matting and even the
fonts in the original
document with unpar-
alleled accuracy.

In today’s age of free Web sites and Web-based image hosting
services, it would be great to port all your memories to a last-
ing digital format to be viewed by your relatives around the

world. Scanners enable this and with increasing resolutions,
vivid colours, smaller form factors and low prices, it is easier
than ever to embark on your digital imaging journey.

Get the picture
Since scanners are used to convert photographs and printed
documents into digital format, their performance is largely
dependant upon the resolution, the colour depth and the speed
offered. The primary factors that affect the quality of the scan-
ner are the resolution along with the colour depth supported.
For most entry-level scanners, a 600x1200 dpi resolution is a
good start as it can scan with a maximum optical resolution of
600 dpi.

The most crucial scanner specification is the optical resolu-
tion—this is the true resolution with which the scanner oper -
ates. Second comes the interpolated or software resolution—this
is the resolution at which the scanner increases its resolution
and creates the in-between scan points by ‘guessing’ their value
using algorithms in software. Therefore, the interpolated resolu-
tion will not necessarily have the same clarity as an optical scan.
The scanning resolution decides the size of your scanned image
as well as the size it is converted to as a graphic file. 

The other important parameter that decides the image qual-
ity is the colour depth. As a rule of thumb, the higher the colour
depth, the greater is the scanner’s ability to reproduce true-to-
life colours. Go for a scanner
with a colour depth of at least
48 bits. During the scanning
process, information is general-
ly lost and therefore, if the scan-
ner can sense a greater number
of colours, the greater is its ability
to capture the original colour.

Another important parameter

of a scanner is its scanning speed. This is decided by two fac
tors—the motor used to advance the scanning element and the
interface of the scanner to the computer. Some brands have
inherently better implementations of the scanning assembly,
allowing them to scan faster without sacrificing on quality.
Therefore, before purchasing a scanner, take a couple of 
scans using different modes such as photo quality, text, 
monochrome, etc. 

Finally, the other factor that affects the scanning speed is the
interface—choose a scanner with a USB interface as this features
much higher speeds compared to parallel port scanners. 

And the award goes to…
The scanner that delivered outstanding imag

ing quality was the HP Scanjet 5470C.
With its support for true 2400x2400-

dpi resolutions and a 48-bit colour
depth, this scanner showed excel
lent results in colour and clarity. For

added functionality, it has 11 buttons
that can invoke a range of tasks, letting
you use the scanner as a copier if you
have a printer connected, along with 
a range of other cross-application 
shortcut keys.

Name

Microtek
ScanMaker
X12USL

HP ScanJet
5400

Comments

Built around a 1200x2400, 48-bit
scanning engine, this Legal-size flatbed
scanner is ideally suited to applications
where large documents need to be
scanned at the highest quality

Featuring a 2400x2400 resolution with
48-bit colour support, this scanner
exhibited very good performance char
acteristics in photo and text scanning

Nominees
Contacts

Rashi Peripherals,
Ph: 022-28260258

Hewlett-Packard
India Ltd, 
Ph: 080-5216121

SCANNERS

OCR SOFTWARE

HP Scanjet 5470C
Hewlett-Packard India Ltd,
Ph: 080- 5216121
The verdict: With its robust

2400x2400 scanning resolution, coupled with a 48-bit
colour depth and a host of intuitive controls, this scan-
ner delivered stellar performance

ABBY FineReader 
6.0 CE
Net Spider, Ph: 022-28633514
The verdict: This OCR soft

ware offers unmatched capabilites
in recognising documents. It is 
also able to retain formatting 
faithfully, and is your best bet 
for digitising your printed docu
ments
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Sound Forge 6.0

With digital audio, very few tools come close to the capa-
bility and power of Sound Forge. This robust audio
editing software incorporates a vast range of tools to

let you perform basic audio editing on digital audio such as copy-
ing, pasting, and lengthening and shortening audio files. In addi-
tion, it offers full 32-bit file support, with sample rates from 2
KHz to 192 KHz, giving very high-quality audio. The zoom ratio
for working with audio has also been increased to 24:1 to let you
edit the waveform on even a sample level. The new multitasking
environment allows the application to render in the background
while you are editing other files in the foreground, saving 

precious bits of your
time. There is also a
set of 35 preset effects
such as flanging, cho-
rus, reverb, etc, that
help to add a dimension
of depth to your audio
tracks.

With professional-
quality audio editing fea-
tures and a host of controls and effect capabilities, Sound Forge
6.0 is your ticket to mastering audio at the home or in a studio.

Until recently, system integrators and branded comput-
ers alike, did not pay much attention to the audio sub-
system. As long as one could attach stereo speakers to

the computer, that was all the audio needed. However, things
have changed—with the integration of advanced audio pro -
cessing in most motherboards, entry-level users can enjoy
multi-channel sound, with some budget cards even boasting
Dolby Digital compliance. This is corroborated by the fact that
most entertainment applications such as games and movies
are now authored using more than two channels of audio.
Due to this convergence, most sound systems today are inte -
grated directly into the motherboard in the form of a codec.
The main processor handles the audio processing and in some
cases, discrete audio processors are built into the mother-
board. While this has been consolidated by a number of
soundcard manufacturers, some prefer to go with dedicated
external soundcards.

Are you listening?
Numerous factors affect the performance of a soundcard, such as
the frequency response, S/N (signal-to-noise) ratio and the MIDI
implementation. Good soundcards have a frequency response of
20 Hz to 20 KHz with an S/N ration of 80 dB. The wider the fre-
quency response and the greater
the S/N ratio, the better the sound-
card. Another important charac-
teristic is the extent to which the
soundcard depends upon the main
processor while in operation. Ide-
ally, a soundcard should be able to
handle all audio requirements inde-
pendently. However, in reality, the
soundcard uses some part of the main

CPU’s power while in operation. Go for a card where the CPU util
isation is not more than 5 per cent. Though the difference isn’t too
significant with newer processors, it could be noticeable if you put
the soundcard into an older machine.

The features that a soundcard supports are just as important—
choose a soundcard that supports at least four channels of sound
and a standard such as EAX or A3D, as these standards are used
in many of today’s games. 

Finally, make sure the soundcard can drive your specific
speakers—some high-end speakers have a provision for digital

input and your soundcard should
have a similar output for the highest
level of audio quality. 

And the award goes to…
The soundcard that shattered all

records in performance and clarity was
the Creative Audigy Platinum. Thanks to
its support for true 5.1 channel Dolby
Digital support, 24-bit audio quality and a
very low CPU utilisation, this soundcard
performed excellently in all the target
applications.

Name

Creative SB
Live! DE 5.1

Zoltrix
Nightingale
PRO 6

Comments

With brilliant performance in handling
multi-channel audio for movies and
gaming, this sound card is a great mix
for home theatre systems
Sporting 4-channel support and very
low CPU utilisation scores, this sound
card delivers plenty of performance
even at a low price

Nominees
Contacts

Compuage
Infocom Ltd,
Ph: 022-23842200

Kunhar Peripherals
Pvt Ltd,
Ph: 022-22345758

SOUND EDITING

Creative Audigy Platinum
Compuage Infocom Ltd,  
Ph: 022-23842200
The verdict: This soundcard

has 24-bit digital audio playback,
robust audio interface support and 5.1-channel
support. It hits the highs in gaming and movie 
performance

Sound Forge 6.0
Sonic Foundry, 
E-mail: customerser-
vice@sonicfoundry.com

The verdict: One of the most robust
Wave editing tools around, this
application boasts unparalleded fea
tures and functionality for creating
effects and processes with audio files

SOUNDCARDS
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Computer speakers used to be humble boxes spreading the
sound in a 50 cm radius. Now they’ve grown into mam-
moth sound blasters. It all started with the advent of

multi-channel audio support on the computer. Ever since the
quad channel and 5.1 soundcards hit the scene, manufactures cre-
ated speaker systems that were complemented these systems.
Thus was born the 4.1 and the 5.1 speaker systems we know today.

Hear the difference
PC speakers are specified by the audio characteristics of frequency
response, Total Harmonic Distortion (THD), Sound Pressure Level
(SPL) and of course, power rating. However, the specified charac-
teristics often belie the true capability of the speakers.  Thus, always
judge the speaker quality after you have heard how they sound.
Always consider the RMS rating—the PMPO rating, though larger
in value, is misleading and should not be relied upon.

In a four-channel speaker system, ensure that the power rat-
ing of each satellite and the subwoofer is at least 4 Watts and 15
Watts RMS, respectively. The higher this rating, the greater is
the power delivery of your speakers. For THD, the acceptable
levels are 0.3 per cent. The frequency
response should be between 20 Hz and

20 KHz. SPL should be 75 dB.  

Consider buying digital speaker systems—these have a
decoder that encodes multi-channel encoded sound such as
Dolby Digital. These speakers produce the highest sound qual -
ity, but you need to have a soundcard that features a digital-out
to drive them. At the upper end of the scale, speaker systems fea-
ture dedicated multi-channel amplifiers that can decode four-
channel and 5.1-channel audio signals from your games and
movies, amplify them and send them to the matched speakers.
These are ideal for a PC-based home theatre system, where you
need power and compliance with multi-channel standards.

Newer breeds of four-channel and 5.1-channel speaker 
systems have taken audio power levels to new heights with sup-
port for industrial-strength audio standards such as THX. These
speakers boast of power ratings in the realm of 300 to 500 watts
RMS—enough to bring the roof down! Such speakers are best suit-
ed to home theatres—there is virtually no difference between
watching a DVD movie in your home and in a movie theatre!

Make sure that you hear how the speakers sound with the

music you specifically listen to—carry a CD of your favourite music
to test the speakers’ quality. When testing, set the bass and treble
controls to a mid point and see how loud the speakers get before
the sound begins to distort. This will help you decide whether the

‘room-shaking’ power of the speaker is
actually present or if there’s just a tinny
cacophony!

And the award goes to…
The 4.1/5.1-channel speaker system that
delivered outstanding performance in the

categories of gaming as well as

movies was the Artis S880. This speaker system was also able to
handle high volume levels with ease and is therefore ideally
suited to users who like to play audio at blaring volumes.

Among the 2.1 speaker systems, the Sumoku Alpha 4R deliv
ered very good response in our tests, especially during DVD play
back where the response was very sharp. This was also reflected
in its superior treble response.

The speakers have a separate amplifier that contains all the
controls, so they can be placed in a convenient location without
bothering to keep them within arm’s reach. If it’s stereo sound
that you’re looking for, this one offers superior sound quality.

Name

Artis X8
5.1

Labtec
Arena 530

Artis S320

Labtec
Pulse 325

Comments

This speaker system boasts of a large
and powerful subwoofer with punchy
satellites, making it a very good com
panion for a 5.1-channel home theater
system.

This quad-channel speaker system per
foms very well, especially when repro
ducing sound effects and is ideally suit
ed to movies and really loud gaming!

Boasting of especially good perform
ance during DVD playback, this speaker
system also provided very sharp highs

Suited very well for gaming, these
speakers delivered excellent response
in reproducing sound effects and held
out impressively even at high volumes

Nominees
Contacts

Kunhar Peripherals
Pvt Ltd,
Ph: 022-22345758

Aditya Infotech Ltd
Ph: 022-26338555

Kunhar Peripherals
Pvt Ltd,
Ph: 022-22345758

Aditya Infotech
Ltd, Ph: 022-
26338555

SPEAKERS

Artis S880
(4.1/5.1-channel category)
Kunhar Peripherals Pvt Ltd,
Ph: 022-22345758

The verdict: Though diminutive in size, this quad-channel speaker
setup boasts crisp highs and defined bass, making for an excellent
speaker system for performance gaming and immersive movies

Sumoku Alpha 4R
(2.1-channel category)
Palesha Electronics Industries, Ph: 9520-6355702
The verdict: Sporting a separate amplifier unit containing

the controls, this speaker system delivered sound quality and power
that belied its size

2.1 SPEAKERS

4.1 and 5.1 SPEAKERS
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The VIA EPIA series mother-
boards are based on the

EDEN platform and are intend-
ed as low-cost, ultra low-power
and compact platforms for
mobile and compact systems
that are mainly used for surf-
ing the Net, watching movies
(DVDs), or working with office
applications.

T h e
EPIA Mini-
ITX is an all-
inclusive board
that features an embedded VIA
Cyrix C3 E-series processor
with an optional fan-less
EDEN ESP 5000 processor
(these cannot be upgraded),
support for up to 1 GB of
100/133 MHz SDRAM, AGP 2x
Trident Blade graphics con-
troller with up to 8 MB of
memory with a TV Out option,
AC ‘97 sound codec with 
S/PDIF output and a 10/100
Mbps integrated Ethernet.

There’s only one PCI slot
and one serial port, but this
shouldn’t be a problem, as its
intended users will not need
the extra expansion slots, and
new devices can make use of
the two USB ports (expand-

able to four) present.
When used with the fan-

less EDEN ESP 5000 processor,
the CPU heats up a bit during
intensive operations, so a 
fan is recommended—when
using the optional CPU with
the fan, it was always at
below-room temperature.

The motherboard system
provides you with more power
than you’ll need for running

your everyday business pro-
grams. Try to give it

something even
remotely graphical

though, and it suf-
fers—it performed poorly

in all our graphics bench-
marks. To be fair, this mother-
board is aimed at the average
budget user and not at gamers
and graphics professionals
and it’s powerful enough to
smoothly run DVDs and DivX
movies. At Rs 4,500 for the
533 MHz variant, you really
shouldn’t be asking for more.

The motherboard sup-
ports processors ranging from
533 MHz to 933 MHz, and
variants that support DDR
memory are also available.

VIA EPIA Mini-ITX motherboard
Good things come in small packages

Price: Rs 4,500
Contact: Via Technologies
E-mail: ravi@quaza.com
Web site: www.via.com

VIA EPIA Mini-ITX 
Performance
Build quality
Value for money
Features
OVERALL

B+B+

SPECIFICATIONS
Embedded 533 MHz processor,
onboard AGP 2x graphics, inte-
grated sound, 10/100 Ethernet,
mini-ITX form factor, ATX-com-
pliant power supply

test drive n
n reviews
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The Hercules 9700
P r o

graphics
card boasts
of an 8x AGP
interface and
128 MB of 310
MHz DDR RAM
with a 256-bit inter -
face. With a maximum
of 256 MB of RAM onboard,
it can reach a bandwidth of
19.2 GBps! It has a 325 MHz
core, eight rendering
pipelines, dual 400 MHz
RAMDAC for 
dual-monitor support and
DirectX 9.0 support. 

The 9700 Pro nicely
blends form and function.
It features an all-copper fan
assembly and heat sinks on
both sides of the card,
which gives it a very pow-
erful look. For the very first
time, it actually packs a
floppy-type power connec-
tor on the card, because the
AGP bus cannot satisfy this
power-hungry monster. So
unless you have a power
supply of at least 300 watts,
don’t even consider own-
ing this graphics card.

We tested the card on a
2.2 GHz Pentium 4 proces -
sor, on the 845-based MSI
Max2 BLR motherboard,

with 256
MB DDR RAM. In the

3DMark 2001 SE test, the
card achieved an impres -
sive score of 12,085. The
Unreal Tournament 2003
benchmark was also very
high—130 fps when
played at 1600x1200 in the
flyby demo, with all set-
tings at maximum level. 

If you’re looking for
the fastest video card
around, then this is the
one for you. All this good-
ness comes at a high price,
though—Rs 34,750 to 
be precise.

We test the latest and the best hardware and software products available in the market 

Hercules 3D Prophet
Performance
Build quality
Value for money
Features
OVERALL

B+B+

SPECIFICATIONS
ATi’s R300 GPU, 128 MB DDR
RAM, dual output, DVI to D-
sub connector included, The
Elder Scrolls III: Morrowind
game CDs
System Requirements:
Pentium 4/III/II/Celeron or
compatible with AGP
8x/4x/2x slot, 128 MB RAM,
300 watts power supply,
Windows XP/Me/2000

Price: Rs 34,750
Contact: MediaTech India
Phone: 022-2396696
E-mail: sales@mediatech
india.com

Hercules 3D Prophet 9700 Pro
When speed matters



This motherboard features
a DDR 333 solution based

on Intel’s latest 845PE
chipset, which supports
Intel’s HyperThreading tech-
nology. This allows software

applications to exploit the
processor’s resources to the
fullest by running threads
belonging to applications in
parallel. However, it requires
a CPU that can perform
HyperThreading, and Intel
has just launched its first
such CPU—the P4 3.06 GHz.
Also, applications need to be
written to take advantage of
this technology, so it might
be some time before its bene-
fits are actually visible.

The board was tested on a
P4 2.8 GHz, with 256 MB of
266 MHz DDR RAM along
with a 7,200-rpm hard disk,
and a GeForce4 Ti 4600 graph-
ics card on Windows XP. The
board performed well in indi-
vidual tests, though, the over-
all performance  was slightly
less than an RDRAM-based
motherboard. One area where
it showed excellent perform-
ance was in the video encod-
ing test, where it encoded a 55
MB MPEG file to the DivX for-
mat in just 58 seconds—this
means we can expect a better
performance when used with
the upcoming 333 MHz mem-
ory module. This board is
excellent for CPU-intensive

applications such as floating
point computations. In the
Business Creation and in the
Content Creation test, the
scores were well above your
average P4 motherboard. 

The board is armed
to the teeth with fea -
tures. It has six-chan-
nel sound capability
with an onboard
AC’97 5.1 sound
decoder. The mother-
board supports a
maximum of 2 GB of
DDR RAM with three
DIMM slots. A Giga-

bit Ethernet controller is also
integrated.  Another interest-
ing feature is the presence of
an onboard Promise RAID
controller with RAID 0 as
striping and RAID 1 as mir-
roring. The board comes bun-
dled with a USB 2.0 module
with diagnostic LEDs. This
helps in debugging system
problems without opening
the case. Also included are an
IEEE 1394 module, an S/PDIF
(Sony/Philips Digital Inter-
face) module, four detailed
manuals and a driver and
software CD that contains
Live Update, a BIOS updating
software for Windows and
PCAlert4, a diagnostic utility
that gives information about
various system parameters
and displays a warning when
the threshold limits are
crossed.
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MSI 845PE Max2
A feature-rich and stable performer

Price: Rs 9,000
Contact: Priya Ltd
Phone: 022-22663611
Fax: 022-22664154
E-mail: salesbom@priyagroup.com
Web site: www.priyagroup.com

MSI 845PE Max2
Performance
Build quality
Value for money
Features
OVERALL

B+B+

SPECIFICATIONS
845 PE chipset with
HyperThreading technology,
DDR 333 support, onboard AC
‘97 5.1 channel support, IEEE
1394, Gigabit Ethernet,
Promise RAID controller, 4x
AGP, 6 PCI slots, 1 CNR slot,
USB 2.0 module

1/2 p AD



The Logitech Cordless
Freedom Optical

uses radio frequencies
and doesn’t even
require you to
be in the line of
sight of the receiver.
The keyboard-mouse com-
bination is good looking
and packs a lot of features
such as 20 hotkeys for Inter -
net, multimedia and so on.
The receiver has two PS/2
connections for the keyboard
and mouse.

The keyboard has an
excellent layout—given its

comfortable tactile response
and feel, it is ideally suited to
those who need to type a lot
such as programmers and lay-
out artists who use a lot of
hotkeys. The keystrokes are

Logitech Cordless Freedom 
optical keyboard
Freedom from wires 

smooth and silent, and the
layout and shape of the key-
board makes for very com-
fortable typing.

The keyboard, when used
from 20 feet away worked
quite satisfactorily, but the
bundled mouse (Logitech
Cordless MouseMan Optical)
was not as responsive—it
missed the signals at times,
making it unsuitable for
applications such as presenta-
tions, where you would be at
a distance from the base com-
puter. The mouse is also a bit
heavy but works quite

smoothly. The Logitech
MouseWare Control Centre
lets the user porgram func-
tions for the extra button as
well as the middle button.

With great looks, plenty
of functionality and comfort,
this keyboard-mouse combi-
nation is a good deal for users
for whom price is not an issue.

SPECIFICATIONS
Radio frequency communica-
tion, 20 hotkeys, PS/2 interface,
6 feet range, package includes
keyboard, mouse and radio
receiver

Price: Rs 3,380
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Web site: www.logitech.com

Logitech Freedom
Performance
Build quality
Value for money
Features
OVERALL

B+B+

Price: 19,551 (local taxes extra)
Contact: PRO-MUSIC Inc
Phone: 91-44-8261445/
8213607
E-mail: promusic@vsnl.com
Web site: www.promusic-
online.com

ACID PRO 4.0, the latest
version of Sonic

Foundry’s music cre-
ation tool,  has a
very clean interface
that might take a
little time to get
used to, but it’s
powered to create
professional-grade
music. The new
version has a lot
more features
than its prede-
cessors, such as
Auto-save, Crash
Recovery and 5.1-channel
mixing to enable great music
creation. One particularly
new, useful feature is the abil-
ity to rip CDs, edit the music
files  and burn them. 

ACID PRO saves to a vari-
ety of formats such as WAV,
WMA, RM, AVI, and MP3. It
allows you to add effects such
as Resonant Sweeps and dra-

matic fades. It also supports
16-bit and 24-bit Audio for -

mats, as well as
importing of
WMA and
WMV files. 

The package
includes a  CD
containing more
than 400  music
loops from Sonic
Foundry’s ‘Loops
for ACID’ collec -
tion. 

ACID PRO is
most definitely rec -

ommended for professionals
and is priced as such—ama-
teurs will probably be put off
by its Rs 19,551 price tag.

SPECIFICATIONS
System requirements:
Windows 98 SE/Me/2000/XP,
300 MHz processor, 64 MB
RAM (128 MB recommended),
Windows-compatible sound-
card and DirectX 8.0

ACID PRO 4.0
Music on the rocks

If you are scouring the mar-
ket for a workgroup laser

printer that can take care of

your daily office print jobs,
then look no further than the
Canon LBP 1210. 

The front panel has a sim-
ple interface design; the back
panel features a USB and a
parallel port interface along
with the power connector. 

This printer is provided
with a 250-sheet paper tray,
which is sufficient for most
daily printing loads. There is
also a provision for manual
paper loading and the paper-
in tray can be detached.

The printer comes bun-

dled with a power cord, inter-
face cables, manuals, a driver
CD and also a quick start
guide. 

In the test, the LBP 1210
delivered good results,
printing a text and graph-
ics document in under 17
seconds. The tonal varia -

tion and greyscale
reproduction in
m o n o c h r o m e

images was smooth.
Even when taking a large

number of printouts, the
printer did not cause any
paper jams.

With a good set of fea-
tures, fast speeds and sharp
and defined prints, this
monochrome printer is the
best bet for office applications
that need a combination of
both speed and quality.

Canon LBP 1210 laser printer
In black and white

SPECIFICATIONS
600 dpi maximum resolution, 
2 MB buffer, 250-sheet paper
tray, parallel and USB interface

Price: Rs 21,192
Contact: Canon India Ltd
Phone: 011-6806572
E-mail: brijesh@canon.co.in

ACID PRO 4.0
Performance
Ease of use
Value for money
Features
OVERALL

BB

Canon LBP 1210
Performance
Build quality
Value for money
Features
OVERALL

BB

test drive n
n reviews
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Price: Rs 20,700
Contact: Adobe Systems India 
Pvt Ltd
Phone: 0120-4444711
E-mail: sandeepm@adobe.com

LiveMotion 2.0, Adobe’s lat-
est offering, is pitted

against Macromedia’s Flash
MX. It allows object-based
animation—instead of frames
as seen in Flash, there’s a
TimeLine that displays a list
of layers within which you
can make changes to the
objects and also control how
an object’s attributes will
change over time. Layer
groups appear as a collapsible
list of objects, so you can ani-
mate individual objects as
well as the complete group.
Changing the frame rate does
not involve re-doing the tim-
ing of the movie—a 10 sec -
ond animation will take 10
seconds irrespective of the
frame rate it is played at. 

Version 2.0 has a new fea-
ture called Time Scaling—by
pressing [Alt], you can resize
segments on the timeline and
the key frames within those
segments are automatically
repositioned so that the exist-
ing animation is scaled to fit
in the new time period. This
feature allows you to make
last minute changes without 
having to alter any of the 
animation. 

LiveMotion offers you a
great set of tools. The draw-
ing tools offer four shapes—
circle, ellipse, rectangle and
square, to help you draw the
basic layout of your anima-
tion. You can then play
around with the advanced
alteration tools such as opac-
ity, size or distortion to give
it any look you like. The soft-
ware includes image editing
features and integrates well
with Photoshop and Illustra -
tor, so you don’t have to
invest in a separate image
editing application. It sup-
ports BMP, JPEG, PSD, ES, AI

and TIFF formats. 
It brings along with it a

library with predefined styles,
textures, sounds and shapes.
You can store presets in the
Styles palette and apply them
later to objects in the same or
in other compositions. 

The Export panel allows
you to set global quality
options for all bitmapped
objects in the document, as
well as specific settings for
particular objects. Hence, by
reducing the quality of all
bitmapped elements in the
object, you can cut down on
the size of the animation. 

In version 2.0, the sup-
port for scripting has been
beefed up. The scripting lan-
guage is based on JavaScript.
The script editor is extremely
functional and relatively easy
to use. Plus there are a num-
ber of sample scripts to make
your task simpler. 

To sum up, Adobe has
brought LiveMotion to a
level where it can be thought
as a serious alternative to the
Flash authoring environ-
ment.

SPECIFICATIONS
System requirements: Pentium
III 600 MHz or faster processor,
Windows 98/Me/2000/XP, 64
MB RAM, 50 MB free hard disk
space, CD-ROM drive, 800x600
or greater monitor resolution

Adobe LiveMotion 2.0
Animate your world

Adobe LiveMotion 2.0
Performance
Ease of use
Value for money
Features
OVERALL

A-A-
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Afirst look, Red Hat 8.0
might fool a Red Hat user

into thinking that it’s a brand
new distribution. The graph-
ics have changed quite a bit,
and the images and characters
look clear and bold. This new
look has been dubbed by Red
Hat as ‘Blue Curve’. 

Looks aside,
version 8.0 offers several
enhanced features. For
instance, there’s a new
option to check the installa-
tion medium for problems
just before installation
begins—quite a thoughtful
addition given that less-than-
flawless installations are a
sure-shot recipe for disaster
in Linux. 

A new installation type,
called Personal Desktop, has
also been added. This is in
addition to the usual Work-
station, Server and Custom
installation types. The pack-
age selection and installation
has been given a new look
and has been grouped into
five categories: Desktop,
Applications, Servers, Devel-
opment and System. The
Desktop group contains KDE
and Gnome, the Application
group contains various edi-
tors, calculators, games and
applications. The Servers
group contains FTP, DNS,
SAMBA and other protocol
servers, while the Develop -
ment group has compilers
and several Software Develop-
ment Kits (SDKs). When you
choose the installation type,

packages pertaining to it are
selected by default.

A standard Personal Desk-
top installation consists of
369 basic packages (these are
non-deselectable compo -
nents) plus 132 additional
packages such as Gnome,
games, etc. This installation
type will need 1,558 MB of
space and takes about 20 min-
utes to install. A Complete
Personal Desktop, with all the
packages, takes 4,680 MB of
hard disk space and 50 min-
utes to install. These times
were logged on a system using
the Intel 1.7 GHz CPU, Intel
D845GBV motherboard, 256
MB DDR (266 MHz) RAM,
nVidia GeForce2 Ultra graph-
ics accelerator, a 40 GB Sea -
gate Barracuda hard disk and
a 48x LG CD drive. Since a
majority of potential Linux
users may not have such a
high system configuration,
installation times can be
expected to be significantly
longer.

The Boot Loader Configu-
rator, which sets up your sys-
tem to boot Linux or shares it
with other OSes, has upgrad-
ed features. You can now spec-
ify the boot sequence (for
example: CD-ROM first, then
floppy, then hard disk). For a
single-boot system (only
Linux), installation is quite
simple  but for a dual-boot
system  (say, Linux and Win-
dows), experience in creating
and assigning partitions is
required.

The first time Red Hat
starts, a new agent activates
itself and configures system
date, time and sound settings.
The Setup Agent also helps in
installing any other packages
from the additional CDs. 

Red Hat 8.0 also has a bet-
ter control panel—the entire
menu structure is well-organ-
ised. Repetition, an essential
element of user-friendliness,
has been achieved by making

the same configuration tools
appear again and again under
different headings.

Integration is another
user-friendly design aspect.
Red Hat integrates some
applications such as Open
Office 1.0, Mozilla Open
Source Browser and Ximian
Evolution (an e-mail client,
calendar and contact manag-
er, all in one) as part of the
installation process. It pro -
vides an alternative to Star
Office with the Open Office
package.

The most important fea -
ture for developers, the GNU
Compiler Collection (GCC),

has also been
upgraded to ver-
sion 3.2. How-
ever as a result,

the GNU C++ compiler has
some compatibility issues
over the type of object code it
produces. GCJ (GNU Compil-
er for Java) has been upgrad-
ed, as also the GDB (GNU
DeBugger). The C and C++
libraries have also been
enhanced and the overall
compiler performance has
been improved.

The bundled MP3 players
present in version 7.3,
mpg123 and XMMS, are not
included in version 8.0 due to

patenting issues, this causes a
major setback in the multi -
media performance. It also
lacks some games that were
present in the older version.

In order to see just how
Red Hat 8.0 performs under
‘stress’ tests such as hardware
changes (this has always been
a thorny issue in previous ver-
sions), we decided to change
some hardware. The Intel
motherboard used in the test
bed had an onboard GPU, so
we decided to remove the
GeForce2 card. When we
started the machine, Linux
properly detected the change
and prompted us to remove
the GeForce drivers and add
the Intel onboard graphics
adapter to the system config-
uration. The following instal-
lation was successful. The
problems started with X-Win-
dows—it wouldn’t initialise.
We then tried the XF86Con-
fig. It started in text mode and
asked for all sorts of details
such as the horizontal scan
rate and vertical refresh rate

and so on.
Even after
giving all
the details,
X - W i n -

dows wouldn’t start. This is
one area where the user-
friendliness needs to be
enhanced.

Overall, Red Hat 8.0
promises to be pretty good
but if something fails, it’s
quite difficult to amend
things.

SPECIFICATIONS
System requirements:
Pentium-class CPU or better, at
least 650 MB hard disk space,
128 MB RAM

Red Hat 8.0
Hat full of goodies

Red Hat 8.0
Performance
Ease of use
Value for money
Features
OVERALL

B-B-Price: Rs 8,750 (Professional),
Rs 2,200 (Personal) 
Contact: Red Hat India Pvt Ltd
Phone: 022-22853452
Fax: 022-22845343
E-mail: info-india@redhat.com
Web site: www.in.redhat.com

The Red Hat 8.0 features a neat and clean new interface
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Anti-virus software contin-
ually strive to reach high-

er levels of effectiveness to
keep pace with viruses that
evolve to find stealthier and
more devastating ways to
attack our data. Norton
AntiVirus 2003 is one such
software that has earned plen-
ty of respect and confidence
for protecting computer sys -
tems from virus attacks. 

Norton AntiVirus 2003
has some additional features
compared to the previous ver-
sion. It has an
expanded file repair
and deletion fea -
ture, which helps
in restoring and
repairing files
infected with
worms or Trojans
with the possibili-
ty of even saving
the original doc-
ument. Like in
the older ver -
sions, if the virus cannot
be removed from the file, Nor-
ton offers to delete the file. 

In today’s connected age,
small files can be easily trans-
ferred through instant mes -
sengers and these could con-
tain viruses—the instant mes-
senger support option safe-
guards the system from these.
Norton automatically detects
the messengers installed on
your system and enables the
protection mode by default
during installation. It scans
MSN, Yahoo! and AOL mes -
sengers for possible malicious
files—all files received through
these messengers are scanned
for viruses and then passed
forward. Users do have the
option of enabling or dis -
abling this feature.

Norton AntiVirus 2003
scans all outgoing mail for

worms and blocks infected
mail. It notifies the user of
such attachments and also
suggests an appropriate action
for the situation. 

The software allows you
to password protect the access
settings. This is helpful if sev-
eral people use your PC, as it
prevents others from access -
ing your data.

Norton AntiVirus 2003 is
easy to use and sports the
same interface as the earlier
one; but even if you haven’t

used any of the previous
versions of the
software, you
will not have to
struggle with its
interface and con-
figuration. The
icons and captions
are self-explanato-
ry and the Scan,
Live-update and
Option setting tasks
are very easy to get
to and perform from

the convenient front
interface. 

The Live-update feature is
very transparent and one of
the best implemented
amongst anti-virus packages.
If you are updating the pro -
tection updates daily, the
download size will not be
more than 80-90 Kb.

If data protection under
any circumstances is your
priority, then Norton
AntiVirus 2003 will put your
mind to ease.

Norton AntiVirus 2003
The ultimate protector

SPECIFICATIONS

System requirements: Win-
dows 98 SE/Me/2000/XP, 300
MHz processor, 128 MB RAM,
70 MB hard disk space, IE 5.0

Price: Rs 2,025
Contact: Symantec
Phone: 022-6570658
Fax: 022-6570671
Web site: www.symantec.com

Norton AntiVirus 2003
Performance
Ease of use
Value for money
Features
OVERALL

BB
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Lindows, as the name sug-
gests, tries to bridge the

gap between Windows and
Linux.

The installation is pretty
smooth. You can let Lindows
take up the whole hard disk,
or, if you’ve already installed
Windows, it can share the
partition and set up your

computer to boot to either
OS. If you have some experi -
ence in partitioning hard
disks, you can perform the
whole process manually.  

Lindows 2.0 eliminates all
applications it considers
unnecessary for a first-time
user. That would include over
50 per cent of the applications
normally found in other dis -
tributions. It might make no
difference to a new user, but
is certainly a disadvantage for
a veteran.

Like most new distribu-
tions, Lindows automatically
configures a wide variety of
hardware, including the 
network card and the net-
work connection—a definite
advantage for the new user.

After the startup, you’re
taken straight to the graphical
interface, which is very simi-
lar to Windows. With nearly
the same layout, this is noth-
ing but a Lindows version of
KDE. Exactly like Windows, in
the left hand corner is an L-
shaped icon that serves as a
start button. From here you
can access any program or

configure settings for display,
sound, etc. 

The interface is extremely
simple to use. If you’ve cho-
sen a dual-boot configuration,
Lindows automatically
mounts the partitions belong-
ing to the other OS so that it
is accessible directly from the
‘My Computer’ icon in Lin -

dows. If you’re on a LAN,
you will get an icon called

‘Network Browser’, simi-
lar to ‘Network Neigh-
bourhood’ in Windows. 

On the applications
front, Lindows is mini -
mal, but these are suffi -
cient for a non-power
user. One feature that
stands out is the Click-
N-Run. It allows you to

download an application,
install it and run it with a sin-
gle click—a definite improve-
ment over the RPM package
management software used
by other distributions. How-
ever, to use this feature, you
need to register with the Web
site for a fee of $99. 

Lindows uses WINE (Win-
dows Emulator) to run many
Windows-compatible applica-
tions such as MS Office. 

One cannot deny the
extreme simplicity of use, the
freshness of the interface, the
ease of configuring hardware
and the various settings pres-
ent in Lindows—an excellent
stepping stone for those who
want to venture into the
world of Linux.

Lindows 2.0  
Stepping stone to Linux

SPECIFICATIONS
System Requirements: Intel or
compatible CPU at 400 MHz,
128 MB RAM, 2 GB free hard
disk space, broadband Internet
connection recommended for
Click-N-Run

Price: Freeware
Web site: www.lindows.com

Lindows 2.0
Performance
Ease of use
Value for money
Features
OVERALL
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What are the specifica -
tions for a top-class

cabinet? The basic require -
ment of any cabinet
is a capable power
supply, proper ven-
tilation system and
sturdy build. 

The Perfor-
mance Plus 660
AMG from  Antec is
awesomely rugged.
The 5.25-inch drive
bay front cover is
made of plastic and
can be removed just
by pushing the two
side buttons. Below
these bays are the
3.5-inch bays. On the front
bezel, a small plastic spring-
loaded flap opens to give
access to two USB and one
FireWire connection. The
power and reset buttons are
present on the front bezel,
with two LED indicators and
two extra LEDs in case you
want to monitor the status of
any other device. The only
sore point is the reset
switch—it’s too small and a
bit hard to reach.

The cabinet comes with
330 watts power supply with
two fans—one normal
exhaust at the back of the
case, while the other is placed
right above the CPU. This
design really provides some
heavy-duty cooling and is rec-
ommended for people using
the AMD Athlon CPU. The
quality of wiring used inside
is splendid, with the mother-
board power supply connec-
tor wire wrapped in nylon net
and all the peripheral power
connectors you will ever
need. The drive bays are

designed such that the drive
has to be fitted to a clip and
then slid into the bay—nice

and easy. The hard
disk can be fitted
into the internal
3.5-inch bay cage,
which can be
removed just by
sliding a clamp.
The bay is provid-
ed with a clamp
for a fan; useful if
you use one of the
faster drives which
dissipate a lot of
heat. Just next to
the hard disk cage
is a washable filter

for ensuring clean airflow.
Finally, there is space for a
stock fan just below the hard
disk cage.

Being a mini-tower, it’s
slightly cramped, especially
near the CPU region, due to
an irritating cross metal rib
that serves as the lateral
strengthening device. Also,
the power supply needs some
sort of support, since it was
seen to tilt a bit due to its own
weight and due to the dan-
gling cables.  

Overall, we were pretty
impressed with the build qual-
ity and the smart thinking that
went into making this cabinet
user-friendly. But then all good
things come for a price—at Rs
7,650, it’s priced way too high
by Indian standards.

Antec Performance Plus 660 AMG 
Sturdy and cool

SPECIFICATIONS
Mini-tower, 17.25x8.1x18.6
inch (HxWxD), seven expan-
sion slots, three 5.25-inch bays,
five 3.5-inch bays (two of them
convertible), P4 compatible
330 W power supply, net
weight approx 10 kg, two USB
and one FireWire front connec-
tors, washable air filter

Price: Rs 7,650
Contact: Cyber Space Abacus 
Pvt Ltd
Phone: 044-4464468
Fax: 044-4915490
E-mail: shunmugavel@theitde-
pot.com
Web site: www.antec-inc.com

Antec Performance Plus 
Performance
Build quality
Value for money
Features
OVERALL

B+B+
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This wireless mouse is con-
toured so that it fits snug-

ly into your palm, making it
easy to use even over pro -
longed periods. During instal-
lation, the mouse was detect-

ed and automatically con-
figured in Windows XP.

The buttons are
easy to click and

the two
h o t k e y s

are just
u n d e r
t h e

t h u m b
for faster access to commonly
used tasks that they can be
programmed to activate. 

The mouse is good for
gaming as well as regular
office applications. The
smooth response will make
for very accurate aiming
when playing Quake sessions!
The additional buttons are
especially suited to gaming
since they can be configured
to perform special tasks. 

Overall, it’s a great com-
panion to applications where
you need accuracy in your
pointing device.

The CX4230 is fully Plug-n-
Play compatible, with USB

connectivity for downloading
photos to your computer.
During the test, the installa-

t i o n

was auto-
matic with Windows XP
detecting the device and
installing the drivers on its
own, without requiring the
driver CD. A 1.6-inch LCD
screen enables even a novice

to properly set the target area.
Indoor photographs with
flash capture all the details,
but the ones without flash are
not too clear. Outdoor photo-
graphs come out pretty clear.
The   Macro Mode option for
close-ups captures even finer
details. The colour composi-
tion is truly excellent in this
mode. However, this camera
is costly for the 2 Megapixel,
16 MB mid-range segment. 

Kodak Digital Camera CX4230 
Sharp shooter

SPECIFICATIONS
Two AA batteries, a receiver,
software CD and manual

Price: Rs 3,380
Contact: Microsoft Corporation
India Pvt Ltd
Phone: 011-6292640
E-mail: connect@microsoft.com
Web site: www.Microsoft.com

IntelliMouse Explorer
Performance
Build quality
Value for money
Features
OVERALL

B+B+

SPECIFICATIONS
16 MB internal memory,
MMC/SD slot, 2 Mega pixel
resolution, 3x optical, 2x digi-
tal zoom, 1.6-inch TFT colour
LCD screen, weight 220 gm,
JPEG/EXIF v2.2 compression

Price: Rs 19,900
Contact: Neoteric Informatique
Pvt Ltd
Phone: 022-4172600
Fax: 022-418 5294
E-mail: sales@neoteric-info.com
Web site: www.neoteric-info.com

Kodak Digital CX4230
Performance
Build quality
Value for money
Features
OVERALL

B-B-
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Microsoft Wireless IntelliMouse
Explorer
Smooth operator

Ü
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The Samsung ML-1210
offers speedy printing at

an affordable price. The print-
er supports a maxi -
mum resolution
of 600 dpi, has a
USB as well as
parallel interface
and comes with
8 MB of onboard
memory. The
paper-in tray can hold
150 sheets of paper. The
printer also supports manual
paper feed.

The build quality of the
toner flap, the paper-in and
the paper-out tray is quite
impressive. As far as perform-
ance goes, this printer took

just 26.73 seconds for the
image print test. However, it
took a slow 280 seconds to

print 50 pages of the
test word docu-

ment. It logged
some good
results in our
print quality
tests, especially

when printing
text and was able to

print even small sized text
with clarity. All in all, this
printer is a good choice if you
need a value solution.

Samsung ML-1210 laser printer 
Print baby, print

SPECIFICATIONS
600 dpi resolution, USB and
parallel interface, 8 MB
onboard memory

Price: Rs 14,500
Contact: Samsung Electronics
India Information & Telecommu-
nication Ltd
Phone: 011-6322517
E-mail: marketing@samsungin-
dia.com
Web site: www.samsungindia.com

Samsung ML-1210
Performance
Build quality
Value for money
Features
OVERALL
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DeDupe 1.0 is designed to
search and eliminate

duplicate files that clutter up
your hard drive. DeDupe
provides enough
safeguards
against los-
ing files in
the process of
e l i m i n a t i n g
duplicate files and
by default protects
the system files and
folders.

DeDupe can also carry out
an automated process of find-
ing duplicate files based on
scheduled tasks. It also checks
for duplicates in multiple
drives (removable and network

drives). However, each time
you need to look for duplicate

files or change your
preferences, you have

to save them with a
different file

name.
Though

a feature-
rich appli-

cation, it’s
expensive if you

consider similar freeware
utilities available on the Net.

DeDupe 1.0 duplicate file finder 
Copy cat

SPECIFICATIONS
System requirements:
Windows 95 or higher,
Pentium or compatible proces-
sor at 100 MHz, 32 MB RAM,
20 MB hard disk space

Price: Rs 1,419
Contact: TechnoPundits Systems
Pvt Ltd
Phone: 044-6524326/27/28
Fax: 044-6247847
E-mail: info@technopundits.com
Web site: www.technopundits.com

DeDupe 1.0 
Performance
Ease of use
Value for money
Features
OVERALL

B-B-
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It was not a particularly dark night and
the weather was especially upbeat. I
leaned over Atul’s shoulder as he

flicked open the sleek, black case and tri -
umphantly exhibited the six-stringed
beauty. It was a Fender! It took a dedicat-
ed application of my secret agent training
to muffle my excitement and broadcast it
as a nonchalant grin. “Plug it into the
amp”, said he. I plugged the beauty into
the home-made 400 W beast, which drove
my Sony speaker set, the showpiece of my
computer system. A riff, a strum and away
it went, taking the speakers with it. “Must
have been the OP-Amp, I had to compro-
mise with its specs”, the wannabe engi-
neer put in. Right. To market, to market,

to buy a set of speakers…Armed with cash
and a spring in my step (new gadget up
ahead!), off I went.

I started with a small shop that had
the knack of disappearing into its sur-
roundings when viewed at a particular
angle. The keeper was adamant that I buy
the Adcom 660 W Multi-media Speaker—
a 2.1-channel speaker set. The asking price
was a shade over Rs 600 and I was
intrigued. The set had reasonable bass out-
put, but the treble lacked the aural nuance
I was looking for. My next run-in was with
an even cheaper unit, a Mercury 440 W
that alas was only stereo. Mercury speak-
ers are affordably priced and are hot sell-
ers and I could tell that the set would be

an ideal buy for a desktop setup where
music makes a sporadic appearance. The
shop also exhibited a two-piece Philips
system, rated at 600 W and priced at Rs
699. An elder sibling from the same com-
pany packed a 1000 W punch, called itself
the Philips Fun Power Plus and was Rs
1,295 away from a purchase. None enticed
me however, not even the Rs 750 Creative
SBS15, another stereo set. These were all
good systems, with output ranging from
very decent to pretty good, but the punch
that I was looking for was missing.

So on I went, bravely venturing into
the my-wallet-feels-lighter territory. Three
sets greeted me on this side of the market.
The Aztec (rated at a cool 2000 W), the Cre-
ative Inspire 2.1 (12 W RMS subwoofer and
4.5 W RMS satellites) and the Cambridge
SW320 (12 W RMS subwoofer and 4 W
RMS satellites). Priced equally at Rs 2,500,
my vote went to the Cambridge set for its
wonderful sound reproduction (the bass,
especially) but the set lacked the multiple-
channel support and the inputs that I was
looking for. Dejected, but neither shaken
nor stirred, I pointed to the Creative 4.1
speaker set that nestled in the corner. At Rs
4,150, the set seemed like a nice compro-
mise between price and performance.

Logitech is doing great things in the
speaker segment, a vendor told me, point-
ing to the Soundman Extrusio DSR-100, an
800 W, 4.1 set that was priced Rs 12,000.
He also told me that the Z560, a 400 W,
THX certified, 4.1-channel speaker set was
expected to arrive any time soon. Patience
was never my forte and I settled for a Jet-
way Artis 5.1 unit, a Rs 12,000 set code-
named X8L/5. It has discrete inputs for all
the channels and the requisite plugs where
the Fender could find port—all in all, a per-
fect fit. Though my wallet is lighter, my
ears ring with pleasure.

n undercover

n If you are into music only, a
good 2.1 speaker set will serve
you well

n Always test the speakers you
buy on your music—take a CD or

tape with you and test the speakers
using your music
n When you buy a multi-channel speak-
er system, make sure that your sound-
card has the correct outputs
n There are some THX and Dolby Digi-
tal certified speaker sets available in the
market—look for these if you want to
set up a home theatre

Speak easy
Agent 001 goes out on a hunt for a replacement set of speakers

after blowing up his original set
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Colours. They rule our lives. We
enjoy them. But all along, on a
one-and-a-half inch by one
inch screen on a mobile hand-

set, all you could see, receive and share
were monochrome text-based messages
interspersed with the odd emoticon.
Then, there’s the 160-character limit.
While SMS has had its share of the lime-
light and was once the killer app in cellu-
lar technology, there was something
missing—SMS is fun, but it isn’t colour-

ful. You can send short messages but you
still cannot send pictures, videos,
audio clips. Creativity is still lim-
ited to sending monochrome
pixellated emoticons.
And it grossly under
utilises the band-
width offered by
t e c h n o l o g i e s
such as GPRS,
which promise
d e s k t o p - l e v e l
Internet access
speeds on your
mobile handset. 

Well, not any
longer. Multimedia
Messaging System (MMS)
is the new buzzword in mobile
communications. You have heard of
it. It promises the ability to send colour
pictures, video clips, audio clips and even-
tually, a whole lot more—a quantum step
up from the text-only SMS service and a
shift into rich multimedia content on
mobile handsets. This shift isn’t far in
coming; in fact in parts of the world,
including India, this is already happening.
From North America to Japan, telecom-
munication companies are integrating
MMS services into their network.

What it means
For MMS to be deployed, the network
operators have to upgrade their infra-
structure and devices supporting MMS
must be available.

The principal standards setting organ-
isation for MMS is Third Generation 

Partnership Project (3GPP), which is also 
collaborating with other standards bodies
such as the WAP forum to assist in certain
areas. The Global System for Mobile Com-
munication (GSM) association is active in
collecting operator requirements to
address to 3GPP to help advance these
standards.

MMS itself will emerge in two phases,
the first phase being 2.5G, right now, fol-
lowed by services on the 3G networks of
the future. In practical terms, it means

that at present, under the
2.5G standard (which includes
GPRS networks), your MMS messages
would look like an animated slideshow or
like the Flash files you see on the Internet.
With 3G, MMS would be available as
streaming video and audio and more
bandwidth-demanding downloadable
multimedia content.

MMS will allow for several elements
within the message. Immediately, we can
expect messages with rich text content,
photographs (in JPEG, PNG and GIF for -
mats), sound and animation. As with SMS
messages, users can create their own mes-

sages. At some point, additional services
are envisaged, such as receiving messages
with rich multimedia content from com-
mercial content creators. These services
may be commercial transactions, where
users would have to pay for them, much
like the Web sites that allow users to pay
for and download ringtones and logos for
their phones. 

With the newer mobile devices, peo-
ple will soon be sharing small video clips
or slideshows (complete with audio). In

short, MMS is all
about dynamic messages.
Even if the phone may lack
a proper true life colour screen,
with shades of greyscale one can
still enjoy a dynamic message. Using
this technology, you could send picture
postcards with phones that feature imag-
ing capabilities, animated greeting cards,

You aren’t satisfied simply saying it with words? How about adding some colour and pictures? 
MMS makes all this possible on your cell phone
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scribbles and doodles to other handsets
that support MMS.

The fun doesn’t stop with just mak-
ing and sharing movies, audio and pic -
ture clips. MMS is just the beginning of a
whole slew of services. In its present form,
2.5G networks let you access the Net on
a mobile device at between 20-70 Kbps
(the theoretical speed is 144 Kbps), equiv-
alent to a regular modem/phone line
access. An average MMS is 5 to 15 KB in
size. Hence, most new MMS-compliant
devices have at least 30 KB of memory to
suport them.

When 3G, the next level, finally turns
up, you could experience speeds anywhere
from 144 Kbps right up to 384 Kbps. Your
MMS messages would then take on the
form of high-quality streaming video and
audio. Services like these are already being
seen in the new 3G networks in Japan and
South Korea. 

The gear
To use and enjoy this multimedia-rich
service over a mobile device, you need an
MMS-enabled mobile device or an MMS-
enabled PDA (see box, ‘Phones that Make you
Go Mmmm!’). Though older handsets that
do not have support for MMS will not be
able to use this services, already mobile
phones are getting smarter. Phones now
offer PDA like functionality (the Sony Eric-
sson P800 comes very close to doing just

that) and yes, they are
meant for more than
punching numbers
and exchanging mes-
sages. They don’t talk
back (yet!) but the
newer phones are
more than just phones.
With Java enabled
functionality, you can
actually download and
play games, whenever
and wherever you
want and create richer
MMS messages. 

Mobile phone
manufacturers are
making newer phones
into colourful, fun
devices. There are
going to be quite a few
technological innova-
tions in the near future
as manufacturers
scramble to integrate
more into a phone.
The Sony Ericsson
T68i, for example, has
built-in support for
POP3 e-mail. The T68i
as well as the upcom-
ing Sony Ericsson P800
and the Nokia 7650 all
feature cameras.

In order to implement MMS, it needs to be
enabled on the side of the service provider
as well as the user. When you send an
MMS, it is sent through the existing cellular

connectivity standard the user is using,
which could be GPRS (which is 2.5G) or a
newer 3G standard like UMTS. On receiv-
ing the message,  the Multi Media Service

Centre (MMSC) sends the
sender a confirmation that
the message is received. The
MMSC then sends the
receiver a notification that a
new message is waiting.
Since MMS messages are
larger than SMS messages,
service providers have intro-
duced an option where the
user can choose to down-
load the message immedi-
ately or download it later. 

On downloading the
message, the receiver gets
an acknowledgement from
the MMSC that the mes-
sage is successfully down-

loaded. Once the receiver has successfully
downloaded the message, a confirmation is
sent by the MMSC to the receiver—some-
what like what happens when you down-
load a file from the Internet.

On the side of the network operator,
the user’s MMS handset (the MMS client)
talks to a central MMS server. This is the
core component that handles the technol-
ogy behind the MMS service where mes-
sages are stored and transmission proto-
cols are implemented. This server works in
tandem (and is sometimes even integrated
into) an MMS Proxy-Relay. The Proxy-
Relay is the intermediary between the user
and the MMS server. It works to grant
access to the messaging and storage serv-
ices, which could be as varied as cellular
phones, tablet PCs, PDAs, etc. It also pro -
vides access to the messaging services on
other messaging systems such as e-mail,
SMS and paging. 

Connecting People

1/4th AD

Setup of MMS Network



88

insight n
n MMS

DECEMBER 2002

Of course, your cellular network oper-
ator should offer MMS services. Compa-
nies around the world are jumping into
this. In Japan NTT DoCoMo is a leader,
having been in this business for some
time now. DoCoMo offers next-genera -
tion services such as high-speed ‘always
on’ Internet access at an astounding 384
Kbps—true 3G services. Another emerg-
ing market is South Korea, where the
DoCoMo’s Japanese success story has
inspired local carriers to implement 3G-
level services. In Europ, service providers
such as Orange and Vodaphone have just
introduced MMS services. In the US, all
the big players have introduced or are
introducing a whole range of services. 

Closer home, BPL Mobile is the first off
the block having introduced these services
in India. The full range of MMS services
available is dependent on the network
operator. Compatibility issues may exist
initially, but as the standards are finalised,
one can expect these to get resolved.

The costs
The rate structure for MMS traffic is con-
trolled by the operator, so costs are going
to vary from region to region. Within the
same region, expect the costs to be more
or less identical once all the operators
implement MMS. Internationally, cus-
tomers get charged either on a per mes-
sage basis or by the amount of data trans-
ferred in the MMS message. There are also
some tariff plans that charge a flat rate for
Internet access (this would include MMS),
over a fixed period. As a basic guide to the
cost of an MMS message, the Mobile
Stream’s MobileMMS forum at
www.mobilemms.com suggests a rate equal
to three times the rate for one SMS mes-
sage. Ultimately though, the rates will be
set by the operators themselves.

I don’t wanna be left out!
Maybe you don’t have a mobile phone or,
even more frustrating, your device does
not support MMS. So you feel left out? No

problem. Realising that the penetration of
MMS-enabled phones is going to be slow,
the standard setters have a simple strate-
gy: use e-mail to send and receive MMS
messages.

Don’t expect to do this overnight,
though. Implementation and functional-
ity depend upon the network operators.
Industry insiders such as the Mobile
Streams believe that this is going to be a
primary driver for the MMS services to
take off, so once rivalries kick in, every-
body should be offering it. Those with
SMS enabled phones should receive a
URL pointing to where the message has
been stored.

The future
Now that users will get a taste of what
multimedia messaging offers, the need for
greater support for audio and video in a
handheld device is only going to increase.
Perhaps the single most influential driver
that would facilitate true multimedia and

advanced forms of interac -
tive messaging will be a cel-
lular service network that
allows for greater band -
width. We’ve already heard
of 3G networks like NTT
DoCoMo, which offers
bandwidths of up to 384
Kbps on a mobile device.
Tomorrow’s 4G networks are
going to boast of wireless
bandwidth like most people
can only dream of. In Octo-

ber, DoCoMo announced the impossible:
under experimental conditions, with a
working prototype of a 4G mobile system,
an incredible 100 Mbps downlink and 20
Mbps uplink conditions. This, DoCoMo
claims, is the fastest data transmission
achieved to date over mobile links. DoCo-
Mo itself is looking at the key technology
being developed by 2005 and possible
commercial deployment of the 4G archi-
tecture by 2010. The possibilities that this
kind of bandwidth, coupled with the slew
of more advanced mobile devices, is going
to bring is only limited by one’s imagina-
tion. However, MMS will become popular
only when prices come down and servic-
es and devices become easily available.
Analysts predict that it would be a couple
of years before MMS reaches the same
level of acceptance and reach as SMS. But
for now, MMS holds promise and is a def-
inite step towards pictures, sound and
video on your mobile device.

SRINIVASAN RAMAKRISHNAN

Sony Ericsson P800: With a 208x320
pixel, 4,096-colour display, built-in camera

and Bluetooth connectivity, this is
one power-packed MMS

device. It features the Sym-
bian 7 OS and can down-

load Java applications.
There is an internal 12

MB and an external 16 MB
Memory Stick. It comes with view-

ers for numerous formats, including Word,
Excel and PDF documents, and you can
send and receive e-mail, surf the Net and
do just about everything a PDA can do.

Nokia 7650: The 7650 features a tiny
camera and comes with
the Symbian OS. The
screen is 176x208
pixels and the phone
has Java applications support.
This MMS-capable camera-phone
features several modes, and images can
be captured at a 640x480 resolution.

Sony Ericsson T68i: This is a curvy MMS-
enabled phone. It features Blue-
tooth and has a plug-n-play
camera. The screen is a
80x201 pixels, capable of dis-
playing 256 colours. This
phone packs in a number of
features and boasts of being

one of the first to feature MMS. It
supports POP3 e-mail and also has 80 KB
of internal memory.

Nokia 7210: The 7210 weighs in at a
mere 83 grams, features
stereo FM radio, and
comes with some rather
wild colour options and
exotic styling. It also features
a high-resolution screen, is set
as a triband world phone and is
Java enabled. 

Panasonic GD87/88: This phone boasts
of a high-resolution 65,536-colour TFT

screen, and an elegant clamshell
body design. Did we mention the
built-in camera and IrDA support

to connect to your PC? The
110,000-pixel CMOS cam-

era also has a built-in
timer to take those
priceless group pictures!

Phones that Make you Go
Mmmm!

The step up from
SMS to MMS is as
important as the
transition was from
DOS to Windows
for your PCSimon Buckingham

CEO OF MOBILE STREAMS
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Security has been reduced to an
‘all talk and no show’ buzzword
that is so typical of today’s fast
and furious world. You can keep

your virus definitions updated, config -
ure your favourite e-mail client such
that it does not automatically execute
attachments and hope that your chil -
dren do not stumble onto adult Web
sites while surfing. You can try to
avoid spam by using a number of
whitelists, blacklists and mail filtering
services. You can hide your personal
data within encrypted partitions and
folders to save it from the prying eyes
of spyware. With all these measures,
things ought to be fine and secure in
the computing world. But reality dic-
tates otherwise; security and privacy
are community-derived—you cannot
hope to be secure even if one person on
your network does not take the same
defensive measures that you do. You
cannot afford to pretend that your
server is safe when all it takes is just
one mouth to utter a vital password.
You certainly cannot pretend that your
kids are safe from the social scum that
seemingly influence a large chunk of

the content on the Internet.
The trick apparently, is to make secu-

rity ubiquitous—like the buzzword that
it is, but only practically implemented
and not verbally announced. If everyone
is secure and every computer ‘trusts’
every other machine, there is little rea-
son to be afraid of a malicious hack or
attack. Thus goes the thinking behind
some new-fangled initiatives that are
meant to bring together the seemingly
dichotomous boons of security and pri -
vacy within the same computer. We take
a close look at one such initiative,
Microsoft’s Palladium, with the intent of
offering an insight into both the work-
ings of the technology involved and the
implication that it will have on the way
we work and communicate.

Think different
Palladium is a content-protection con -
cept that has spawned from the belief
that the PC, as it currently stands, is not
architecturally equipped to protect a

user from the pitfalls and challenges
that an all-pervasive network such as
the Internet poses. A drastic change in
the PC hardware is not feasible due
largely to economic reasons. What Pal
ladium hopes to introduce is a minimal
change that will serve the dual purpose
of granting a computer user security,
even as it maintains backward compat
ibility with existing applications. 

These changes will be reflected in
the key components of the central
processor, a motherboard chip, input
devices and output components such as
the graphics processor. Palladium is not
a separate operating system; rather, it is
based on low-level changes to the Win
dows kernel itself. Secondly, it is meant
as an enforcer of security measures—
measures that will either be defined by
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Microsoft’s Palladium is all set to secure the computing world in ways unimaginable…we find out how

IMAGING: Solomon Lewis
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an end user or a content generator. Think
of Palladium as a policing system whose
actions are guided by laws set by a third
party, akin to the judiciary.

Think secure 
Palladium is meant to cultivate a comput-
ing environment, termed as ‘trusted space’,
which a user can rely on for security and
privacy. At the heart of the system lies a
secure cryptographic co-processor, that is,
a tamper-resistant embedded smart card,
which contains unique keys and a variety
of cipher implementations. It thus acts as
a unique identifier of a par-
ticular system and is the base
on which Palladium’s security
measures are implemented.
Additional changes made to
the CPU (in terms of exten-
sions, similar to 3DNow!) will
allow the central processor to
run in a special mode. Finally,
to enable secure communica-
tion over a motherboard’s
data buses, the chip too will
have to be modified.

Built upon this hardware foundation
and extending its functionality is a tiny
piece of software termed the Nexus. It rep-
resents a change in the kernel of the oper-
ating system and takes the form of an inde-
pendent micro-kernel. The Nexus is run in
an ultra-privileged mode of the CPU where
certain areas of memory are strictly
reserved for it and are restricted to other,

potentially malicious, pieces of code. This
micro-kernel dictates the rudimentary
security policies that the rest of the system
must follow. Under Palladium, a Nexus can
be changed, thus changing the security
parameters and guidelines. Under Palladi-
um, these rudimentary policies can be
changed by using a different Nexus.

The Nexus is the manager of trusted
memory and an arbitrator of access to the
cryptographic co-processor. When a Palla-
dium PC is booted for the first time, an
inventory of the system hardware is taken
and authenticated. If a part of the hard-

ware is later changed or replaced, the sys-
tem will have to be re-authenticated via a
central authority. Assuming that the sys-
tem’s hardware is recognised as legal, the
Nexus is then loaded in an encrypted state
into the restricted memory space. It will
then reside there as long as the system is
up, all the while dictating the system’s
security policies and ensuring that appli-

cations do not trespass into restricted
memory or file systems. Thanks to the
way a CPU works, it is not possible for any
software to modify the Nexus or subvert
the policies laid down by it. 

The Nexus is thus protected by the
hardware, while it protects the software
that forms the applications and data. While
the Nexus maintains a low profile, mana
gerial stance, entities known as Trusted
Agents (TA) do the legwork of interacting
with the user. A TA can either be a Palladi
um-enabled application or an add-on to an
existing program, imparting Palladium

awareness to it.
Although existing applica

tions will run on a Palladium
system, they will not be able to
use the security features with
out TAs. To better comprehend
the relation between a Nexus
and TAs, consider the analogy
of a language. If the Nexus
defines the rules of grammar for
the language, the TA uses those
rules to construct sentences as
a means of communicating

securely with other systems and users.

Think trust
The Nexus and TAs together provide trust
ed data storage, encryption services for
applications and facilities to enable hard
ware and software to authenticate them
selves and each other. Central to the
Palladium concept are ‘Spheres of trust’,
wherein a user can not only define which
program to trust but can also ask it to use
only a certain set of data. Its like trusting
your doctor with very sensitive health
information. You are unlikely, however, to
share with him the particulars of your
bank account—details that your broker is
aware of. The broker, in turn, is in the dark
about the details of your health. Thus, the
trust you lend to your physician does not
extend into your financial life, just as your
broker’s ‘sphere of trust’ does not encom
pass information on your health.

Similarly, Palladium divides user data
into separate spheres or vaults. Each
trusted application is granted access to
either a section or an entire vault. The
user thus controls what is revealed and
to whom. This policy is akin to the Zones
that can be set within Internet Explorer
and it can be used to grant you a high-
security environment while working and
a low or zero-security space while play
ing games or movies—all on the same PC
and in the same user session. 

DECEMBER 

Palladium is a new 
hardware and software
architecture that will run
applications in a memory
space that is highly 
resistant to tampering 
and interference

John Manferdelli
GENERAL MANAGER,
MICROSOFT PALLADIUM

UNIT
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Think information
Using the Nexus and the supporting hard-
ware, a Palladium system is cryptographi-
cally verifiable to the user and to other
computers or services. The system can
ascertain that other computers are trust-
worthy before engaging them in a transac-
tion involving sensitive data. This is
termed as attestation and it forms a cor -
nerstone of successful security and privacy
measures. Take the instance of a bank oper-
ation. Banking software has to be highly
trusted and moreover, it must be ensured
that the computer dealing with it does
indeed belong to you and not to some
malicious party masquerading under your
identity. You hardware should thus trust
the banking software and vice-versa. This
virtual handshake to exchange and verify
credentials is made possible by attestation.

Once attestation is done, exchange of
data takes place. It is important that data is
only accessible to applications that have
been identified as trusted. Once your per-
sonal data is transmitted to the bank, you
could so arrange the transaction that only
particular software can read your informa-
tion. Such control is made possible by a
mechanism called sealed storage.

Sealed storage is done by encryption or
decryption techniques using the crypto-

graphic co-processor. To seal a piece of data,
it is appended with the hash of the system’s
Nexus identifier (a 160-bit number). It is
then encrypted with a private key—a secret
key  unique to each system. When a sealed
data is given to a Palladium system, the co-
processor attempts to decrypt it using its
platform-specific private key. If successful,
the hashed Nexus identifier is extracted and
decrypted to determine which Nexus is per-
mitted to receive the data. If the Nexus that
currently resides on the computer is the
same as the one that was present while the
data was sealed, the data is unsealed and
read. Two things emerge from this:
1. You cannot take a sealed file and transfer
it to another machine to be unsealed there
since the platform-specific key will change
and the process will fail at the first step. Such
a measure is essential if you wish to store sen-
sitive data on a non-trusted hard disk or over
a network. Since this is an inconvenience to
most users who demand transportability of
their data, Microsoft has defined wrappers,
which are software extensions that will
implement one of three migration policies:
(a) migration is entirely prevented by default
setting, (b) migration is permitted upon
entry of a valid password, (c) migration is
allowed with the consent of a third party, for
instance, permission is required while down-
loading an MP3 file from a music company.
2. The same Nexus must be present while
sealing and unsealing the data. If you
have changed the micro-kernel after

encrypting a file, you will have to go back
to the older one to read the file.

Thus, your applications can only
decrypt sealed data if they run on the same
hardware and under an identical software
environment (as dictated by the Nexus)
under which the data was sealed. This
ensures that under a trusted Nexus, an
application can decrypt and process the
data but cannot subvert a TA’s policy. If
you’re not running under a trusted Nexus,
you could run software that undermines
the policy set by a TA, but the application
will no longer be able to decrypt the sealed
data since the Nexus has changed (see info
diagram, ‘Securing your Data‘).

Think implications
Palladium does not require user informa
tion for authentication purposes; instead, it
secures the hardware and software envi
ronment. The Nexus identifier is not
unique to a system, since it is likely that the
majority of people will use the same Nexus.
The only identifier unique to your system
will thus belong to the cryptographic co-
processor. Although Palladium discourages
the transmission of any private informa
tion, Microsoft has defined the concept of
identity servers. These are third-party serv
ices that will grant you a unique identity
credential using Palladium, and may or
may not reveal personal information.

The implications of using Palladium
are many and not all scenarios make a

Palladium is widely touted as a system
that will put an end to virus attacks and
spam. Can it hop to achieve those lofty
goals?
How does Palladium hope to stop
viruses?
Trusted code runs in memory that is
physically isolated, protected and inacces-
sible to the rest of the system, making it
inherently impervious to viruses.

Most viruses exploit the way software
applications use scripting. A virus can thus
infect a trusted application and use it mali-
ciously without infecting memory space.
You will still need antivirus software.
How does Palladium hope to stop
spam?
A Palladium enabled e-mail client will
only download mail from ‘trusted’
machines and servers, thus spammers are
automatically blocked.

Spamming is a very lucrative business.
To get around the security measure
imposed by Palladium, all a spammer had
to do is use a trusted machine to do the
dirty work.

A Nice Thought

Securing your Data
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rosy picture. To begin with, although you
could write and use your own Nexus, or
trust a non-Microsoft party to service you
one, chances are that like the Web brows-
er, most users will stick to the micro-ker-
nel that ships with a Palladium PC—a
Microsoft one. If Microsoft emerges as the
sole or the most used identity server, the
system could place the company as the
gatekeeper of identification and authen-
tication, a powerful role to say the least.
Finally, if the Nexus and TAs served by
Microsoft take a monopolistic market
share, the company could ask application
developers for royalties while granting
them use of its enabling software.

Palladium is also a good Digital Rights
Management (DRM) solution. Content
can be granted or denied to a computer
based on its identity and the level of trust
tagged to it. Consider content renting,
where a content provider can release a
movie to your PC in return for a contract
(implemented by TAs) that dictates your
application to collect Rs 50 from you
every time you view the movie. This is
understandable till the content provider
insists that you download its trusted soft-
ware at a price to watch the movie, also at

a price. The way that software and hard-
ware work together under Palladium
could ensure that while running the
movie, screen capture hardware and soft-
ware can be disabled as part of the con-
tract, dictated by the content provider and
enforced by the TAs and the Nexus. While
this may slow down piracy, it could also
mean that your TV tuner and video com-
bination card has been disabled, render-
ing one section of your system useless.

A TA, in combination with a Nexus
can also define expiry dates for data. E-
mail can be automatically and perma -
nently deleted after a period of 30 days,
doing more harm than good. While
national security might demand such a
system, market manipulation, shady
accounting or other anti-trust policies of
companies might very well go unaccount-
ed for. Finally, a security policy defined by
a TA can ascertain that only a particular
pair of application and data goes hand-in-
hand. While such a system can provide
enhanced security to a user—your e-mails,
for example, can only be read by a propri-
etary application developed in-house, thus
minimising corporate espionage and infor-
mation leaks—it can also be used as a mar-

ket-grabbing tactic. If a leading office suite
refuses to read files created by other appli
cations, what can you do?

Think about it
Thanks to product activation, Microsoft
has already prevented Office XP and Win
dows XP from working if parts of your
computer are changed or if you do not
divulge some personal information. A cen
tral security repository has been imple
mented in the form of the MS Passport and
its Wallet system—if your Wallet account is
cracked, all the sensitive information will
be visible to any malevolent user. The Pass
port system has already shown some weak
nesses. Security patches for Microsoft’s
server, OS and even its mail clients regu
larly feature in our download queues.

The cornerstone of the Palladium sys
tem is trust. It is a philosophy that is
reflected across its architecture via trusted
spaces, trusted agents and spheres of trust.
The question to ask is then, ‘Can we trust
a single monopoly to manipulate our per
sonal data and communication under the
pretext of security? Is this really security
and at what cost?’

AHMED
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Kaul, the logistics manager at the
head office of the courier compa-
ny, walks into office and boots up
his PC. It’s the end of the month

and he has a lot of work today—managers
from all regions have sent him reports
which he has to compile and pass on to
the accounts department and his boss. He
fires up his mail client, saves all the attach-
ments into neatly organised folders and
starts compiling all the data into one doc-
ument. Having worked hard at it till a
much-delayed lunch, he gives the entire
document one final glance before sending
it off. It wasn’t a slow PC, the copy-paste
operations or the two cigarette breaks that
took him five hours to make the final
report—he was busy changing the format-
ting of each document from the various
regions to one consistent look and cross-
checking the data in the Excel sheets.

Microsoft Office is by far, one of the
most common Office suites in use today.
Whether it’s for writing letters, making
project reports, managing balance sheets
or making presentations, it is used as much
at home as it is in the office. All applica-
tions in the suite highly simplify the
processes of creating, updating, managing
and, to some extent, even sharing content.
However, often we find ourselves playing

with the same tools, doing the same things
over and over again. Not only does this get
thoroughly boring, it also turns out to be
quite time-consuming. Microsoft has
included support for macros that can
automate a lot of repetitive tasks and, con-
trary to popular belief, the feature is
extremely simple to use.

Personal robots
A macro is a series of commands and
instructions grouped together, which,
when run, execute these instructions auto-
matically. They are used to perform repeti-
tive tasks in Microsoft Office. Thus, they
are actually software robots that are ‘taught’
a specific set of instructions once and these
are mimicked in the exact same manner
every time you ‘switch them on’. Struc-
turally, a macro is a block of program script,
using Visual Basic for Applications (VBA).
VBA is a modified version of the popular
programming language, Visual Basic.

You don’t need to understand a single
line of code for creating basic macros. In all
Office applications, you can literally
‘record’ a macro—the software tracks your
actions (mouse clicks and keyboard entries)
to generate the macro for you.

Macros are stored in the file you are
working with, its template, or the default

template. Macros stored just in the file are
available only while that document is
open. If the macro is stored in the template
for that file, it will be available to all doc-
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Macro Viruses
Since macros are actually executable code,
they can be malicious, just like viruses.
Viruses are also executable code and can be
executed independently, or via another
program (an infected EXE). Similarly,
macros are executed via Office documents.
A simple block of code that selects all text
on the document, deletes it, saves the file
and closes it can be the worst nightmare
for most people.

Microsoft has included a very crude
virus protection technique in Office applica-
tions. Click Tools > Options and enable
Macro Virus Protection. With this, whenever
you open a document containing macros,
the software will ask you whether you want
to enable them or not. If its a document
that is not supposed to have macros, or if
you are unsure of its source, you can dis-
able macros and thus prevent infection.
However, you should always have a good
anti-virus software running that can trap
and warn you of macro viruses.

Building software robots

Ü
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uments that are based on that template.
Macros stored in the default template (for
example, Normal.dot for Word) are always
available while the application is open,
irrespective of where and from what tem-
plate the file is created. These robots can
also be shared with other users, either by
sending them the file containing the
macros, or by saving the macros to a sepa-
rate script file.

You can use macros for virtually any
task in an application, such as formatting,
stylising, replacing text, printing, sorting,
filtering, etc. If you are comfortable with
scripting, you can even stretch the func-
tionality of the application to do tasks that
are not readily available in the software. For
example, many dotcoms and content man-
agement systems use macros to automati-
cally generate XML from Word documents.
The XML documents can be directly
uploaded to their Web site. Thus, convert-
ing existing content is just a matter of
opening a document and clicking a button.
Also, writers can continue writing in the
confortable Word environment, instead of
having to work with clunky HTML forms.

Recording macros
To begin with, we’ll use Word. Before you
start you need to decide where you want
to save the macro—in the document or in
a template. If you want to save the macro
in a template other than the default tem-
plate, a document based on that template
or the template itself must be open.

Plan the steps you want the macro to
perform. List them down if required. A
macro will perform each and every record-
ed action, exactly as it is executed, so this
is important. If you make an error while
recording a macro, the error and correc-
tions will also be recorded. If you are com-
fortable with scripting, you can edit the
macro later to remove the extra lines of
code, otherwise it is best to start over. 

If you want to use the macro in other
documents, ensure that it does not depend
on the current document’s contents. If you
record a macro to embolden and italicise
some text in the document, Word will
assume that it has to stylise whatever text
is currently selected. If you need to stylise
a particular string in several documents, it
would be better to use the Find function to
find that text, then stylise it, so that the
Find action is also recorded and only the
matching text will be formatted.

To record a macro, click Tools > Macro >
Record New Macro . Alternatively you can
click the area marked REC on the status bar.

You will be asked for a name for the macro
and where it should be stored. You can also
enter a description for the macro and assign
it to a toolbar or keyboard shortcut (see box,
‘One-click Fix ’). Click OK and
Word will record every action
henceforth. It will also show
the Stop Recording toolbar,
from where you can pause or stop record-
ing the macro. Click the Stop Recording
button once you are done. It is best to undo
all the steps you recorded in
the macro, then run the
macro to test it. Next, test the
macro with another similar
document if you intend to
use it across documents. You
are now ready to use the
macro and let it do all the
tedious, time-consuming
work for you.

To use a macro, click Tools
> Macro > Macros . From here, you can run,
delete, edit and debug macros. Editing and
debugging will require at least basic knowl-
edge of VBA. You can also copy macros
across documents and templates by click-

ing the Organizer button. If you have
assigned a toolbar button or keyboard short-
cut to the macro (see box, ‘One-click Fix’), you
can also use these to run the macro.

If you want to save a macro to an exter-
nal file, say, to distribute it to all the region-
al offices, open Tools > Macro > Visual Basic
Editor. On the left pane, you will see the
templates and documents that are open.
Double-click each item to open the code
stored in it. Locate the code you want to
save, right-click the module on the left
pane, and click File > Export . The recipient
would have to follow a similar procedure
to import the code. However, it is easier to
simply send over a document or template
containing the macros and use the Orga-
nizer to copy the required macros.

Removing unwanted text in Word
When you get Word documents from sev-
eral sources, or even when you collect infor-
mation from the Web, you may get a lot of

junk that you spend hours
cleaning. The most typical
replacements are for double
spaces, multiple paragraph
marks, manual line breaks,
acronyms, etc. Let’s create a
macro to remove these from the
document and apply some for-
matting to the text.

To list out all the steps, we
want to Find and Replace all

double spaces with single spaces (doing
this several times over will take care of
multiple spaces), then do the same for
paragraph marks and remove manual line
breaks. Next, we will replace ‘&’ with ‘and’,

When you
record a

macro with a name
that already exists,
the existing one will
be overwritten
without warning

Name your macro and choose where it should
be saved

Assigning macros to toolbar buttons or key-
board shortcuts makes it very convenient to
access them. One way to assign these
shortcuts is when creating the macro
itself—just click the relevant button. If you
click the Toolbars button, you will see the

list of macros that you can drag to any tool-
bar you want. Once you place the button
on the toolbar, click Modify Selection to
rename the button and change its image. 

If you click the Keyboard button, simply
type in the key-combination that you want
to assign to it. If the combination is current-
ly assigned to some other action, it will be
displayed. Make sure you check this before
clicking Assign—you may not want to over-
ride one of the existing keyboard shortcuts.

Another way to assign macros to tool-
bar buttons and keyboard shortcuts is to
right-click on any toolbar and click Cus-
tomize. Click the Keyboard button to
assign a keyboard shortcut, or select
Macros in the left pane and drag the rele-
vant macro to any toolbar.Assigning macros to toolbar buttons

One-click Fix
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‘%’ with ‘per cent’ and ‘, etc.’ with ‘ and so on.’. Finally, we need
to format paragraphs to include 12 point spacing after them and
format the entire document with Garamond, black, 12 pt.

Click Tools > Macro >
Record New Macro and
name it CleanupDocu-
ment (macro names can-
not have spaces). Since
we would be using the
macro with several docu-
ments, save it in the Normal template. Click Edit > Replace and
click the More button. Ensure that the search direction is set to All
and enter double spaces in the Find box and a single space in the
Replace box. Click Replace All and repeat this for paragraph marks
(you can access special characters by clicking the Special button).
Next, choose to find Manual Line Breaks and replace it with a
blank; replace the symbols and acronyms too. Use [Ctrl] + [A] to
select all text and click Format > Paragraph. Set the Spacing After to
12 pt and click OK. From the Formatting toolbar, set the font to
Garamond, font size to 12 and the colour to black. Hit the Stop
Recording button and you are done.

Printing in Excel
When printing from Excel, usually, we would want to change
the scale at which it is printed, specify headers, footers and mar-
gins, change the print quality, etc. This is true with several kinds
of documents in Word too. All you need to do is create separate
macros for your different printing needs, and run the right one
when you need to print.

Let’s create a macro in Excel that prints three copies of the
worksheet in Landscape format with gridlines, scaling the sheets
to 70 per cent. The pages should be centred horizontally and ver-
tically and must be numbered. Click Tools > Macro > Record New
Macro to begin recording. Name the macro Print3CopiesNum-
bered and click OK. In Excel, macros saved in the Personal Macro
Workbook will be available to all sheets. Click File > Page Setup
and choose Landscape for the Orientation and 70% for the scal-
ing under the Page tab. Under the Margins tab, check the boxes
to centre the worksheet horizontally and vertically. On the Head-
er/Footer tab, choose ‘Page 1 of ?’ for the footer and enable Grid-
lines on the Sheet tab. Click the Print button and set the number
of copies to 3. Hit Print and stop recording the macro. To allow
for further customisation, you may want to skip the last step and
just stop recording. Now, whenever you want to print a work-
sheet with these settings, simply run this macro.

Macros provide a very powerful and efficient way to perform
repetitive tasks, so why spend your time doing mundane, time-
consuming tasks when you can have the software do it for you? 

VEER KOTHARI

1. Text copied off the
Internet

2. The document after
running the macro

1

2
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T he hottest thing about TV today
isn’t TV anymore. With access to
virtually every type of television
programme, the challenge is in

taking charge of seeing what you want,
when you want. Enter Personal Video
Recorders (PVRs).

These devices are incredibly utilitari-
an—just plug your cable TV line into them
and you can record straight to the built-in
hard disk, then burn all of it onto optical
media through a built-in DVD-RW or CD-
RW drive. They get even better. You can
program them to avoid recording adver-
tisements. They also have timer facilities
so that if you don’t want to miss The Simp-
sons while working, you can set the clock
and the channel and the device does the
rest. You can then watch it whenever you
want. Besides, having it in a digital format
gives you the advantage of enjoying clear
digital quality video and sound, and easy
distribution through the Internet, P2P
networks and other means of sharing. 

So where’s the catch? Well, the catch
is that they cost an arm and a leg. A Toshi-

ba RD X2, with an 80 GB hard disk and
DVD burner retails for around $1,499
(approximately Rs 75,000). The Panason-
ic DMR-HS2 comes with a 40 GB hard disk
and a DVD burner and retails for $999
(approximately Rs 50,000). Devices like
the TiVo let you program the device so
that you can see any show by download-
ing listings from the Internet. Again, they
don’t come cheap.

But here’s the cool thing—you don’t
have to spend serious money to get most
of the features that commercial PVRs give
you—a little hardware and software
tucked into your PC will give you almost
all of this functionality! 

Putting together the bits and
pieces
You should have the TV tuner card and its
driver CD. There may also be additional
CDs containing software—it’s time to get
them all out. You may be prompted for
some Windows components, so get hold
of your Windows installer CD. Don’t for-
get the screwdriver.
Install the TV Tuner card and drivers:
Ground yourself of all static charges by
touching a metal object and open the casing
of the cabinet. Locate an empty PCI slot in
the motherboard and insert the TV Tuner
card into it. Apply even pressure along the
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Your PC as a VCR!
Tired of hunting for blank video cassettes every time you want to record your favourite soap while you

are away? There’s a better way if you look towards the digital realm

Hardware
n A standard PCI TV Tuner card (available
for as little as Rs 2,550 to Rs 3,700). For
this workshop we chosen the Pinnacle
PCTV Plus (Aditya Infotech Pvt Ltd, Phone:
022-26338555)
n Pentium III 500 MHz processor
n 128 MB RAM
n At least 1 GB of free hard disk space for
the replay buffer and additional 1 GB
space for saving video footage—the
more free space, the better
n A normal coaxial cable that is hooked
into your TV to provide cable and satel-
lite TV channels. The RF connector that
goes into your card is the same one that
goes into the TV set
n If your budget permits it, add a CD-RW
drive. You can archive your recorded
shows without filling up your hard drive 

Software
n PVR software—for this workshop, we
are using Cyberlink PowerVCR II 3.0
Deluxe.  
n The latest versions of your graphics
card drivers and DirectX 8.1 on your 
system 

The Shopping List

DirectX 8.1 
Cyberlink PowerVCR II
Find them on the  
Mindware CD
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whole card and lock it down with a screw.
You can now close the computer.
Connect the equipment: Before you
load the software, hook up the cables into
the card. There will be directions for this
in the card’s manuals, but here’s general-
ly what you have to do. Connect the coax-
ial cable (from the cable TV line) into the
cable/antenna socket. Also, connect the
cables from the card to your soundcard.
The external interface is easily connect-
ed—hook up the 3.5 mm jack into the
Audio Out on the TV Tuner card and on
the other end, into the Line In connector
for the soundcard.

Having done this, boot up your com-
puter. As Windows loads up, it will detect
your card and prompt you for the card
drivers. Insert the driver CD and follow
the instructions on screen.

3, 2, 1… PVR!
A PVR software may be bundled along
with the card, but it would be better to use
a dedicated third-party PVR software for
higher control and functionality. Cyber-
link PowerVCR II has an attractive inter-
face, is highly configurable and the codecs
that come bundled with it are fast and
deliver good quality video. Before instal -
lation, check for any known conflicts (see
box, ‘Tweak Me!’).
Install the software: Install the PVR
software and follow the directions on
screen. The installation program will then
locate a working directory on the drive
that has the maximum free space. You will
need a minimum of 500 MB for a 10

minute replay buffer to view 10 minutes of
real time TV. You should optimally keep at
least 1 GB for this working directory and
additional space for saving video footage.
After this, the software will run a couple of
diagnostic tests and recommend some set-
tings based on it. Since capturing video
feed is a stressful exercise on the subsys-
tem, we suggest you tweak your hardware
settings to get the best out of it (see box,
Tweak Me!).

PowerVCR comes bundled with Pow-
erDVD. This is very useful if you have a
DVD-ROM drive, as PowerDVD is one of
the best DVD playback tools available. The
install program will also give you the
option of installing the Intel Indeo codecs.
Configuring the software: Before start-
ing the software, make sure that the cable
line is plugged in firmly. Also check and see
if the audio connectors are in place.

PowerVCR is made of three primary ele-
ments—the main panel, the video display
and the PowerVCR panel. The main panel
will let you switch between PowerVCR,
PowerDVD, Recording, Editing, and
Live/Replay as well as File play modes of the
software. The Video display panel shows
the video feed as is received by the TV Tuner
card. Finally, the PowerVCR panel comes
with controls to switch between channels,
play and stop the video (buffered or on file)
and increase and decease volume levels (see
‘PowerVCR: What’s Where?’).

When you start PowerVCR for the first

Capturing, encoding and storing video
footage is quite stressful for your com-
puter. These are the tweaks that will help
you on your road to PVR bliss.
DMA: Enabling DMA (Direct Memory
Access) for hard disk drives and CD-ROM
drives results in freeing up the CPU dur-
ing read/write operations. To enable
DMA, right-click on My Computer and
choose Properties. Open the Device
Manager tab and expand the Disk drives
tree. Choose your hard drive and click on
Properties. Under Settings, check the
DMA option. Windows 98 may have a
small warning popping up. Don’t worry
about it and select close. Repeat the
same with your CD-ROM drives. Restart.
DMA should now be enabled. If DMA is
not enabled, check if your BIOS, hard
drive and CD-ROM drive support DMA. 
Drivers: Get the latest drivers for your
graphics card from the vendor’s Web
site. Most PVR software require DirectX
drivers, which you can download from
Microsoft’s Web site. Also, check with the
TV Tuner card’s manual and Web site to
see if there are any known conflicts with
your graphics card drivers, and install
patches for these. Also install the codecs
for converting raw video footage into an
appropriate format.

Tweak Me!

Live/Digital Recorder

Instant TV Replay

PowerDVD

File Player

Recording Scheduler

File Converter

Video Trimmer

iPower
Video PanelChannel surfing

DV Tape Transcoder
(DV to MPEG)

ON/OFF switch

Settings Help Indicates time recorded /
space usage on the hard disk

Playback
controls

Volume ControlPowerVCR Panel TV tuner control

The Pinnacle PCTV Plus

Inserting the TV Tuner card

PowerVCR: What’s Where?
The Main InterfaceMain Panel
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time, the system settings menu opens up
and allows you to enter the settings.

To check and see if the card is correct-
ly recognised by the software, go to the
System Settings menu and under the V/A
Devices tab you should be able to see the
TV Tuner card in the Video capture device
menu. V/A Devices sets the configuration
for all video and audio devices. Set video
source as Composite Video, and click on
Cable. Also check the audio settings.

The Channels tab lists available sta -
tions in your area and allows you to name
specific channels. Under Video Signal For-
mat Setting, select India. This would
automatically set the Video Signal Format
for India, which is PAL B. You can then
choose the Cable option and click on Auto
Scan. The application will scan across all
available input signals and list them out
in the Channel Listing table. As the auto
scan proceeds, you will be able to see the
video feed in the main viewer panel. Once
set, you can view the video, but hold on—
you haven’t set the other options yet.

Under the Video tab, you can change
the options for brightness, contrast, hue
and saturation. Now you can also set the
snapshot and TV replay options. Go to
Snapshots and set the options for where
you want the screen captures to be
stored—these can be used later to sort
through archived videos.

Under the TV Replay tab, set the
Replay Buffer Time/Disk Space options.
Remember, the minimum amount of
space required is 500 MB for 10 minutes
of replay time. Set the Replay Buffer Time
/Disk Space to the highest possible, sub-
ject to the free disk space available. You
may also want to change the Replay
Working Directory.

The Profiles tab allows you to set the
quality of encoding raw video footage
coming in through the TV Tuner card.
There are several default profiles and you
can also define your own.

You should apply a profile that best
suits the hardware you have. A rule of
thumb is to use MPEG-1 for low resolu-
tions (normal usage) and MPEG-2 for
high resolutions. For example, if you have
a machine that is not too high in pro -
cessing power and system resources, settle
for the Average profile—at MPEG 1, the
picture quality is still reasonably good.
Likewise, if you have a machine that’s
absolutely state-of-the-art, go ahead and
choose the Superior profile, at MPEG-2. If
you want to further specify the quality of
the encoding, you can do so by trying out
the other options under Advanced and
DVD Profiles. You could also set custom
values for video and audio compression,
bit rates, frame rates, frame sizes and
other parameters. Remember though, for
recording at resolutions such as 640x480
and upwards, you need to have at least a
Pentium III 700 MHz-class processor.

Although you can leave the settings
at their default values, you should con-
sider experimenting with some cus-
tomised options to take advantage of your
hardware and get better results.

Director’s cut 
Ever seen something on TV that you
wanted to see again? Like a football goal
you just can’t believe? Or maybe a catch
that you just missed seeing? Those are the
times that you wished you could replay
‘live’ TV! Your PVR can actually do that!
Switch to the Instant TV Replay mode and
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Auto Scan detects available video signals

Set the profile that best suits your hardware

V/A Devices tab shows the TV Tuner card

Television standards: Televi-
sion standards used around the world
vary. Unfortunately, video recorded in
one particular format is not normally
compatible with another format. The tel-
evision standards are:
n PAL: Based on a 50 Hz power system,
PAL (Phase Alteration Line) is the stan-
dard format for television broadcasts in
Asia and Western Europe. By reversing
the relative phase of the colour signal
components on alternate scanning lines,
it avoids the colour distortion that occa-
sionally appears in NTSC broadcasts.
n NTSC: NTSC (National Television Sys-
tems Committee) is a standard format
adopted by the FCC for television broad-
casts in the United States, Japan, Canada
and Mexico. This is commonly referred
to as Composite Video because of the
convergence of luminance and colour
into a single analog signal. 
n SECAM: SECAM (Sequential Couleur a
Memoire or Sequential Colour with
Memory) is the video format used in
France, Eastern Europe and some Middle
Eastern countries. Like PAL, SECAM is
based on a 50 Hz power system. Colour
signals are transmitted sequentially. 
MPEG: MPEG (Moving Picture Experts
Group) is a compression technology for
digital video and audio signals. It includes
the following standards: MPEG-1
(Audio/Video), MP3 or MPEG-1 Audio
Layer 3 (Audio), MPEG-2 (Audio/Video),
MPEG-4 (Interactive Multimedia System).
MPEG is responsible for multiplexing and
synchronising one video stream with a
single or multiple audio streams. MPEG-1
was designed to reproduce VHS/VCR
quality in digital format, while the MPEG-
2 concept, similar to MPEG-1, is intended
to cover a wider range of applications
with DVD quality and broadcast TV.
Composite Video Signal Format:
Generally used for less expensive types of
video devices, it produces a single video
signal. Used in VHS camcorders or VCRs.
Digital Video Format: Digital video
signals are split up into three compo-
nents: luminance, luminance minus red
and luminance minus blue. The compo-
nent video signals can create a picture
free of common distortions that result
from combining and then separating the
video signal components. This technolo-
gy is used for DVDs.

Jargon Buster
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you can pause, rewind, play in slow
motion, replay live TV feeds and also skip
those pesky commercials! All this can be
easily achieved with the keys on the Con-
trol Wheel of the PowerVCR Panel.

Of course, there is even more that the
PVR software can do—refer to the manu-
al and see the facilities offered by it. Some
of the functions include unattended video
recording (by scheduling it), DVD Play-
back, playing and editing video files and
trimming video files.

Set it and forget it
You can use the Scheduling Wizard for
recording programs when you’re away
from your computer. So there will never
be a show that you will miss!

To start the Recording Scheduler, click
Recording Scheduler on the main panel to
launch the wizard. The wizard can also be
started by clicking on the Sched-
uling Wizard icon located in
the Recording Scheduler
panel. Select Enable this
Schedule, verify and confirm
the video settings and choose
the channel from the drop
down menu. For the Record-

ing Mode, you can choose between
recording daily, a particular day of the
week or on just weekends or weekdays.
You can also set a date and choose to
record only on that date.

Editing scheduled tasks
For editing scheduled tasks,
switch to the Recording
Scheduler mode and double-
click on the task in the
Recording Scheduler panel.

To delete a task, click on Delete or press
[Delete] on your keyboard after selecting
the task in the display area.

So there it is. You have unleashed the
awesome PVR capabilities of your com-
puter with just a little software and hard-

ware tucked in. No more scrounging
around for mouldy old tapes and messing
with arcane VCR settings! So hop into a
nice, comfortable armchair with a king
size bowl of popcorn and enjoy. And
don’t forget to junk that VCR!

SRINIVASAN RAMAKRISHNAN
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Scheduling recordings in PowerVCR

MPEG files occupy a lot of space on the
hard drive. To counter this, there are
other formats such as DivX that have
higher compression. You could also
convert your MPEG files into VCD 
format (DAT files) and write them 
onto CDs. Most CD writing software
has built-in tools for this. You could 
also convert your MPEG files into DVD
files. This can be done by DVD author-
ing tools such as MyDVD and others,
when used in conjunction with a 
DVD-R drive.

Saving for the Future

1/2 page H AD

Remember to
keep your

computer on during the
period for which the
recording is scheduled!
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The Internet has become a domi-
nant means of communication
across the globe. It has enabled
highly successful services such as

e-mail and chat for direct conversation,
and newsgroups and forums for publish-
ing ideas and thoughts. People share not
only opinions over the Internet, but also
photographs, video, music and money.
The Internet has evolved into a huge
graffiti board where anyone can stick up
their creations, for feedback and com -
ments from people from all walks of life.

The Internet has also produced its
share of fads and failures. One phenome-
non that ranks high on the hype meter is
Web logs, or blogs. Being free and with-
out the burden of requiring additional
infrastructure, they may just become as
popular as forums, attracting large, like-
minded communities.

Scientifically speaking…
Essentially, at the heart of it, blogging is
just a personal online diary that you can
share with your friends and family. They
are quite like the online photo albums you
can create at various Web sites, only blogs

are meant to hold more text content than
images.

Blogs are quite similar to Web forums.
On a forum, the creator sets the mood and
topic for the discussions, and people post
their views and ideas for others to see. The
forum may be moderated to allow only
certain content to be made public, to
maintain the quality of the forum. A mod-
erator can also ban malicious users from a
forum. Think of a blog as your own per-
sonal forum, where you are the creator
and moderator. The topic of discussion is
you and your activities. You can invite sev-
eral people to view and comment on your
posts. If you wish, you can control what
they post. When you sign up with a blog-
ging site, it creates a personal space for you
that is completely under your control.

Over time, people tend to discuss spe-
cific threads on their blogs and lots of
blogs have evolved into valuable discus -
sion chains of topics as diverse as tech-
nology, sports, art and even kung fu. Peo-
ple concentrate more on the quality of the
content than on writing styles and punc-
tuation—in fact, blogs enable a lot of
ingenious essays to be published, which

otherwise may not get published until the
publishers of traditional media like them.

Personally speaking…
Blogs provide the ideal medium for shar
ing your daily activities with others. You
can jot down all the interesting events,
new things you learnt, the little foolish
things you do, the pranks you play, virtu
ally anything you want. It’s an easy way
for others to keep up with you, so the next
time you meet a friend, your conversation
can go a bit further than, “…so what’s
been up with you?”

The most important attribute of blogs
is that they are personal. In a vastly pub
lic medium such as the Internet, the idea
of personal space can be very compelling.
Not only is it quite addictive for those
who maintain these diaries, it has a simi
lar effect on visitors too. Also, personal
blogs by nature are attached with a lot of
credibility—a person tends to write the
bare truth, so a first-person view of the fall
of the Twin Towers on a blog holds much
more value than a similar write-up in the
local newspaper. Readers know that
behind the blogs are people who are not

ILLUSTRATION : Mahesh Benkar
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Blog
in!

Blogs offer a little private space in the public domain of the Internet. Are blogs just another 
fad or will they be the biggest offering since Napster?
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restrained by industry or social pressures.
Blogs can be completely personal, that

is, the writer may not allow anyone to see
what’s on it, but this is not the idea of the
Internet. One of the primary reasons why
material is published on the Net is the
unhindered wide audience it automatically
offers. However, a person can dictate what
appears on his or her blog and what does-
n’t. This increases the respect and trust a
blogger gains because unlike forums,
though the blogger allows others to post
messages on the blog, it is still his or her
personal space. No blogger would allow any
violation of this personal space even though
he or she may try hard to get together the
ideas of several people to get as open an
opinion or as real a truth as possible.

Blogging can also be used as a means
of direct communication with your peers,
building a thread of conversation and an
ever-valuable archive of intelligence.
Omar Javaid, Chief Technology Officer
and founder of the mobile-computing
consulting firm, Mobilocity, used to regu-
larly e-mail interesting URLs to colleagues
and clients. Now he just maintains a Web
log, which he updates frequently.

Window shopping
There are several free blogs on the Net.
One of the most popular is LiveJournal

(www.livejournal.com).
In fact, the site has
become so popular
that the developers
have put up restric-
tions for signing up.
If you have a friend
who’s already blog-
ging on it, he or she
can invite you to
join LiveJournal for
free, otherwise you

will have to blog at a price. LiveJournal,
like many other sites, takes blogging very
seriously and provides excellent security
features so that bloggers can freely dis-
cuss whatever they want to, without wor-
rying about intruders. LiveJournal is
open source and has been used as a base
by many Web sites to provide free 
blogging services.

At LiveJournal, you can configure
your account so that you have complete
control over the content posted in your
space. You can choose to display your
contact information, location and birth-
day with your blogs, and whether every-
one can view it or only the users listed in
your Friends list. As a measure against
spam-robots, which harvest e-mail
addresses from Web sites, LiveJournal can
display your e-mail address differently, so
that it is not recognised by such software.
Whether your space is indexed by search
engines or not can also be controlled by
you. You may even choose to hide your
Friends list from your online profile with
the site.

To ensure high quality of content on
your blog, you can enable or disable vari-
ous restrictions. You can choose to disable
message boards completely, which means
that no one can post any replies to your
posts. You can allow anyone, only users
registered with LiveJournal or only users
from your Friends list to post messages on
your blog. The service can optionally log
IP addresses of people who post messages.
This can sometimes be useful in deter-
mining whether the message was actually
posted by that person, especially with the
growing number of cable Internet con-
nections, where a lot of computers have
static IP addresses.

Being open source, LiveJournal gives
you complete access to the code. Thus,
advanced bloggers can simply understand
the LiveJournal structure and take better
control of their blogs. For example, you
can override the stylesheet your blog uses
by modifying the header information or

even help towards the development of the
service.

Another service, Blogger (www.blog
ger.com), has an impressive Web log offer
ing, ideal for those who don’t want too

LiveJournal is one of the most popular
blogging sites, offering excellent features for
amateur and seasoned bloggers

Blogging Etiquette
Blogging is a form of communication and
publishing on the Internet. It involves
several communities, from various walks
of life so it’s wise to follow a few guide
lines so that you don’t end up offending
anyone.
n Don’t use abusive language on public
blogs. Though it may be common
among your friends and peers, there
could be several others reading your
blog. An alternative is to keep your blog
completely private, allowing only friends
to read it.
n Be discrete with the pictures and don’t
use revealing ones—they might offend
even friends.
n Respect all bloggers. Be polite when
you post comments on someone else’s
blogs, be it in tune with or against what
they have posted. Blogging is no different
from conversation. Don’t say anything on
your blog that you wouldn’t say to a face.
n Healthy blogging is for the open-mind
ed. Don’t ban a user because he or she
has a differing opinion. Opinions should
be welcomed, or disabled completely.
n Don’t hesitate to ban mischief-makers
from your blog. You will be doing a great
service to your fellow-bloggers. 
n If you are referencing items from other
Web sites, provide a link to them. This
not only helps readers, but also tremen
dously increases the credibility of your
blog. Also, remember to give due credit
to the original source of content, be it
articles or quotes.

My work involves a lot
of research and I use
blogs to find relevant
and reliable informa-
tion on a particular
topic at one locationJacob Joseph

MARKETING PROFES-
SIONAL, SYNAPSE ”

Blogger is a simple, no-frills site, where you can
post your thoughts, opinions, ideas and
happenings of the day

“
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many frills. You can simply sign up with
the site and start blogging. When you cre-
ate a blog, you can specify whether the
blog is public or private. Next, you choose
whether you want to host the blog with
BlogSpot (www.blogspot.com), or FTP it to
your own server. With the former, your
blogs will be attached with advertisements,
though you can pay to remove these. Final-
ly, you choose the colour scheme for your
blog and you’re done. All you have to do
now is keep posting messages. The site puts
up fresh and noteworthy blogs right on the
homepage, so you can browse through the
ones you find interesting. 

At Blogroots
(www.blogroots.com), you
can easily create your
own blogs and other
users can reply to your
posts. Blogroots keeps a
track of news about the
Web logs. Here, you can
suggest a post by provid-
ing its URL, title and a
short description. You
will find a dense jungle
of information here, but
this site is not quite like

the traditional blogging sites. More of a
collection of blogs and a discussion board,
this service is not about personal diaries
online. This is great if you want to discuss
issues, but not if you want to share a part
of yourself with the world.

Here to stay?
Are blogs a trend that will transform the
way people use the Internet or just a fad
that will run its due course and die quiet-
ly in some corner of the massive World
Wide Web?

Today, everyone’s information needs
are quite different, dictated by differences

in environments and vocation. Then
again, there are people across countries
that have similar interests and informa
tion needs. NASA researchers, for exam
ple, need the same information that space
observatories in Australia and Russia do.
Bloggers typically read up news, journals,
discussions and blogs from various
sources. If they find value in what they
read, they may link to it from their blogs.
Thus, they are a filtering system for infor
mation, and people with similar interests
can further contribute to their research or
benefit from their postings.

On the personal front, blogs are a
much more efficient way of letting
everyone keep in touch with your life
and staying in touch with others’. It’s
also a great way to make new friends
with the same interests, experiences or
even expertise.

However, the primary advantage of
blogging could turn out to be its own
downfall—blogging is completely person
al, so bloggers must update their blogs
often enough for them to stay alive. Also,
the content on blogs determines their life.
Good bloggers tend to develop blogging
as a discipline and take great pride in the
quality of their blogs. In fact, blogging is
now giving rise to some professional blog
gers. Andrew Sullivan (www.andrewsulli
van.com) makes as much as $6,000 (approx
Rs 3,00,000) every month from just dona
tions from readers. The Poynter Institute
(www.poynter.org), a journalism school,
hired Jim Romenesko, an early blogger to
produce the MediaNews Weblog
(www.poynter.org/medianews/), as early as
1999. These and many more examples go
to show the value that people find in
blogs and bloggers. If nothing, its still a
great way to publish your mind on the
Internet.

VEER KOTHARI

At Blogroots you can post your views and
comments on articles posted on the Net under
three categories: News, Technology and
Culture

Let’s create a blog at LiveJournal, one of the
most popular blogging sites. If you want to
blog for free, find someone who already has
a blog there and ask him or her to invite
you. Your friend can create account creation
codes, which you can use to get in. Once
you enter the code, simply sign up with the
site and you can begin.

LiveJournal will send you an authorisation
e-mail, to make your blog live. You can now
edit your personal information, which helps
people identify with you or find you based
on your interests. You can also enable or dis-
able various security features for your blog on
this page. With a new blog, when you are
just building your community, you may want
to display your e-mail address and instant
messenger details with your online profile.
Also, make sure your biography and interests
are as descriptive, yet concise, as possible.
You can even upload your photograph here.
If you already have a group of friends whom
you want to share your journal with and can
do without additional people, you just need
to build up your Friends list. Now choose
who can view your contact and personal
information, who can reply to your posts
and other content security options from

here, save your changes and you are done. 
You may want to download the desktop

software for uploading messages, or do it
from the Web directly. Now you can keep
posting messages as you see fit. 

If you want to use a different style for
your journal, you can change the look and

feel as and when you like by clicking Modify
Journal. You may not want to bother with
the advanced options yet, until you’ve seen
the source code of LiveJournal from the
Developers’ section.

If you have restricted your blog only to
friends, remember to add other users from
LiveJournal to your Friends list by clicking
the Your Friends link.

Starting your First Blog

Configure how your blog is used and by whom

Writing HTML,
uploading and man-
aging archives for my
Web site was tedious.
Blogging allows me
to concentrate on
what I do best—think
and write

Mahesh Shantaram
AN INDEPENDENT
WRITER, REGULARLY
UPDATES HIS BLOG AT
www.techrose.org

“
”
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You know the problem all too well—
all those years of sourcing MP3s
from friends, the Internet and your

personal CD collection has left a mass of
music that is difficult to sort through. The
problem with MP3s is that most of them
don’t use any particular system of classi-
fication as they are created from numer-
ous sources—you probably have songs
with their names misspelled, under
wrong band or artiste names and they are
probably placed in random folders on
your hard disk.

But take heart. With tools that help
you rename, organise and even categorise
your MP3 files, there is still hope of intro-
ducing some sanity and organisation into
your 8 GB music collection. Let’s take a
look at MoodLogic, one such tool that
helps bring order to your MP3 chaos.

Getting started
MoodLogic incorporates a suite of

MP3 management tools that let you
organise, fix and playback your MP3s in
a more intuitive and orderly manner. 

You need to activate the MP3s on your
hard disk so that MoodLogic can recognise
them and process them further. Simply
select your songs from the song listing in

MoodLogic and click on the ‘Activate’ but-
ton. The trial version allows you to acti-
vate only 25 songs for free, beyond which
you have to activate additional songs by
logging credits or by paying for it. 

Configuring MoodLogic
Navigate to the My Active Music

section from the main interface to find
the 25 songs that MoodLogic has sorted
by genre, category, artiste, etc. Here you
can fix the ID3 tags and even the song
names for sorting the MP3s by clicking
on the ID3 & Files button at the bottom
of the interface. MoodLogic has a large
database of music on its Web site
(www.moodlogic.com), which you can
access to fix your MP3 track’s naming and
ID3 information.

MoodLogic can even move the
renamed songs into specific folders for
each artiste. Once you hit the Fix All but-
ton, you’ll have all your MP3 files organ-
ised, renamed and properly tagged. The
time taken to complete this process is, of
course, dependant upon the number of
MP3 files you have on your hard disk.

Let’s get rocked
The real benefits of organising your

music come through when you want to

play it—you can easily customise a playlist
to suit your mood by choosing songs from
various artistes and albums. But Mood-
Logic takes you one step further—you can
view your music based on a number of
parameters such as tempo, year of the track
and even the mood of the particular piece.
So you can choose songs by tempo such as
romantic, party, relaxing, etc. You can also
view them by genre.

Another very interesting feature is the
Instant MusicMix tool. This tool lets you
group songs that ‘sound’ like each other,
taking into account musical phrasing,

tempo, etc. Finally, with MoodLogic you can
also transfer your MP3s to a portable MP3
player and refer to and categorise your music
from other sources such as CDs or Zip disks.

Now that you finally have command
over all your MP3 files, play away!

MARCO D’SOUZA

TagMaster, MoodLogic, 
MP3db v1.40
Find them on the 
Mindware CD 

Follow the Tune!

The main interface of MoodLogic lets you
activate songs 

Fix and format ID3 information using the
ID3 & Files button

Activated and recognised music shows up in
the My Active Music screen

Generate playlists of your favourite music by
sound, tempo, genre, etc
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XP incompatible Web cam
I have a PC with a Pentium III 933

MHz CPU and 256 MB RAM running two
OSes—Windows Me and Windows XP.
Now the problem is that Windows Me
runs my Web cam (D-Link’s DU-C300) but
XP doesn’t. Whenever I try to install it
from the Scanner & Camera section in the
Control Panel, it gives a list of different
brand names but D-Link is missing. When
I try to install it from the driver disk, a
message appears saying, ‘The specified
location does not contain information
about your hardware’. What could be the
cause of the problem?
Rajesh Iyer
Secunderbad 

It looks like your driver disk does not
contain the drivers for Windows XP. 
All you have to do is download the rele -
vant drivers from http://www.dlink.co.in/
dlink/Drivers/WindowsXP/dsbc100whitecase__XP_
driver_b2.exe to get your Web cam up and
running.

Transferring Hotmail to Outlook 
I want to know how to transfer

Hotmail messages to Microsoft Outlook
(not to Outlook Express). I have tried to
configure Outlook but have not been suc-
cessful. Please help me. 
Preetinder Virk
Via e-mail

You can set up a Hotmail account
only if you have Outlook 2002. If your
version is earlier than 2002, then

chances are you won’t be able to create
a Hotmail account. To download your
Hotmail messages, go to Tools > E-mail
Accounts > Add a new account and click
Next. When asked which protocol to
use, select HTTP and click Next. Now
type your Hotmail login name for User
Name: and ensure that Hotmail is dis-
played in the top right box. Click Next
and then Finish. The next time you click
on Send/Receive, Outlook will download
the mail from your Hotmail account.

Dolby Digital from the soundcard
I have a discrete 4.1 channel speaker

system. If I buy an AC-3 5.1 channel PCI
soundcard, can I enjoy Dolby Surround
Sound while playing Audio CDs and
MP3s? Will there be much difference
between a Dolby Pro-Logic Surround
home audio system and my PC sound
system?
Sumanta
Via e-mail

There are a few things you’ll need to
do to enjoy the full benefits of your sound
system. Once you’ve bought the 5.1 chan-
nel soundcard, in Windows XP, go to the
Control Panel > Sounds and Audio Devices .
Click Advanced under Speaker Settings
and set your speaker setup to 5.1 chan-
nel. You will find extra settings in the
Control Panel, depending on your sound-
card, which will let you set up and test
your speaker system. We’re using Windows
XP as an example, since the closest options

available in
Windows 98
SE are Quadro-
phonic and
S u r r o u n d
Sound. You
will also have
to ensure that
your MP3 and
CD player sup-
port 5.1 out-
put. Check
your audio
player’s Web
site for any

available plugins. However, since you
have a 4.1 speaker system, you will miss
out on the centre channel. Fortunately,
most applications such as software DVD
players are able to send Dolby Digital
sound streams into your four-channel
speaker system.

As far as your second query is con-
cerned, Dolby Pro-Logic is far inferior to
the Dolby Digital 5.1 channel system, so
stick to the latter. 

From problems with Web cam drivers to AGP compatibility issues—find your answers here

Downloading Hotmail messages into your
Outlook Inbox

Set up your speaker system
to receive 5.1 channel
sound
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Dial-up networking
In the Quickstart section of Digit,

September 2002, you demonstrated how
to connect to another computer through
a dial-up connection. Is it possible to con-
nect to a computer in another country
too? My husband wants to connect to my
system in India and he is in the UAE. Will
the calls be charged by ISD rates? Please
let me know.
Abha
Via e-mail

The Quickstart primarily dealt with
connections established over a telephone
line and though connections can be
established across the globe, one of you
will have to call the other to establish
them, inviting international call rates. An
alternative is to set up a dedicated point-
to-point connection between your com-
puters, but the costs of such an operation
for home users is too prohibitive to even
discuss. So if you need to transfer files to
each other, the best solution is to use
instant messengers such as MSN Messen-
ger (www.msn.com ) or Yahoo! Messenger
(www.yahoo.com ). The Windows XP Mes-
senger gives you far greater control over a
remote computer and the file transfer
application is also very user-friendly.

Post removal hard disk problems 
When I connect my 20 GB hard disk to

a friend’s PC, both our computers work
fine. But after I disconnect my hard disk,
my friend’s machine shows two CD drives,
one of which does not work. The system
also slows down a lot. Please give us a
solution for this.
Taral B. Khasiya
Via e-mail

Unfortunately, you haven’t mentioned
your system configuration, so based on
your information, do the following.
Reboot the PC and enter the BIOS by press-
ing [Del] or the appropriate key for your
BIOS. In Standard CMOS Setup, set the
drive type for all the IDE drives to Auto.
Then go back to the main menu and enter
Integrated Peripherals. Change the PIO
and UDMA modes to Auto. Now save your
settings and reboot. It’s also a good idea to
examine the IDE cables to see if they’re
properly connected. The long end should
go to the motherboard, while the two con-
nections close by on the other end go to
the devices. Finally, download the latest
drivers for your motherboard’s chipset. If
you don’t know the motherboard’s manu-

facturer, you can go to www.motherboards.org
to identify the board type.

Problem with free memory 
I have a 466 MHz Celeron CPU, Intel

815 motherboard, a 40 GB hard drive,
52x CD-ROM, 320 MB RAM and onboard
graphics with 1 MB of shared memory.
When I run and then close a lot of pro-
grams, Windows’ System Monitor shows
244 MB of RAM utilised. Is this reading
harmless or do I have to do something
about it? Please help.
Raviteja
Via e-mail

Since you have 320 MB of memory, you
should not have any problems with low
resources for most applications. The rea-
son why System Monitor shows this high
reading is because it probably takes some
time to refresh its information or because
the memory used by these programs is not

completely de-allocated until some other
program requests it. Check to see that too
many programs aren’t loading themselves
during startup—ensure that your System
Tray is not too filled with running pro-
grams. To free up more RAM, remove
unnecessary programs from the Startup
program group in your Start menu. Any-
way, as long as you don’t get any ‘Low vir-
tual memory’ messages—which,
considering your RAM, is highly unlike-
ly—you have nothing to worry about.

Virus problems
I have two computers running

Windows 98, which are connected to
each other through a LAN card. The main
computer is plagued with the
Win32.Worm.datom virus and gives the
following error messages: ‘Cannot find file
MSVXD.EXE. Could not load or run
MSVXD.EXE specified in the WIN.INI file.’
Is there any software to remove this virus?

Buying a new computer 
I’m contemplating buying a new P4-

based machine, primarily for entertain-
ment purposes. But after going through
some comparisons, I have a few doubts:
1. Is it true that with a GeForce2, 3 or 4-
based AGP card, I can play the latest as
well as older games?
2. If an AGP card is marked
OpenGL/Direc-
tX compatible,
does it mean
that it has both
capabilities and
can play both
types of games?
3. What types of
CD formats are
supported by a
DVD-ROM drive? Is it
also capable of writ-
ing CDs?
4. Is it true that in order to play
games I must have the same type of RAM
for my processor and AGP card? 
Vishal Arora
Delhi

Let’s tackle your questions point by
point:
1.Yes, you will be well equipped to play
new and old games with any of these
cards, particularly the GeForce4 Ti 4600
or the ATi Radeon 9700. Please note
that any new card is backward compat-

ible, that is, it will be capable of run-
ning older games. However, the latest
card is the latest only till a new game
pushes the graphics higher. 
2. Yes, any AGP card marked thus will
support both kinds of games and the
newer the Direct3D/OpenGL version

supported, the better. The newest
cards are DirectX 9
and OpenGL 1.3
compatible.

3. The CD for -
mats supported
by DVD drives
vary according
to the manufac-
turer, but gener-
ally, they
support CD-

ROM, CD-ROM XA,
CD-R, CD-RW, Photo-
CD, Video-CD, Multi-

Session, CD TEXT and CD Extra. A
DVD-ROM drive, as its name suggests, is
only able to read DVDs and CDs. DVD
R/RW drives are able to write DVDs and
CDs, but again, the exact formats sup-
ported depend on the manufacturer
and the model. Check the specifications
of the writer before you buy one. 
4. The RAM types of your system and
your AGP display controller have
absolutely nothing to do with each
other and do not affect one another in
any way. 
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Another virus called BKDR_NEWBIERO has
infected a file in my C:\WINDOWS\SYS-
TEM\LVMGI.EXE on the other computer.
Shaikh Mohammad Wasi
Via e-mail

Viruses can be removed automatically
by most anti-virus software with updated

virus definitions such as Norton AntiVirus
and McAfee. To remove them manually,
do the following: For Win32.Worm.
datom, restart Windows in Safe Mode by
pressing [F5] during boot-up. Now  to
eliminate the HKEY_LOCAL_MACHINE
\Software\Micr-osoft\CurrentVersion\
Run\MSVXD registry entry, go to Start >
Run and type regedit . Then press 
[Enter]. Delete all the MSVXD.EXE,
MSVXD16.DLL and MSVXD32.DLL files
in the Windows\System folder. Finally,
using Notepad, open the win.ini file in

the Windows directory. Delete all refer-
ences to these files in the ‘load=’ and
‘run=’ lines (the second and third line) in
the file. Save the file and close it. Alter-
natively, download a free removal tool
from http://www.bitdefender.com/down-
load/download.php?file=AntiDatom.exe. 

To remove the BKDR_NEWBIERO, a
Trojan, open regedit and go to the key
HKEY_CURRENT_USER\Software\Micros
oft\Windows\CurrentVersion\Run. In
the right panel, search for the registry key
that contains the registry data value
‘Microsoft Diagnostic=”%Windows%\
[random filename].exe’ and delete it.
Close regedit and restart your PC. 

Font despair 
When I tried to install Norton AntiVirus

2002 on my computer (based on a P-III
933 MHz CPU, 256 MB RAM, 40 GB hard
drive running Windows 98 SE), the setup
initialisation box showed some square
boxes instead of English letters and I could-
n’t complete the installation. I also could
not install Office 2000. I find these square
boxes in some other applications too, for
instance, in the left pane of the help win-
dow of Outlook Express 5.0. Please tell me
how to get rid of this problem.
Kamal Kishore
Via e-mail 

The problem could lie with missing
system fonts or the system language

selection. Go to Start > Settings > Control
Panel and double-click on Regional Set-
tings. Make sure that the language list-
ed here is English (United States). If the
problem still persists, reinstall the fonts
in your system from another Windows
98 computer. If all else fails, the best
(but most time-consuming) solution
would be to re-install Windows 98 on
your computer. This will restore the
required fonts, as well as other system
settings that might have been corrupted
due to a malfunction.

Hidden free space
I have a Pentium III 700 MHz CPU with

196 MB RAM and 20 GB hard drive running
Windows Me. The hard disk has six parti-
tions, allotting the C: drive with 2,532 MB.
I have a tough time formatting and rein-
stalling Windows Me at least once a month.
I have set the swap space manually to 196
MB. The problem is that the C: drive gets
filled up and a message appears saying,
‘Warning: Low disk space. Would you like to
uninstall any programs to free up disk
space?’ But since I did not install any appli-
cations on the C: partition, uninstalling pro-
grams from other partitions would not
make any difference. The strange thing is,
when I select all the files and folders of C:, it
shows 1.14 GB and a free space of less than
100 MB. Nearly 1 GB of disk space is miss-
ing! How do I retrieve this disk space?
Where is this 1 GB of space?
Vyjesh
Via e-mail

There are several reasons why the disk
space might be reported incorrectly. Fore-
most among them is the possibility of an
error in the filesystem, which results in
incorrect reporting of disk usage. Run Scan-
disk from Start > Programs > Accessories > Sys -
tem Tools > Scandisk and choose the
Thorough option. Scan all your partitions
for errors. If that doesn’t throw up any-
thing, check your disk’s actual allocated size
and available space. To do this double click
on My Computer and then right-click on
C:. Check the capacity and ensure that it is
actually 2,532 MB and see how much of it
is being used. Click on Disk Cleanup to
start the wizard and remove unwanted files
from your computer. Finally, consider mov-
ing your permanent swap file to another
partition to free up space on the C drive.

Backing up virus definitions
I run Windows 98 SE on a PC with a

Pentium III processor and 192 MB of RAM.

Unstable motherboard
When I turn my PC on, it boots per-

fectly, but it goes blank after 20-25 min-
utes. The LED on the monitor flickers
on and off too. When I switch on
the power switch on the LED,
the monitor goes on and off
nearly 10-12 times
before it boots.
Why does this hap-
pen?
Vaishali
Via e-mail

Your problem
seems to be possi-
bly heat-related.
It’s possible that
the CPU or the
motherboard chipset is generating too
much heat for the system to handle,
resulting in the crash. In case you
aren’t comfortable with opening your

PC, call a service technician to exam-
ine your processor to see if the
heatsink is properly seated on the CPU

and that the cool-
ing fans are operat-
ing correctly. Your
CPU fan may be
blocked by a wire
or might have
a c c u m u l a t e d

dust; or your cabi-
net might not be

able to ventilate
and air the sys-
tem enough.
Also, observe if

certain actions
trigger the crash.

This should help you pinpoint the
cause of the problem. Also, enter the
system’s BIOS during power-up by
pressing [Del] and select the Load Fail-
safe Defaults option.

The ‘load=’ and ‘run=’ lines should be empty

ILLUSTRATIONS: Mahesh Benkar
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I use Norton AntiVirus 2000 for protec-
tion. I update the virus definitions every
month and as a result, I have updated 13
times in the last 13 months. Recently, I
upgraded my hard drive from 20 GB to 40
GB. So now I have to transfer all my data
to this drive and install a clean copy of
Windows 98. How do I back up my virus
definitions so that I don’t have to update
them again?
Namrata
Via e-mail

Updates of Norton AntiVirus include
virus definition updates as well as updates
to the scanning engine. Although you
won’t be able to carry over your engine
upgrades, transferring the virus definitions
is a simple task. You can find these defini-
tions in the C:\Program Files\Common
Files\Symantec Shared\VirusDefs folder.
Just copy this folder and paste it in the
same location in the new installation.

Compatible AGP slot
I recently bought an MSI 845E

MAX2-BLR MS-6398E motherboard. I
intend to buy a GeForce4 graphics card.
In the motherboard manual, it says ‘AGP
4x slot (1.5V only)’. Will I be able to use
the GeForce4 GPU on my motherboard?
Is there any way I can increase the 4x to
anything higher for future use? How
long can I use 4x to play the latest
games?
Leejo
Via e-mail

To answer your second question first,
you cannot upgrade your AGP slot’s
capabilities as this will involve changes in
the circuit and power requirements. How-
ever, you have no cause for concern as
your motherboard will support even ATi’s
Radeon 9700 and other new graphics
cards. Regarding the relevance of 4x, as
the latest cards have just begun to sup-
port the 8x mode, rest assured that you
can use your board for quite some time
to come. Your 4x AGP interface has
enough bandwidth to run the present
crop of games, giving you no reason to
fret for a while.

Unable to search in Windows XP
I have a Celeron 1 GHz with an Intel

810-based motherboard and a 40 GB
hard drive running Windows XP and
Windows Me. When I run the Search
function from Windows XP, it gives an
error saying, ‘A file that is required to run
Search Companion cannot be found. You
may need to run setup.’ The search win-
dow appears, but there are no fields in
the pane on the left. When I click on the
character, it keeps repeating the same
action—even right-clicking on it has no
effect. Please help me.
Chandru
Via e-mail

This is a documented error that hap-
pens with some installations of Windows
XP—download the patch for it from
http://www.microsoft.com/Downloads/Release.as
p?ReleaseID=39318. After downloading, fol-
low the on-screen instructions. 

Flickering screen and low virtual
memory 

I have a Pentium 4 1.6 GHz processor,
Intel 850 MV motherboard with 128 MB
RDRAM and a 17-inch monitor that  flick-
ers around the edges. Also, very light
curves appear on the display when I set
no wallpaper. I normally work in
Windows XP. What can I do to solve this
problem? Another problem is that after
playing Duke Nukem, when I exit, some-
times an icon appears in the system tray
showing the message, ‘Your system is low
on virtual memory.’ I had the same prob-
lem with Real Player until I uninstalled it.
What can I do to solve this problem? 
Yash
Via e-mail

To solve your first problem go to
Desktop > Properties > Settings > Advanced .
Go to the Monitor tab and set the
Refresh Rate to 75 Hz or more. You
could set a higher refresh rate but make
sure your monitor supports it. 

Your second problem lies with the
operating system’s virtual memory set-
tings. A permanent solution would be to
upgrade your memory to 256 MB. Anoth-
er solution would be to go to Control Panel
> System > Advanced > Performance and click
on Settings. Click Advanced in the new
window and go to Change. Here set you

virtual memory management to ‘System
managed size’—if this option was already
chosen, then it means that you’re low on
hard disk space. You’ll need to restart your

computer for the changes to take effect.
Note the drive in which the swap file
resides and free up at least 250 MB in that
drive by deleting unnecessary files. 

Restoring file associations
My PC has MS Office, therefore MS

Photo Editor is installed with it. Hence, I
cannot open JPG and GIF files in Internet
Explorer. How do I uninstall it?
Samar
Via e-mail

Rather than uninstalling Photo Edi-
tor, which is rather an awkward process
requiring you to re-run the Office instal-
lation, you can restore file associations
back to Internet Explorer. To do this,
locate the JPG or GIF file you want to
open. Click on it to select the file and
then, while pressing [Shift], right-click
on it. In the popup menu, choose ‘Open
with…’ You will then be presented with
a list of applications that can be used to
open the file. Scroll down until you see
the entry ‘iexplore’. Select it and make
sure that the checkbox titled ‘Always use
this program to open this type of file’ is
checked. Click OK and the setting will
be finalised. Repeat this procedure for
all the other file types that you wish to
open with Internet Explorer. The proce-
dure is approximately the same with all
versions of Windows.

FAQs

Send your computing
problems to
sos@jasubhai.com
or write to Digit, 

D-222/2, Om Sagar, MIDC, Nerul-400
706, and we may answer it here!

‘System managed size’ suits most users
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Photoshop 7 trial
version  
Find it on the 
Mindware CD

Add pizzazz to your images 
using Photoshop
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Gamma correction
Often what you see on
screen does not match what
you get in print. The gamma
correction setting calibrates
your monitor so that it
remains in synchronisation
with your printer and your
scanner. Under Windows > Set -
tings > Control Panel , select the
option Adobe Gamma and
the wizard will guide you
further. Choose the step-by-
step wizard option and then
proceed accordingly.   

Changing scratch disk 
Scratch disk refers to the loca-
tion on your hard disk where
the data is stored while you
are working in Photoshop.
This will be a lifesaver when
you are running out of disk
space in the current drive. Go
to Edit > Preferences > Plug-Ins &
Scratch disks and under First,

fill in the path where you
would primarily want all your
data. Under Second, Third
and Fourth, fill accordingly. 

Working with multiple
images 
The Tile feature allows you
to view a number of images

together and edit them. To
tile the images, open all the
images you require and then
select Window > Documents >
Tile from the menu in Pho-
toshop 7 (Windows > Tile in

Photoshop 6). The images
get arranged in tile format—
you can toggle between
them using [Ctrl] + [Tab]
and edit the images.

Managing your images
(Photoshop 7)
Within the File Browser
menu, you can open, select,
name, rotate and view
images. You can even man-
age your files and folders—
create, rename or delete
them. You can rename mul-
tiple files using the Batch
Rename feature or even
rotate one or multiple images
with the Rotate feature.

The File Browser displays
four panes: Tree, Preview,
Metadata and Thumbnail. 
Tree pane: The Tree pane
shows the files, folders and
drives of your system, mak-
ing it easy to navigate and
locate images.

Preview pane: In the 
Preview pane, you can view
a larger image of the selected
thumbnail.
Metadata pane: The
Metadata pane provides the
user with detailed informa-
tion about the current selec-
tion such as the image
filename, date when creat-
ed, image format, along

with any additional
information entered
in the File Info dialog
box. It even displays
EXIF (Exchangeable
Image File) data (that
is, information about
images created with a
digital camera), if it’s
available.
Thumbnail pane:
The Thumbnail pane

displays thumbnails by size,
rank and text detail. They
can be viewed with different

size options such as Small,
Medium, Large, Large with
Rank and Detail. The Large
with Rank displays a large
thumbnail along with the
image’s rank while Detail
provides information about
each image shown such as
file name, date created and
modified, copyright, file
format, colour mode, image
size (in pixels), file size, and
rank.

The Rank By and Sort By
menus help to create a rank
for your images, such as
proof or final, and sort your
images according to their
stage of completion. 

The File Browser lets you
sort images by file name,
file width and height, file
size, file type, resolution,
colour profile, date created,
date modified, and copy
right. 

n tips and tricks

INCREASING PRODUCTIVITY
Manage multiple images and avoid repetitive

tasks through simple actions

The scratch disk dialog box

Working with multiple images is easy

Here’s how you can use the
Actions feature to save time
and effort:
n To open and save multiple
files of the same size, resolu-
tion and mode in one step.
n If there is a folder of images
that you need to convert to
Web graphics and if the
images are somewhat similar,
then don’t do it individually—
choose Actions.
n If you downloaded an
action from the Web but Pho-
toshop doesn’t seem to
recognise it, then first make
sure that the action has the
file extension .atn. Then go to
the Actions palette and from
the drop down menu, choose

Load Actions. Now locate
your action and click OK. The
action will now appear in the
Actions palette under its own
section from where you can
run it.
n When you create actions,
Photoshop runs them so
quickly that you would gener
ally not be able to track a
missing or wrong step. To
slow down or even put a
pause between each step,
choose to play your action
Step by Step in the Playback
Options dialog box in the
Actions palette’s drop down
menu. As an alternative, enter
the number of seconds for
which you’d like it to pause.

Actions Speak Louder than Clicks
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Image modes: RGB,
CMYK, Duotone, Tritone
Before you begin editing an
image, save it in the correct
mode, else it won’t show accu-
rate colours. If you are going
to use the image on the Web,
save it in RGB mode; for print,
save it in CMYK. You can also
save the image as Duotone
(two colours) or Tritone (three
colours)—these modes impart
interesting effects to an image.
If you want to use an image
for the Web as well as for
print, make sure that you have
two copies, one RGB and the
other CMYK.

Perspective in cropped
images
The Cropping tool offers a
wide range of options. For
instance, you can skew the
cropped image by selecting
Perspective in the Options bar.
You can even resize the
cropped image by expanding
the cropping edges beyond the

image size. Use the [Alt] key to
maintain the centre and the
borders when you click and
drag the mouse. Use [Shift] to
maintain the proportions.

Removing noise from
digital camera images 
Images taken from a digital
camera show noise when
opened in Photoshop, usually
in the Blue channel. To correct
this, go to the Channels
palette and make the Blue
channel active. Now click
Gaussian Blur (Filter > Blur) and
add a slight blur to the
image—start with 0.5 and
increase the blur by using the
Up Arrow key. When the noise
has pretty much disappeared,
click on the RGB composite
channel and continue with
the regular image correction.

Fixing stray pixels 
Many a times when we use
Magic Wand or Color Range,
Photoshop leaves some stray
pixels unselected. To select
these, under Select > Modify >
Smooth, enter a sample radius
of 1 pixel and click OK. 

Making a dull image
brighter and sharper
Need to make a low-resolu-
tion image sharper and
brighter? Duplicate the layer
which has your image and
under the Filter menu,
choose Filter > Other > High
Pass. In the example shown
here, the radius is set to 2
(choose the radius according
to the resolution of the
image). Now in the Layer’s
palette, choose the Hard
Light option under Blend
Modes. You could further
flatten the image by choosing

Layer > Flatten Image and see
the difference between the
new and the original image! 

Working with the Heal -
ing Brush and Patch tool
With the old Rubber Stamp
tool, you can clone pixels
from a sampled area and
apply them to an area need-
ing correction. However, it
does not take care of the
shadows and highlights of
the flawed area. The new
Healing Brush tool in Photo-
shop 7 clones by using the
texture from the sampled
area and then using the
colours around the brush
stroke as you paint over the
flaw. You can sample and
heal between two images but
you need to make sure they
are in the same mode.

The Patch tool is similar
to the Healing Brush but
instead of painting with brush
strokes, you select the flawed
area and apply the patch to it.
It can be useful for selecting
larger flawed areas. 

Creating gradients from
photos 
Seen a nice combinational
background somewhere? This
neat little trick will show you
how you can use it in your
own creation. Open the image
and select the Gradient tool.
In the Gradient Options bar,
click on the Gradient sample
to bring up the Gradient Edi
tor. Click on the first Color
Stop button on the left of the
Gradient bar. Now move your
cursor outside the Gradient
Editor, onto your image and
click on the first colour that

IMAGE EDITING
Crop them, skew them, play with them. Give

your images the perfect look

The Perspective option lets you
skew cropped images

The original photograph

The gradient created from the
photograph

A low resolution image 

The low resolution image after
brightening and sharpening

When working with
the Patch tool, you need not
make your initial selection
with this tool. Instead, select
it with any selection tool and
drag the selection with the
Patch tool to the portion of
the image from which you
want to clone, and then
release your mouse button.

Patch it up
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you want in your gradient.
Your Color Stop will take on
this colour. Add another
Color Stop by clicking just to
the right of your first stop
under the Gradient bar.
Again, move outside the
Gradient Editor into your
image and sample the next
colour. Keep adding stops
and sampling colours until
you have the required gradi-
ent effect. Give the gradient
a name in the Name field
and click on the New button
to add this to the Gradient
picker so that you can access
it easily.

Erasing back to your
original image 
When editing an image, to
revert to an earlier stage,
select the Eraser tool
(instead of File > Revert ,
which will revert to the orig-
inal image). Press down [Alt]
and start erasing the areas
you don’t want to keep.
Usually the Eraser tool eras -
es the image, but when you
hold down the [Alt] key, it
acts like a history eraser and

erases back to how the
image looked originally.

Changing colour and
luminosity effects 
Open your RGB image and
make a copy of it. Now press

[Ctrl] + [I] to invert your
image in the new layer. Go to
the Layers palette and change
the blend mode from Normal
to Difference in the inverted
layer mode. Now make a copy
of the original background
layer and place it above the
inverted layer. Finally, change
the layer blend mode from
Normal to Luminosity.

mouse away from the text, it
changes into the Move tool.
You can now move the Type
in the Edit mode too. The
moment you bring the
mouse nearer to the text, the
cursor blinks again and you
can edit the text again.

You [Enter] only once
In the edit mode, when you
press [Enter], the cursor goes
to a new line. When you fin-
ish editing, press [Enter] on
the Numeric keypad. This
will finish the editing task
and the cursor will turn into
a Move tool.

Metal and chrome
effect 
Open a new document in
RGB mode and type in Steel .
Hold down the [Ctrl] key and
click on your Type layer in
the Layers palette to put a
selection around your text.
Now under the Select menu,
choose Save Selection. Press
[Ctrl] + [D] to deselect and
then delete the Type Layer.

Go on to the Channels
palette and click on Alpha 1.
Next, under Filter > Blur >
Gaussian Blur, enter 1 pixel.
Select the background layer
and under Filter > Render >
Lightning Effects, go to Texture
Channel and choose Alpha
1; click OK. 

Now press [Ctrl] + [A],
[Shift] + [Ctrl] + [J] to put this
entire image on its own layer. 

Under Image > Adjust
ments, choose Curves, create a
curve like the one shown
above, by clicking on the
lower left hand side of the
curve and dragging
upwards. Release the mouse
button and then click on the
right hand side and drag
down to give it a chrome
effect. Once you get a curve
similar to the one in the fig
ure, click OK. Now choose
Load Selection from the
Select menu. Make sure
Alpha 1 is selected under the
Channel popup. From the
Select menu, choose Modify >
Expand. Here you need to
evaluate how many pixels to

Kerning text
The kerning effect is used to
crunch or expand words while
retaining even spacing
between letters. Just select the
word you want to kern and
press [Ctrl] + [Alt] + left/right
arrow. This will increase or
decrease the spacing by 100
points. On pressing the [Ctrl]
+ [Alt] + up/down arrow key,

the leading changes by 10
points. To increase or decrease
the font size, press [Shift] +
[Ctrl] + [>] or [<].

Moving Type in Edit
mode 
Haven’t you always wished
to be able to move the text to
its proper position while you
edit? As soon as you take the

You can
add cool
effects by
changing
the image
luminosity

This is the text without the effect

The Lightning Effects dialog box
with the angle setting for the light

Get your curve to look like this

‘Steel’ made of metal and chrome

TEXT EFFECTS
Some shortcuts and effects that will make 

your text stand out
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put in so that it will select all
of the text. We’ve put in 3
pixels as the value. Press
[Shift] + [Ctrl] + [I] and press
[Delete]. Press [Ctrl] + [D] to

deselect. Add a soft drop
shadow by choosing Drop
Shadow from the Layer
Style. That completes the
metallic effect.

Grouping: an excellent
bridge 
Grouping layers essentially lets
you move one object within
another. Press [Alt] and in the
Layers palette, click between

the layers you want to group.
In the figure, first and second
layer are shown individually
and after grouping.

Rotate through the
Blend modes 
It is a test of your patience
when you try to get the right
effects in the layer Blend
modes because you have to
go back to the Blend mode
drop down menu every
time. There’s a simpler way
to do this: simply press
[Shift] + [–] or [+] to go to the

previous or next Blend
mode. 

Organising related layers
If you need to work on sever-
al layers simultaneously, you
can keep them in sync by
clicking the ‘Create a new set’
button in the Layers palatte
and dragging and dropping
the related layers in Set Layer.
Else, you can link the layers—
hold down the [Alt] key and
from the Layer palette’s drop-
down menu, choose New Set
From Linked. 

You can also keep related
data in a more accessible for-
mat by pressing [Alt] and
double-clicking on the layer.
In the Layer Properties dialog
box, choose a colour and
click OK. This will colour the
left side of that layer in the
Layers palette and make it
easier for visual identifica -
tion. Apply the same colour
to all related layers.

Moving multiple layers
between documents
To move more than one layer
at a time from one document
to another, link your layers
and make sure you drag your
layer from within the docu-
ment itself rather than drag-
ging from the Layers palette. If
you drag it from the Layers
palette, you can only get one
layer at a time.

Applying the same style
across layers
You have a style which you
want to apply to all the layers
but the thought of doing the
tedious action is bugging
you? Simply link all the lay-
ers to which you want to
apply the same style. Then
under the Layer menu, go to
Layer Style and choose Copy
Layer Style. Go back to the
Layer menu and choose Paste
Layer Style to Linked, and
your copied style(s) will
instantly be applied to all the
linked layers.

Selecting a letter after
the Type layer has been
rasterised 
To do this, just make a loose
selection using the Lasso
tool around the letter. Hold
down the [Ctrl] key and
press the Up Arrow key once

and then the Down Arrow
key once. The letter will be
selected without disturbing
anything else on the layer.
Now you can play with this
letter as it is now a ‘floating
selection’.

Preventing Layer styles
from affecting your new
work
Layer styles apply to all the
elements in the layer. For
example, if you apply a

Bevel and Emboss to a layer,
everything you do on that
layer will have this effect
applied to it. If you want to
avoid this, create a new
blank layer by clicking on
the New Layer icon, and
drag this new layer beneath
your Bevel and Emboss layer.
Click on your Bevel and
Emboss layer and press [Ctrl]
+ [E] to merge it with the
blank layer directly beneath
it. This will remove the
active effect from the layer
so it no longer applies a
Bevel and Emboss to the
new things on that layer.

Creating your own
styles
If you have created that mas
terpiece of art and want to
use it in your future projects,
you can do so by saving it as
a Style. 

Open the Layer Style dia
log box (double-click on any

effect on that layer in the
Layers palette) and click on
the New Style button. A New
Style dialog box will appear
where you can name your
style. To apply this style, go
to the Window menu and
choose Show Styles. The
style you just created will
appear as the last style in the
palette.

The two objects before grouping

The two objects after grouping
The selected letter can be
tweaked as required

Using your own styles as and
when you want

WORKING WITH LAYERS
Managing layers more efficiently
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WEB GRAPHICS

Reducing file size for
Web images 
To save images for the Web,
preferably save them as
transparent images so that
they take up less space. Go to
the Layers palette and simply
delete the Background layer.
This leaves only transparent
layers above it. Now when
you click on Save for web,
the checkbox for Trans-
parency is no longer grayed
out. 

Clean Type for the Web 
For use on the Web, a type
size below 12 points
becomes blurry. To maintain
the visibility, do not reduce
the type size further. Instead,
increase the positive tracking
and try to keep the tracking
anywhere between 20 to 50
points. This will not only
keep the size small, but will
also maintain the visibility
of the type. 

Trim for the Web 
Another way to keep file
sizes small is to use the Trim
function from the Image
menu. It will crop your Web
graphic as tightly as possible
for the smallest possible file
size. It does this by looking
at the pixel colour in the
upper left hand corner of
your image and it keeps
cropping down until it hits
another colour.

Layer-based slices 
Photoshop can automatical-
ly flatten your image for the

Web and slice it too by using
layer-based slices. If you cre-
ate a layer-based slice, when
you move the layer, Photo-
shop will automatically
adjust all the slices to accom-
modate your move and it
will also create a new slice
layer for your layer. From the
Layer menu, choose New
Layer Based Slice in case of
changes in the layer. Also, if
you let Photoshop do the
slicing, you don’t have to
drag out slices—Photoshop
does the slicing exactly at
the size of your layer. 

The new Slice options in
Photoshop 7 allow you to
link and unlink your slices.
Linking the slices allows
them to share the same
colour palette and dithering
options, which prevents vis-
ible seams that occur
between the lines due to
changes.

Get rid of those annoy -
ing marching ants
There are times when the
selected portion in an image
shows annoying lines called
selection border, popularly
known as ‘marching ants’. If

the selection border gets
annoying, press [Ctrl] + [H].
By doing this, your selection
remains but the marching
ants disappear. This com-
mand is known as ‘Show
Extras’.

Using the WBMP 
format
Photoshop 7 supports a new
file format called WBMP.
This is designed specifically

for mobile devices such as
cell phones and PDAs. This
format supports only 1-bit
colour, that is, either the
pixel is black or white. You
can use masks from Type lay
ers, Shape layers and alpha
channels to vary the Dither
percentage across an image.
This technique produces
higher-quality results in crit
ical image areas without sac
rificing file size.

Straighten those
jagged Lasso tool selec-
tions
Can a Lasso tool give a
smooth selection? Draw the
area you want to use as your
selection and press [q] to
enter Quick Mask mode
(your selection will now be
surrounded by solid pink).
From the Filter menu, under
Noise, choose Median. As

you raise the radius of the
Median filter, the edges
smoothen out. When you
find it satisfactory, press [q]

Smart ways to get sharp, yet small images for
use on the Web

The selection still remains even
after removing the selection
border

Getting smooth selection edges

PNG was originally designed
to replace the popular Gif for-
mat. It supports 24 and 48 bit
images, while gif supports only
8 bit. PNG also supports RGB,
Grayscale and  Indexed colour
image modes as well as vary-
ing levels of transparency, for
example, soft drop shadows,
which are not supported by
GIF and JPEG. The downside is
that in PNG files, the colour
images are often larger than in
GIF or JPEG images because

they contain more colours and
don’t compress like JPEG. The
biggest disadvantage is that
they are not supported entirely
by the browser world. Though
they are natively supported by
Microsoft Internet Explorer
and Netscape Navigator, their
32–bit RGB transparency is not
supported by Windows Inter
net Explorer. So they are ideal
ly suited only for small images
such as buttons and thumb
nails with details.

Portable Network Graphics (PNG)

FILTERS
Filters can give you some amazing effects,

provided you know how to use them correctly

Tips and Tricks Dec 2002 OPTION.qxd  4/28/2004  5:34 PM  Page 116



117 DECEMBER 2002

again to return to Standard
mode.  

Placing lens flares
The location of the lens
flare centre can be con-
trolled precisely. Go to the
Info palette and click on the
cross hair in the lower left
hand side of the palette. In
the screen for measurement
values, insert values in pix-
els or inches. Place your
cursor over the exact spot
where you want the lens
flare to appear. If you look
in the Info palette, you will
see the exact position in
inches. Note this value and
go to the Lens Flare dialog
box; press [Alt] and click 
in the Lens Flare preview 
window.

In the Precise Flare Cen-
ter dialog box, enter the X
and Y coordinates that you
have noted. Click OK and
you will see the lens flare
right where you wanted it.

Working with the
Lightning Effect filter
Here are a few things you
must remember when using
this filter. 
n Press [Tab] to jump from
one light to another.
n You can create your own
styles (presets) by configur-
ing the Lightning Effects
and clicking on the Save
button at the top of the dia-
log box, just below Style.
n To delete a light, simply
click on it and press [Back-
space].
n To add another light, click
and drag the Light icon into
the preview, or hold the
[Alt] key and click and drag

a copy of your existing
light.

Extract and Liquify
commands in Photoshop 7
In Photoshop 7, the Extract
and Liquify commands
have been shifted from the
Image menu to the Filter

menu. The enhanced
Liquify filter gives you
greater control over image
warping with zoom, pan
and multiple undo. You can
also save your meshes,
which lets you return to an
image after experimenting
with the Liquify tools and
start where you left off. You
can even apply the same
mesh to different images or
experiment on a low-resolu-
tion image before applying
the mesh to a high-resolu -
tion version. Create effects
such as smoke or fire with
the new Turbulence brush.
You can also use the new
backdrop option to view
individual layers or a flat-
tened version of the file so
that you can see your dis-
tortions in context as you
create them. 

The Pattern Maker has
been introduced in version
7, which is also located
under the Filter menu. In
order to use the Pattern

maker, highlight the portion
of the image you want to use
in the pattern and click on
the Generate button. A ran-
dom pattern is made from
your selection, which will be
tiled to cover the whole can-
vas. If you don’t like the
result, simply generate it
again. Pattern Maker can

hold 20 patterns in its histo
ry, so you can always go
back and play around with
the controls. You can con
trol the size and layout of
the pattern tiles too. Finally,
when you get the pattern of
your choice, click the disc
icon to save it as a pattern
preset.

Creating a motion
effect 
This is a simple example to
show the motion effect of a
moving vehicle. As shown
in the image, select one
wheel with the help of the
Elliptical Marquee tool. Press
[Shift] to get a circular selec-
tion. From the Filter menu,
choose Blur > Radial Blur and
enter the number of pixels
as 50 (select the pixels
according to the file size).
Now repeat this process with
the other wheel. Next, select
the car using the Polygonal
Lasso tool and use Filters >
Blur > Motion Blur with a value
of 50 pixels. Copy and paste
this layer by using [Ctrl] +
[C] and [Ctrl] + [V]. Select
the Move tool and move the
replicated image in the
direction opposite to the

motion. Reduce the opacity
to 50 per cent. Make a copy
of this layer and drag the
image further behind in the
opposite direction and
reduce the opacity to 25 per
cent. 

Reflection in water
effect  
Here is a special effect that
will create the reflection in
water effect for an object.
Take the Lasso tool and

The Liquify filter in Photoshop 7
has many options 

Radial selection of the wheel in
the image of a stationary car

The effect seen on the image
after moving the image in the
opposite direction and reducing
the opacity to 50%

The car in rapid motion

SPECIAL EFFECTS
Make your design work stand out 

in the crowd
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select the objects in the
image. Copy and paste the
selection using [Ctrl] + [C]
and [Ctrl] + [V]—this cre -
ates another layer. In the

new layer, press [Ctrl] + [T]
to bring in Free Transform
selections. Right-click and
select Flip Vertical from the
options. Bring down this
flipped image by keeping
the [Shift] key pressed and
dragging it. Now scale the
image to a lesser width and
decrease its opacity.

The flame effect 
In order to get the flame
effect on text, open a new
image in the Greyscale

mode with the background
layer kept black and the
foreground layer white. Now
create your type and ras-
terise the type using Layer >
Rasterize > Type. Create a copy
of the layer by going under
the Layer menu and choos-
ing Duplicate Layer. In the
dialog box that appears,
change the destination to
New. This will duplicate
your text layer to a new doc-
ument. 

Go back to your origi-
nal document and merge
your text layer with the
background layer by press-
ing [Ctrl] + [E]. Under the
Image menu, choose Rotate
Canvas and choose 90

degrees CW. From the Filter
menu, choose Stylize > Wind.
In the Wind dialog box,
make sure your chosen
method is Wind and that
your direction is From the
Left. Press [Ctrl] + [F] to run
the same filter again with
the same settings. 

Now go under the Image
menu, under Rotate Canvas,
choose 90 degrees CCW.

Choose Filter > Stylize >
Diffuse and make sure it is set
to Normal mode. Again
choose Filter > Blur > Gaussian
Blur and enter 2 pixels.

Now go under the Image
menu and under Mode
option, choose Indexed
Color. Go back to the Image
menu and under Mode,
choose Color Table and
Black Body in the Table
popup menu. Go to the

Image menu and under
Mode, choose RGB.

Switch to the duplicate
of the text layer. Once
again, go to the Layer menu
and choose Duplicate Layer.
In the dialog box, change
your destination to the
name of your main docu
ment (the one in which
you’ve applied the effects).
The text layer will appear in
exactly the same position as
it was, before the duplica
tion.

Finally, press [d] to set
your foreground colour to
black and then press [Shift]
+ [Alt] + [Backspace] to fill
your text with black. Lastly,
go to Filter > Distort and
choose Ripple. Choose 27
for amount, and choose
Large for size. Click OK to
complete the effect.

The original image

Align the vertically flipped image
with the base of the original 

The final image showing the
reflection in the water

The plain text without any
effects

The text when rotated by 90
degrees CW

The ‘flaming’ effect on the text

Fill selection with foreground colour . . . . . . . . .[Alt] + [Backspace]
Fill selection with background colour  . . . . . . .[Ctrl] + [Backspace]
Display Fill dialog box . . . . . . . . . . . . . . . . . . .[Shift] + [Backspace]
Free transform  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[Ctrl] + [T]
Transform again  . . . . . . . . . . . . . . . . . . . . . . . .[Ctrl] + [Shift] + [T]
Increase brush size  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Decrease brush size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
New layer  . . . . . . . . . . . . . . . . . . . . . . . . . . . .[Ctrl] + [Shift] + [N]
Cut selection to a new layer  . . . . . . . . . . . . . . .[Ctrl] + [Shift] + [J]
Clone selection to a new layer  . . . . . . . . . . . . . . . . . . . .[Ctrl] + [J]
Scroll image  . . . . . . . . . . . . . . .[Spacebar] + drag with the mouse
Scroll left or right  . . . . . . . . . . . .[Ctrl] + [Page up] or [Page down]
Cancel operation  . . . . . . . . . . . . . . . . . . . . . . . .[Esc] or [Ctrl] + [.]
Close image  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[Ctrl] + [W]
Save Image for Web . . . . . . . . . . . . . . . .[Ctrl] + [Alt] + [Shift] + [S]
Brushes palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[F5]
Color palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[F6]
Layers palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[F7]
Info palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[F8]
Actions palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[F9]
Just palettes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[Shift] + [Tab]
All palettes, status bar, options bar and toolbox  . . . . . . . . . . .[Tab]
View rulers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .[Ctrl] + [R]

Must-know Shortcuts
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BioRifle
The BioRifle is an excellent defence and
retreat weapon—shoot where your oppo-
nents are likely
to walk and use
its bio sludge as
a mine. A few
good shots
from this gun
are good
enough to kill
anybody. The secondary fire charges up
the sludge and a maximum fill is enough
for a one-shot kill. Ensure that you are not
too close to the opponent to avoid splash
damage. The weapon should be used to
booby-paint surfaces such as walls and
floors of your base, while guarding a flag.

Shock Rifle
The Shock Rifle shoots a laser beam that
covers great distances accurately. Keep
mental track of the charge-up time taken
by the weapon between shots. The sec-

ondary fire
shoots out a
slow-moving
plasma ball
that can cause
major damage.
The balls are
more useful in close combat. The ta
master with this gun is shooting the
ma balls with the primary fire of th
that is the laser. This combination r
in a huge and deadly explosion th
clear multiple targets.

Link Gun
The gun spews green balls at a d
speed that are pretty accurate and 
a healthy dis-
tance. The sec-
ondary fire is
where the gun
shines, firing a
steady stream
which is more
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The tools of the trade
The Cheats of the Trade

Press [Tab] key to bring down the con-
sole and then type: 

- Makes you invulnerable
ghost - Lets you walk through 

walls
loaded - Gives you all weapons
allammo - Gives you infinite 

ammunition for your 
weapons 

skipmatch - Lets you win the 
current match

behindview 1 - Changes to a third 
person view (0 will turn
it off)

invisible 1 - Makes you invisible 
(0 will turn it off)

amphibious - Lets you breathe 
underwater 

stat fps - Displays the FPS rate
stat net - Displays the network 

status
stat all - Displays various 

statistics 

Ammo Indicator
Shows the amount
ammunition the ac
weapon contains

Health Indicates your
health points

Unreal Tournament 2003
much more; follow this guide and exercise your right to frag!

Under the HUD

arcade ■
■ tactics

Rank/Spread
The first number indi-

cates your position in the
current competition, the

second tells you the
number of participants.

The Spread is how many
places behind the leader

you currently are

Adrenaline
Shows how much
adrenaline you hav
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accurate and easier to control, albeit not
as damaging. Keep a close eye on the
ammunition while in this mode. The
secondary fire reveals the true power of
this weapon: during team matches, the
guns can be linked together with devas-
tating effect. A teammate can fire a beam
onto another carrying a Link Gun and
when the second member secondary-
fires his weapon, his beam will cause
twice the damage.

Minigun
This is the bread and butter gun of
UT2003. Its rapid-fire action ensures that

you need not
be a good shot
to get a kill. It
is the ideal
weapon to
harass some-
one with at
long dis-

tances—it’s more effective than the
Assault Rifle at slowly eating away at
armour and health. The secondary mode
takes a longer spin-up time to fire shots
that cause greater damage, at a higher rate
of fire. You can safely stick to this mode
as long as you keep an eye on the ammu-
nition.

Flak Cannon
This gun is mighty powerful. The primary

mode fires off
a diverging
array of hot
flaks that are
e x t r e m e l y
effective at
close range.
These shots

can be bounced off walls and around cor-
ners, thus making this gun an ideal one to
possess while retreating to a safe spot. The
secondary mode fires off a single flak

grenade that does an awesome amount of
damage—it can be a one-shot killer when
used accurately. The secondary mode for
long distance firings and the primary
mode for short distance shootings is how
the Cannon likes to be used.

Rocket Launcher
The Rocket Launcher shoots a single,
straight rocket
that travels at
a good speed
and has a large
blast radius.
Always aim at
your oppo-
nent's feet to
maximise the effect of the splash damage.
Also try to lead the foe a bit with the rock-
et: predict where your target is likely to be
and then aim your shot on that spot.
Hold the secondary-fire button to load up
to three rockets that shoot simultaneous-
ly—a good strategy to cover a large area,
although accuracy thus decreases. You
can lock on to a target by tracking it with
the aiming cursor of the Launcher for a
few seconds. Rockets fired post-lock will
home in on their target. Finally, hold sec-
ondary fire to load multiple and then
immediately press the primary fire but-
ton, followed by releasing both the but-
tons simultaneously—the Launcher will
fire swarming missiles.

Lightning Gun
This is the sniper gun of UT2003. The pri-
mary fire shoots lightning bolts that are
one-shot killers if on target but the
r e c h a r g i n g
time between
shots is quite
long. Also note
that the blue
arc is a dead
give away of

your position, so those fine campin
are numbered. The secondary fire le
zoom in and frag someone. Headsho
a breeze in this mode and the gun
becomes a great defender of flag
domination points.

Ion Cannon
The primary fire of this gun is us
paint a target area, whereupon an o
satellite anni-
hilates the
tagged area.
Paint enemy
areas for maxi-
mum effect.
The secondary
fire lets you
zoom, very much like the Lightning

Redeemer
The primary fire shoots a nuclear
head that causes insane damage 
good nuke
should. Note
that the mis-
sile can be shot
down, where-
upon it harm-
lessly blows
up.

The secondary mode lets you 
the missile to its destination, such
enemy base.

AHMED

Double Jump: An excellent techniq
get on to ledges and high nooks, a
effective as an escape move when s
rounded. To execute a double jump
jump once and when at the peak, p
the jump key once more to gain m
Backward Leap: This leap can be 
to quickly retreat to a safe spot. A
invaluable if you have a long-rang
weapon in hand and are being ch
by someone equipped with a clos
ranged weapon. Double-tap on th
back button to perform the leap.
Strafe Leap: Rockets can be a rea
in UT2003, ditto the Shock Rifle a
the Link Gun. The key to reducin
ache is dodging—double-tap the
keys to perform this miracle in eit
direction.
Elevator Leap: Use the elevators t
extra air. While on an elevator, if y
jump as it stops, inertia will impart
jump a significant boost. The eleva
leap is particularly good in combin
with the double jump.

Move
Berserk

Invisibility
Regeneration
Speed Booster

The Moves of the Trade

When you get 100 adrenaline points, you can perform a special move for a set amount of
time. To increase the adrenaline points, gather the pills strewn around a level or bag more
kills.

Key combination
Forward, Forward,
Back, Back
Back, Back, Back, Back
Left, Left, Right, Right
Forward, Forward, For-
ward, Forward

What the move does
It increases your attack speed by about 40 per
cent
You turn invisible
You regenerate health points and shield points
Movement speed and jump height are 
doubled
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